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Chapter 1 — General Information

1-1 Introduction

This LMR Master User Guide is part of a set of publications that cover all of the instrument’s
functions and their use. This guide covers the instrument overview, system functions, and
other common features, along with a brief guide to basic measurement concepts and setups.
Most instrument operations and modes are covered in specific measurement guides as listed
in Table A-1 on page A-1.

Read the Handheld Instruments Product Information, Compliance, and Safety Guide

(PN: 10100-00065) for important safety, legal, and regulatory notices before operating the
equipment. For additional information and literature covering your product, visit the product
page of your instrument and select the Library tab:

e http://www.anritsu.com/en-US/test-measurement/products/s412e

Contacting Anritsu for Sales and Service

To contact Anritsu, visit the following URL and select the services in your region:
http://www.anritsu.com/contact-us.

1-2  Instrument Description

The S412E LMR Master is an integrated multi-functional test instrument that eliminates the
need to carry and learn multiple test sets. The LMR Master combines a high performance
receiver/spectrum analyzer with a vector network analyzer. The S412E can optionally be
configured to include Coverage Mapping for P25/P25p2, NXDN™, dPMR, DMR
MOTOTRBO™, PTC-ITCR, PTC-ACSES, and TETRA (LMR Digital Demodulation). Other
available options include Interference Analyzer with mapping, Channel Scanner, AM/FM/PM
Analyzer, Vector Voltmeter, Fixed and Mobile WiIMAX™, GSM/GPRS/EDGE, FirstNet LTE
(RF, Modulations, and Over-the-Air), and High Accuracy Power Meter.

The LMR Master includes a CW and NBFM Signal Generator with a 500 kHz to 1.6 GHz
frequency range and 0 dBm (1 mW) maximum power level. In many available LMR modes
(P25/P25p2, NXDN, TETRA, DMR, PTC-ITCR, or PTC-ACSES), the LMR Master signal
generator can create mode-specific patterns, CW, 1 kHz AM, and 1 kHz FM signals with
adjustable frequency and power levels.

The LMR Master spectrum analyzer, NBFM, P25/P25p2, NXDN, TETRA, DMR, dPMR, and
PTC-ITCR and PTC-ACSES frequency ranges are expanded to 6 GHz with Option 6. The
VNA frequency range is expanded to 6 GHz with Option 16. Additional options include a Bias
Tee for TMA testing and a GPS receiver. Details on configuration and available options are
provided in the LMR Master Technical Data Sheet.

The bright, 8.4 inch, TFT backlit, LCD color display provides easy viewing in many lighting
conditions. Use the touch screen to navigate menus and use the keypad to enter data.

All LMR Master models are equipped with a field-replaceable Li-Ion battery delivering more
than three hours of battery life.

S412E UG PN: 10580-00318 Rev. AC 1-1
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1-2 Instrument Description General Information

The internal memory is large enough to store approximately 2,000 traces or setups.

Measurements and setups can also be stored in a USB memory device or transferred to a PC
by using the included USB cable or through Ethernet. The amount of external USB memory
is limited only by the size of the USB memory device. Use Line Sweep Tools (LLST) for certain

VNA measurements and Master Software Tools (MST) for spectral analysis measurements
(refer to Chapter 7, “Anritsu PC Software Tools” for an overview of these software tools).

Not all after-market USB memory devices are compatible with the LMR Master.
Many drives come with a second partition that contains proprietary firmware. This

Note

partition must be removed. Only one partition is allowed. Refer to the individual

drive manufacturer for instructions on how to remove it. Some drives can be made
to work by reformatting them with the FAT32 format.

Frequency Ranges

Table 1-1 lists the LMR Master frequency ranges for the various measurement modes.

Table 1-1. LMR Master Frequency Ranges
Model Frequency Range
S412E Vector Network Analyzer: 500 kHz to 1.6 GHZz?

Spectrum Analyzer: 9 kHz to 1.6 GHzP
Signal Generator: 500 kHz to 1.6 GHz
NBFM Analyzer: 100 kHz to 1.6 GHzP

a. Upper frequency range is 6 GHz with Option 16.
b. Upper frequency range is 6 GHz with Option 6.

Additional Options

Additional options for the LMR Master are listed in Table 1-2. Most of these options are
described in Measurement Guides (refer to Appendix A).

Table 1-2. Available Options

Option Description
S412E-0006 6 GHz Spectrum Analyzer Frequency Extension
S412E-0010 Bias Tee
S412E-0015 Vector Voltmeter
S412E-0016 6 GHz VNA Frequency Extension
S412E-0019 High Accuracy Power Meter
S412E-0025 Interference Analyzer
S412E-0027 Channel Scanner
S412E-0031 GPS
S412E-0046 Fixed WiIMAX RF Measurements
S412E-0047 Fixed WiMAX Demodulation
S412E-0066 Mobile WiMAX RF Measurements
S412E-0067 Mobile WiMAX Demodulation
S412E-0037 Mobile WiMAX Over-the-Air Measurements
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Instrument Care and Preventive Maintenance

Table 1-2. Available Options

Option Description
S412E-0431 Coverage Mapping
S412E-0444 EMF Measurement (requires Anritsu isotropic antenna)
S412E-0501 Distance Domain (feature is standard with firmware V1.11 and later)
S412E-0509 AM/FM/PM Analyzer
S412E-0521 P25/P25p2 Analyzer Measurements
S412E-0522 P25/P25p2 Coverage Measurements
S412E-0531 NXDN Analyzer Measurements
S412E-0532 NXDN Coverage Measurements
S412E-0541 LTE RF Measurements
S412E-0542 LTE Modulation Quality
S412E-0546 LTE Over-the-Air Measurements
S412E-0886 LTE 256QAM Demodulation Measurements (requires Option 542)
S412E-0551 TDD LTE RF Measurements (requires Option 541)
S412E-0552 TDD LTE Modulation Quality (requires Option 542)
S412E-0556 TDD LTE Over-the-Air Measurements (requires Options 31 and 546)
S412E-0573 dPMR Analyzer RF Measurements
S412E-0572 dPMR Coverage Measurements
S412E-0591 DMR Analyzer Measurements
S412E-0592 DMR Coverage Measurements
S412E-0721 PTC-ITRC Analyzer Measurements
S412E-0722 PTC-ITRC Coverage Measurements
S412E-0731 PTC-ACSES Analyzer Measurements
S412E-0733 PTC-ACSES Coverage Measurements
S412E-0581 TETRA Analyzer Measurements
S412E-0582 TETRA Coverage Measurements
S412E-0880 GSM/GPRS/EDGE Measurements

1-3 Instrument Care and Preventive Maintenance

LMR Master preventive maintenance consists of cleaning the unit and inspecting and
cleaning the RF connectors on the instrument and on all accessories. Clean the LMR Master
with a soft, lint-free cloth dampened with water or with water and a mild cleaning solution.

Caution To avoid damaging the display or case, do not use solvents or abrasive cleaners.
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Connector Care

Clean the RF connectors and center pins with a cotton swab dampened with denatured
alcohol. Visually inspect the connectors. The fingers of the N(f) connectors and the pins of the
N(m) connectors should be unbroken and uniform in appearance. If you are unsure whether
the connectors are undamaged, gauge the connectors to confirm that the dimensions are
correct. Visually inspect the test port cable(s). The test port cable should be uniform in
appearance, and not stretched, kinked, dented, or broken.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the
Type-N connectors. The recommended torque is 12 Ibf in to 15 Ibf ‘in (1.36 N ‘'m to 1.70 N ‘m).
Inadequate torque settings can affect measurement accuracy. Over-tightening connectors can
damage the cable, the connector, the instrument, or all of these items.

Visually inspect connectors for general wear, cleanliness, and for damage such as bent pins or
connector rings. Repair or replace damaged connectors immediately. Dirty connectors can
limit the accuracy of your measurements. Damaged connectors can harm the instrument.
Connection of cables carrying an electrostatic potential, excess power, or excess voltage can
damage the connector, the instrument, or both.

Connecting Procedure

1. Carefully align the connectors. The male connector center pin must slip concentrically
into the contact fingers of the female connector.

2. Push connectors straight together. Do not twist or screw them together. A slight
resistance can usually be felt as the center conductors mate.

3. To tighten, turn the connector nut, not the connector body. Major damage can occur to
the center conductor and to the outer conductor if the connector body is twisted.

4. If you use a torque wrench, initially tighten by hand so that approximately 1/8 turn or
45 degrees of rotation remains for the final tightening with the torque wrench.

Relieve any side pressure on the connection (such as from long or heavy cables) in order
to assure consistent torque. Use an open-end wrench to keep the connector body from
turning while tightening with the torque wrench.

Do not over-torque the connector.

Disconnecting Procedure

1. If a wrench is needed, use an open-end wrench to keep the connector body from turning
while loosening with a second wrench.

2. Complete the disconnection by hand, turning only the connector nut.

3. Pull the connectors straight apart without twisting or bending.

ESD Caution

The LMR Master, like other high performance instruments, is susceptible to ESD damage.
Coaxial cables and antennas can easily build up a static charge, which (if allowed to discharge
by connecting directly to the LMR Master without first discharging the static charge) may
damage the instrument input circuitry. Operators must be aware of the potential for ESD
damage and must take all necessary precautions.
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General Information 1-4 Battery Replacement

Operators should exercise practices outlined within industry standards such as JEDEC-625
(EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices,
equipment, and practices. Because these standards apply to the LMR Master, Anritsu
Company recommends that any static charges that may be present be dissipated before
connecting coaxial cables or antennas to the LMR Master. This may be as simple as
temporarily attaching a short or load device to the cable or antenna prior to attaching to the
LMR Master. Remember that the operator may also carry a static charge that can cause
damage. Following the practices outlined in these standards helps to ensure that a safe
environment exists for both personnel and equipment.

1-4  Battery Replacement

The battery can be replaced without the use of tools. The battery compartment is located on
the lower left side of the instrument (when you are facing the measurement display). Refer to
Figure 1-1. To remove the battery:

1. Slide the catch toward the bottom of the instrument.
2. Tilt the top of the door away from the unit.

3. Lift out the battery door.
4

Remove the battery pack from the instrument by grabbing the battery lanyard and
pulling out.

Replacement is the opposite of removal. The battery key side (slot below the contacts) must be
facing the front on the unit and slides in first. Press the battery inward firmly to seat the
contacts, then reinstall the door.

When inserting the battery, the battery label must face the back of the instrument,
Note and the guide slot on the battery must be below the contacts. If the battery door
does not latch closed, the battery may be inserted incorrectly.
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Figure 1-1.

Battery Compartment

The battery that is supplied with the LMR Master may need charging before first use. The
battery can be charged while it is installed in the LMR Master by using either the AC-DC
Adapter or the DC adapter, or outside the LMR Master with the optional Dual Battery
Charger. Refer to “Battery Symbols” on page 2-13 for a description of battery symbols used on
the LMR Master screen.

Note

Use only Anritsu Company approved batteries, adapters, and chargers with this
instrument.

Anritsu Company recommends removing the battery for long-term storage of the
instrument.

To ensure an improved battery life, do not charge the battery above 40°C.
Press Shift+8 > Status to view the Battery Temperature in the Status window.

If the battery temperature exceeds the limit, disconnect the AC power supply and
allow it to cool down and perform a power cycle before resuming operation.

Caution

When using the Automotive Cigarette Lighter Adapter, always verify that the
supply is rated for a minimum of 60 watts at 12 VDC, and that the socket is clear of
any dirt or debris. If the adapter plug becomes hot to the touch during operation,
then discontinue use immediately.

PN: 10580-00318 Rev. AC S412E UG
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1-5 Calibration and Verification

The LMR Master is a field-portable unit designed to operate in the rigors of the test
environment. In order to ensure measurement accuracy, RF calibration (OSLT, for example)
must be performed prior to making a measurement in the field.

The LMR Master has no field-adjustable components. The RF calibration components,
however, are crucial to the integrity of the calibration and must be periodically verified to
ensure their performance. This is especially important if the components have been dropped
or over-torqued.

For best calibration results (compensation for all measurement uncertainties),
ensure that the calibration is performed at the end of the test port or optional

Note extension cable (that is, at the same point that the device that is to be tested (DUT)
will be connected).
For best results, use an Anritsu phase stable Test Port Extension Cable, such as
those listed in the Technical Data Sheet for your instrument (refer to Appendix A).
Caution Use of a typical laboratory cable to extend the LMR Master test port to the device

under test, or any bending of the cable subsequent to the OSL or OSLT calibration,
may cause uncompensated phase reflections inside the cable. Reflections of this
type cause measurement errors, which are more pronounced at higher frequencies.

Anritsu recommends an annual calibration and performance verification of the LMR Master
and the OSL calibration components and InstaCal module by local Anritsu Service Centers.

The LMR Master is self-calibrating and has no field-adjustable components. The OSL
calibration components are crucial to the integrity of the calibration. As a result, they must be
verified periodically to ensure performance conformity. This is especially important if the
OSL calibration components have been accidentally dropped or over-torqued. Contact
information for Anritsu Service Centers is available at http://www.anritsu.com/contact-us.
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1-6 Secure Environment Workplace

This section describes the types of memory in the LMR Master, how to delete stored user files
in internal memory, and the recommended usage in a secure environment workplace.

LMR Master Memory Types

The instrument contains non-volatile disk-on-a-chip memory, EEPROM, and volatile DRAM
memory. The instrument does not have a hard disk drive or any other type of volatile or
non-volatile memory.

Disk-On-A-Chip (DOC)

DOC is used for storage of instrument firmware, factory calibration information, user
measurements, setups, and *.jpg screen images. User information stored on the DOC is
erased by the master reset process described in section “Erase All User Files in Internal
Memory” on page 1-8.

EEPROM

This memory stores the model number, serial number, and calibration data for the
instrument. Also stored here are the user-set operating parameters such as frequency range.
During the master reset process, all operating parameters that are stored in the EEPROM
are set to standard factory default values.

RAM Memory

This is volatile memory used to store parameters needed for the normal operation of the
instrument along with current measurements. This memory is reset whenever the
instrument is restarted.

External USB Memory Device (not included with the instrument)

This memory may be selected as the destination for saved measurements and setups for the
instrument. You can also copy the contents of the internal disk-on-chip memory to the
external memory device for storage or data transfer. The external USB memory device can be
reformatted or sanitized using software on a PC.

Refer to Chapter 4, “File Management” for additional information on saving and copying files
to the USB memory device.

Erase All User Files in Internal Memory
Perform a Master Reset:

1. Turn the instrument on.
If the Menu screen is displayed, press the Esc key.
Press the Shift button then the System (8) button.
Press the System Options submenu key.
Press the Reset key, then the Master Reset key.

A o

A dialog box is displayed on the screen warning that all settings will be returned to
factory default values and all user files will be deleted.

N

Press the ENTER button to complete the master reset.

The instrument reboots, and the reset is complete.
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General Information 1-6 Secure Environment Workplace

Recommended Usage in a Secure Environment
To set the LMR Master to save files to an external USB memory device:
1. Make sure the format of the USB memory device is Fat32 in one partition.
Attach the external memory device and turn on the instrument.
Press the Shift button then the File (7) button.

Press the Save submenu key.

A

Press the Change Save Location submenu key, then select the USB memory device with
the rotary knob, Up/Down arrow keys, or the touchscreen.

6. Press the Set Location submenu key.

The external USB memory device is now the default location for saving files.

Not all after-market USB memory devices are compatible with the LMR Master.
Many drives come with a second partition that contains proprietary firmware. This

Note partition must be removed. Only one partition is allowed. Refer to the individual
manufacturer for instructions on how to remove it. Some drives can be made to
work by reformatting them using the FAT32 format.
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Chapter 2 — Instrument Overview

2-1 Introduction

This chapter provides a brief overview of the Anritsu LMR Master. The intent of this chapter
is to acquaint you with the instrument. For detailed measurement information, refer to a
specific measurement guide listed in Appendix A, “Measurement Guides”.

The Anritsu LMR Master is capable of approximately three hours of continuous operation
from a fully charged, field-replaceable battery (refer to Section 1-4 “Battery Replacement”
on page 1-5).

The LMR Master can also be operated from an external power source (which also
simultaneously charges the battery). This can be achieved with either the Anritsu AC-DC
Adapter or the Automotive Cigarette Lighter Adapter. Both items are included with the
LMR Master.

When using the Automotive Cigarette Lighter Adapter, always verify that the
supply is rated for a minimum of 60 Watts at 12 VDC, and that the socket is clear
of any dirt or debris. If the adapter plug becomes hot to the touch during operation,
discontinue use immediately.

Caution

2-2  Turning On the LMR Master

To turn on the LMR Master, press the green On/Off button on the front panel (Figure 2-1).
The LMR Master takes approximately sixty seconds to complete power warm-up and to load
the application software. At the completion of this process, the instrument is ready for use.

2-3 Front Panel Overview

The LMR Master menu-driven interface is easy to use and requires little training. The

LMR Master uses a touch screen and keypad for data input. The bottom menu keys and
submenu keys on the right side are touch screen keys. The menu and submenu keys vary
depending upon the selected mode of operation. Refer to “Mode Selector Menu” on page 2-16.

Numeric keys 1 through 9 are dual purpose, depending upon the current mode of operation.
The dual-purpose keys are labeled with a number on the key itself, and the alternate function
is printed in blue above each of the keys. Use the blue Shift key to access the functions that
are printed on the panel. The Escape key, used for aborting data entry, is the oval button
located above numeric key 9. The rotary knob, the four arrow keys, and the keypad can be
used to change the value of an active parameter.

The Menu key provides graphical icons of all of the installed measurement modes and user
defined shortcuts (refer to “Menu Key” on page 2-3). The locations of the keys are shown in
Figure 2-1.

Keep the fan inlet and exhaust ports clear of obstructions at all times for proper

Note ventilation and cooling of the instrument.
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Received Pyr _ -4.15 dBm
Freq Error 017 Hz

SymRate E;r 0.01mHz

1|Instrument Settings Summary (unique to each trace). Many of displayed settings are used
as menu shortcuts. Select a setting using the touch screen to display the menu and set the
parameter for editing.

2|Fan Exhaust Port

3|Speaker

4|Rotary Knob

5, 12|Fan Inlet Port

6| Touch Screen Submenu Keys

7|Menu Key
8|Enter Key and Arrow Keys

9|Esc (Escape) Key

10| Shift Key

11 |Numeric Keypad and Shift Menu Keys (printed in blue above 1 through 9)
13|Charge LED

14|0On/Off Button

15|Power LED

16| Touch Screen Main Menu Keys

Figure 2-1. LMR Master Overview
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Instrument Overview 2-3 Front Panel Overview

Front Panel Keys

Menu Key

Press this key to display a grid of shortcut icons for installed measurement modes and any
user-selected menus and setup files that may have been added.

Figure 2-2 shows the Menu key screen with shortcut icons for the installed measurement
modes. Touch one of the icons in the top row to change modes. These top-row icons are
preinstalled and cannot be moved or deleted.

PTC-ITCR
Analyzer

Figure 2-2. Menu Key Screen, Icons for Installed Measurements

The display of the Menu screen varies depending on your LMR Master model and
installed options.

Note Only the Esc key and the touch screen icons are functional in the Menu screen.

The instrument must be in a measurement mode to execute a function that is
indicated in blue text above the number key. They do not function from the Menu
screen.
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2-3 Front Panel Overview Instrument Overview

Figure 2-3 shows the Menu key screen with shortcut icons for the installed measurement
modes and four rows of user-defined shortcuts to menus and setup files.

Press and hold down any touch-screen key for a few seconds to add a shortcut to this screen.
To add shortcut setup files (* . stp), open the recall menu and hold down on the file name for
several seconds. Then select the location for the shortcut.

fo3

nt

£
iy

E W

m

Limit

Figure 2-3. Menu Key Screen with User-Defined Shortcuts

User-defined shortcuts stay in memory until deleted. To delete or move a shortcut button,
press the Menu key, then press and hold the shortcut for approximately 3 seconds. The
Customize Button dialog box opens to allow a button to be deleted or moved. Press Esc to exit
the Menu shortcut display.

The Factory Default reset deletes all user created shortcut icons from the Menu

Note screen. Refer to “Reset Menu” on page 5-18 for additional information.

2-4 PN: 10580-00318 Rev. AC S412E UG



Instrument Overview 2-3 Front Panel Overview

Help for the Menu shortcut screen is available by pressing the icon in the lower-right corner
of the display.

Keep a Button or a Setup File pressed
to add it to this Screen

Keep an Icon pressed to delete or move it

ESCAFE

Figure 2-4. Menu Help

Esc Key

Press this key to cancel any setting that is currently being made.

Enter Key

Press this key to finalize data input or select a highlighted item from a list.

Arrow Keys

The four arrow keys (around the Enter key) are used to scroll up, down, left, or right. The
arrow keys can often be used to change a value or to change a selection from a list. This
function is similar to the function of the rotary knob. The arrow keys are also used to move
markers.

Shift Key

Pressing the Shift key followed by pressing a number key executes the function that is
indicated in blue text above the number key. When the Shift key is active, its icon is displayed
at the top-right of the measurement display area near the battery charge indicator.

Innritsu 03/31/2010 12:22:06 pm =

Figure 2-5. Shift Key Icon
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Number Keypad

The Number keypad has two functions: The primary function is number entry. The
secondary function of the number keypad is to list various menus.

Rotary Knob

Turning the rotary knob changes numerical values, scrolls through selectable items from a
list, and moves markers. Values or items may be within a dialog box or an edit window.

Touch Screen Keys

Main Menu Touch Screen Keys

These five main menu keys are horizontally arranged along the lower edge of the touch
screen. The main menu key functions change to match specific instrument Mode settings. The
main menu keys generate function-specific submenus. The various measurement modes are
selected by pressing the Shift key and then the Mode (9) key. Descriptions of the various
measurement modes can be found in the applicable Measurement Guides listed in

Appendix A, “Measurement Guides”.

Available measurement modes are based on model and options purchased.

Note Refer to Table 1-1 and the Technical Data Sheet for additional information.

Submenu Touch Screen Keys

These submenu keys are arranged along the right-hand edge of the touch screen. The
submenu key labels change as instrument measurement settings change. The current
submenu title is shown at the top of the submenu key block.

Keypad Menu Keys (1 to 9)

Pressing the Shift key followed by pressing a number key selects the menu function that is
printed in blue characters above the number key. Refer to Figure 2-1 on page 2-2.

Not all Secondary Function Menus are active in various measurement modes. If any one of
these menus is available in a specific instrument mode of operation, then it can be called from
the number keypad. It may also be available from a main menu key or a submenu key.

y

The Preset Menu (1) and System Menu (8) are described in Chapter 5, “System Operations ”.
The Sweep Menu (3), Measure Menu (4), Trace Menu (5), and Limit Menu (6) vary depending
on measurement mode, refer to the Measurement Guides listed in Appendix A for
information. The File Menu (7) is described in Chapter 4, “File Management”. The Mode
Menu (9) is described in “Mode Selector Menu” on page 2-16.

LED Indicators

Power LED

The Power LED is located to the left of the On/Off key. The LED is solid green when the unit
is on and slowly blinks when the unit is off but has external power.
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Charge LED

The Charge LED is located to the right of the On/Off key. The LED slowly blinks when the
battery is charging and is solid green when the battery is fully charged.

2-4 Display Overview

Figure 2-6 illustrates some of the key information areas of the LMR Master sweep window in
Vector Network Analyzer mode using “Field” menu structure. For detailed information, refer
to the Measurement Guides that are listed in Appendix A, “Measurement Guides”.

/INritsNg. 4/05/201!031259 am N a7 aan wzie 39 et el - : Measure :

Display Type

Single

Measurement Type
Insertion Loss

B.000 GHz

Freq/Dist Scale Sweep Measure Marker

Trace 1 (TR1) data (within Instrument Settings Summary)

1
2|Instrument Settings Summary (applies to all traces)
3|Real Time Clock
4|GPS Icon
5|GPS location
6

7

8

Battery Charge indicator

Measurement description

Submenu Touch Screen Keys

9|Main Menu Touch Screen Keys
Figure 2-6. Field Mode View VNA Display with GPS On
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Refer to “Field Mode Display vs. Standard VNA Display” on page 3-3 for

Not information on the two LMR Master menu structures in VNA mode.
ote
Press Shift-8 (System) > Application Options > Meas Menu to toggle between the

two structures.

Display Settings

In addition to the default color display, LMR Master offers the following display settings
(System > System Options > Display) in some measurement modes:

Black on White for printing and viewing in broad daylight conditions
Color on White exchanges black for white on the display for best color printing

Night Vision optimized for night-time viewing
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High Contrast for other challenging viewing conditions

[Anritsu sazrzoi0 103608 an

5] (NN | Oiply sotngs
o Figh

T 10T G -

Brightness Biightness

°
Default Calors Detaut Colors

f————t
.
Black & White Black & White
et
Night Vison Night Vison
et
2
High Contrast
———————

o
Invert Black. & Wi

o
InvertBlack & White

Pt ETI TR TR Y

Black on White

Display Setings Anritsu sanzroi0 103911 am E — Display Setings

Brighiness

R

Default Calors Default Colors

N

o )
Black & White Black & White

Night Vision

o
Invert Etack & Whie

oy i g
Pt s [ sew [ e [ w

High Contrast Color on White

Night Vision

Figure 2-7. LMR Master Display Settings
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2-5 Test Panel Connector Overview

Instrument Overview

2-5

Test panel connectors for the LMR Master is shown in Figure 2-8.

Test Panel Connector Overview

External Reference In

Audio In

External Trigger In

Signal Generator Out

RF In

GPS Antenna (with Option 31)

USB Mini-B (Full Speed, USB 2.0)

O N OO W|IN| -~

RJ-45 LAN Connection

©

External Power

10

USB Type A (Full Speed, USB 2.0)

11

3.5 mm Headset Jack

12

VNA Port 1 50 ohm

13

VNA Port 2 50 ohm

Figure 2-8. Test Panel Connectors

Note

This instrument is equipped with Type N connectors. To prevent damage, do not

use pliers or a plain wrench. Do not over tighten.
Recommended torque: 1.36 N-m to 1.70 N-m (12 Ibf-in to 15 Ibf-in).

Do not twist cable or accessory body. Rotate the coupling nut only.

2-10
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Test Panel Connectors

External Power

The external power connector (item “9” in Figure 2-8) is used to power the unit and charge the
battery. Input is 12 VDC to 15 VDC at up to 5.0 A. The green flashing Power LED indicates
that the instrument has external power.

When using the AC-DC Adapter, always use a three-wire power cable that is
connected to a three-wire power line outlet. If power is supplied without grounding
the equipment in this manner, then the user is at risk of receiving a severe or fatal
electric shock.

Warning

USB Interface — Type A

The LMR Master has two Type A USB connectors (item “10” in Figure 2-8) that accept USB
Memory devices for storing measurements, setup data, screen images, and firmware updates.

USB Interface — Mini-B

USB 2.0 Mini-B connector (item “7” in Figure 2-8) can be used to connect the LMR Master
directly to a PC. The first time the LMR Master is connected to a PC, the normal USB device
detection by the computer operating system will take place. The CD-ROM that is shipped
with the instrument contains a driver for Windows XP that is installed when Master
Software Tools is installed. Drivers are not available for earlier versions of the Windows
operating system. During the driver installation process, place the CD-ROM in the computer
drive and specify that the installation wizard should search the CD-ROM for the driver.

For proper detection, either Line Sweep Tools or Master Software Tools should be

Note installed on the PC prior to connecting the LMR Master to the USB port.

LAN Connection

The RdJ-45 connector (item “8” in Figure 2-8) is used to connect the LMR Master to a local
area network or directly to a PC with an Ethernet crossover cable. Integrated into this
connector are two LEDs. The amber LED shows the presence of a 10 Mbit/s LAN connection
when on, and a 100 Mbit/s LAN connection when off. The green LED flashes to show that
LAN traffic is present. For additional information about the LAN connection, Ethernet
connection, and DHCP, refer to Chapter 6, “Ethernet Connectivity”.

Headset Jack

The headset jack provides audio output from the built-in AM/FM/SSB demodulator for testing
and troubleshooting wireless communication systems. The jack accepts a 3.5 mm (1/8 inch)

3-wire miniature phone plug such as those commonly used with audio headsets (item “11” in
Figure 2-8).
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External Trigger In

A TTL signal that is applied to the External Trigger In female BNC input connector causes a
single sweep to occur. In the Spectrum Analyzer mode, it is used in zero span, and triggering
occurs on the rising edge of the signal. After the sweep is complete, the resultant trace is
displayed until the next trigger signal arrives (item “3” in Figure 2-8).

External Reference In

The BNC female connector (item “1” in Figure 2-8) is used for connection of an external
frequency reference. The amplitude of the External Reference should be between
—10 dBm and +10 dBm.

RF In (50 ohm)

This connector (item “5” in Figure 2-8) provides the input 50 ochm interface for the Spectrum
Analyzer function. With Option 10, Bias Tee, output is available on the center pin out of this
port in Spectrum Analyzer mode.

GPS Antenna Connector (Option 31)

The GPS antenna connection on the LMR Master is type SMA-female (item “6” in Figure 2-8).
The GPS function is described in Chapter 9, “GPS (Option 31) ”.

Audio In

Audio In (item “2” in Figure 2-8) is used to support SINAD and Quieting measurements of
analog FM radio sensitivity.

Signal Generator Out

Output of the built-in Signal Generator when the LMR Master is in CW, NBFM, P25/P25p2,
NXDN, dPMR, DMR, TETRA, PTC-ITCR or PTC-ACSES mode (item “4” in Figure 2-8).
Output is turned on with the Turn Sig-Gen ON main menu key.

VNA Port-1 (50 ohm)

This connector (item “12” in Figure 2-8) provides the input/output 50 ohm interface for
reflection measurements of the Vector Network Analyzer at Port 1.

VNA Port-2 (50 ohm)

This connector (item “13” in Figure 2-8) provides the input 50 ohm interface for transmission
measurements of the Vector Network Analyzer at Port 2. With Option 10, Bias Tee, output is
available on the center pin out of this port in VNA mode.
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2-6 Symbols and Indicators

The following symbols and indicators indicate the instrument status or condition on the
display.

The instrument settings that are unique to each trace are summarized in an information
block on the left side of the measurement display screen (refer to Figure 2-6). Each block
contains the trace number followed by the S-parameter or information that is assigned to that
trace (TR4: S21, for example). If the trace has Trace Math applied to it, then the math
function is also displayed on that line (TR1: S11/M1, for example), where M1 is the memory
that is associated with TR1, and the math function is Trace/Memory). The S-parameter that
is assigned to the trace memory is shown (if enabled) at the top of each trace information
block (M1: S11, for example). Each trace block also includes the Graph type, the smoothing
percentage, the calibration status, and the scale (Resolution per Division and the Reference
Value). The calibration status indicates whether the calibration is ON, OFF, or non-existent
(--) for the specific S-parameter that is assigned to each trace. If the Calibration is ON, then
its validity is also displayed (OK,?, or X).

For calibration procedures refer to the Vector Network Analyzer Measurement Guide
(PN: 10580-00289) listed in Appendix A.

Battery Symbols

The battery symbol above the display indicates the charge remaining in the battery.
The colored section inside the symbol changes size and color with the charge level.

Figure 2-9. Battery Status

Green with Black Plug body: Battery is fully charged and external power is applied
Green: Battery is 30 % to 100 % charged
Yellow: Battery is 10 % to 30 % charged
Red: Battery 0 % to 10 % charged
Lightning Bolt: Battery is being charged (any color symbol)
Detailed battery information is also available in the Status dialog box (System > Status).

When either the AC-DC Adapter or the Automotive Cigarette Lighter Adapter is connected,
the battery automatically receives a charge, and the battery symbol with the lightning bolt is

displayed (Figure 2-10).

Figure 2-10. Battery Charging Icon
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The green Charge LED flashes when the battery is charging, and remains on steady when the
battery is fully charged.

Caution  Use only Anritsu-approved batteries, adapters, and chargers with this instrument.

When operating from external power without a battery installed, the battery symbol is
replaced by a red plug body (Figure 2-11).

Figure 2-11. Battery Not Installed

Additional Symbols
Single Sweep

Single Sweep is selected. Press Continuous in the Sweep menu to resume continuous
sweeping.

Floppy Icon

Shortcut to the Save submenu. Touch the icon to open the touch screen keyboard for saving
measurements, setups, or screen displays.

il

Figure 2-12. Floppy Icon
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2-7 Data Entry

Numeric Values

Numeric values are changed using the rotary knob, arrow keys, or the keypad. Pressing one
of the main menu keys displays a list of submenus on the right side of the touch screen. When
the value on a submenu key is displayed in red, it is ready for changing. When using the
rotary knob or arrow keys the changing value is shown on the submenu and in red on the
graticule. When using the keypad, the new value is shown in red on the graticule and the
submenu changes to Units. Selecting a unit for the new value completes the entry.

Parameter Setting

Pop-up list boxes or edit boxes are used to provide selection lists and selection editors. Scroll
through a list of items or parameters with the arrow keys, the rotary knob, or the touch
screen. These list boxes and edit boxes frequently display a range of possible values or limits
for possible values.

Finalize the input by pressing the Enter key. At any time before finalizing the input, press the
escape (Esc) key to abort the change and retain the previously existing setting.

Some parameters (such as for antennas or couplers) can be added to list boxes by creating
them and importing them using Master Software Tools.

Text Entry

When entering text, as when saving a measurement, the touch screen keyboard is displayed
(Figure 2-13). Characters are entered directly with the touch screen keyboard. The keypad
can be used for numeric entry. The left and right arrow keys scroll the cursor through the
filename. Refer to “Save Menu” on page 4-9 for additional information.

Location: Jnternal Memary/use

Filename: |RIEREWE

Filetype: | teasurament .dat- - Viewable in HHST Only! j

1 2 3 4 5 6 7 8 9 1] - = _

q w e r t ¥ u i o p

m

Site 2 Guick Name 2 Quick Mame 3 Guick Name 4 Quick Mame 5 Guick Name B

Figure 2-13. Touch Screen Keyboard
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2-8 Mode Selector Menu

The list of modes that appear in this menu varies depending upon the installed and activated
options in the instrument. Figure 2-14 is an example of the Mode menu. Your instrument
might not show the same list.

To access the functions installed and activated on your instrument:
1. Press the Shift key
2. Press the Mode (9) key.

3. Use the directional arrow keys, the rotary knob, or the touch screen to highlight the
selection, and press the Enter key to select. The current mode is displayed below the
battery symbol.

MODE SELECTOR

Vector Network Analyzer =
Vector Volimeter

Spectrum Analyzer

Power Meter

High Accuracy Power Meter
Interference Analyzer

Channel Scanner

C¥ Signal Generator
AM-FM-PM Analyzer

LTE Signal Analyzer

Fixed WiMAX Signal Analyzer
Mobile WiMAX Signal Analyzer
NBFM Analyzer

DMR Analyzer

P25 Analyzer

P25p2 Analyzer

NXDN Analyzer

PTC - ITCR Analyzer

TETRA Analyzer

(PTC _ ACSES Analyzer N

Figure 2-14. Mode Selector Menu

The Menu key is another option to quickly change measurement modes. Press the Menu key
then select one of the Measurement icons in the top rows (Figure 2-2 on page 2-3).
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2-9 Soft Carrying Case

The LMR Master can be operated while in the soft carrying case. On the back of the case is a
large storage pouch for accessories and supplies.

To install the instrument into the soft carrying case:

1. The front panel of the case is secured with hook-and-loop fasteners. Fully close the
front panel of the case. When closed, the front panel supports the shape of the case
while you are inserting the LMR Master.

2. Place the soft carrying case face down on a stable surface, with the front panel fully
closed and laying flat.

The soft case has two zippers near the back. The zipper closer to the front of the
case opens to install and remove the instrument. The zipper closer to the back of

Note the case opens an adjustable support panel that can be used to provide support for
improved stability and air flow while the instrument is in the case. This support
panel also contains the storage pouch.

Open the zippered back of the case.

Insert the instrument face down into the case, take care that the connectors are
properly situated in the case top opening. You may find it easier to insert the
connectors first, then pull the corners over the bottom of the LMR Master.

=5

I R RN R, S/ Fate Er ~7.94mHz
Ao
Genarator ON

Setp

ived Py

iesasuronent

Figure 2-15. LMR Master Inserted into the Soft Carrying Case

5. Close the back panel and secure with the zipper to secure the LMR Master.

The soft case has panel openings for the fan inlet and exhaust ports. Do not block

Caution the air flow through the panels when the unit is operating.
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2-10 Tilt Bail Stand

A Tilt Bail is attached to the back of the LMR Master for desktop operation. The tilt bail
provides two settings of backward tilt for improved stability. To deploy the tilt bail, pull the
bottom of the tilt bail away from the back of the instrument. To store the tilt bail, push the
bottom of the bail towards the back of the instrument until it attaches to the LMR Master.

Do not use the tilt bail while the instrument is in the soft case. The soft case has an

Note adjustable support panel in the back zipper.

Figure 2-16. Tilt Bail—Partly Extended
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Chapter 3 — Quick Start Guide

3-1

Introduction

This chapter provides a brief overview of basic measurement setups for several measurement
modes. For detailed measurement information, refer to a specific measurement guide listed in
Appendix A, “Measurement Guides”. This chapter provides quick start measurement
information for the following measurement modes:

Section 3-3 “CW Signal Generator” on page 3-2

Section 3-4 “Vector Network Analyzer” on page 3-3

Section 3-5 “Spectrum Analyzer” on page 3-9

Section 3-6 “NBFM Analyzer” on page 3-14

Section 3-7 “LMR Digital Demodulation Signal Analyzers” on page 3-17

Note

LMR Digital Demodulation Signal Analyzers include P25/P25p2, NXDN™, dPMR
DMR, PTC-ITCR, PTC-ACSES, and TETRA Signal Analyzers.

3-2

Measurement Mode Selection

Press the Menu key and use the touch screen to select the appropriate measurement icon.

PTCATCR
Analyzer

PTC-ACSES
Analyzer

Figure 3-1. Menu Screen with Icons for Installed Measurement Modes

Note The content of the Menu screen might vary depending on the installed options.
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3-3 CW Signal Generator

The CW Signal Generator provides a continuous wave (CW) signal from the Signal Generator
Out port of the LMR Master. The CW signal is primarily used for testing the sensitivity of
receivers. To test receiver sensitivity, connect the output directly to the receiver that is being
measured, and then reduce the signal generator amplitude until the receiver is unable to
detect the signal.

CW Output is turned on by default when entering CW Signal Generator mode and

Note automatically turned off when exiting CW Signal Generator mode.

Set the instrument to CW Signal Generator mode as described in the previous section.
2. Press the Freq main menu key and set the transmit frequency of the CW signal.

Press the Amplitude main menu key and set the Power Level and Offset. Add a positive
value offset value for any external gain or negative offset value for any external loss.

4. Press the Turn Sign-Gen OFF main menu key to stop transmitting.

l/lnritsu 03/23/2011 02:4342 pm H -
" Tx Freq

800.000 MHz

Offzet
0.0dB

Power dBm

-10.00 dBm

Frequency: 800.000 MHz
Power(CW): 100.00 pW

Frag Amplitude Turn Sig-Gen OFF

Figure 3-2. CW Signal Generator

3-2 PN: 10580-00318 Rev. AC S412E UG



Quick Start Guide 3-4 Vector Network Analyzer

3-4  Vector Network Analyzer

Set the instrument to Vector Network Analyzer (VNA) mode as described in Section 3-2.

Field Mode Display vs. Standard VNA Display

Field Mode is the default display of the LMR Master when the instrument is turned on for the
first time or reset. Field Mode display may be more familiar to users who have experience
making Cable and Antenna measurements using the Anritsu LMR Master. Standard VNA
display allows the full Vector Network Analyzer functionality of the LMR Master.

Press Shift-8 (System) > Application Options > Meas Menu to toggle between the two views.
Figure 3-3 shows an example of typical VNA measurements in Field Mode Display and
Standard VNA display. Refer to the Vector Network Analyzer Measurement Guide listed in
Appendix A for detailed information on VNA measurements and the menu differences
between the two display structures.

|/II'II'itSLI Da/05/2011 081259 e @D Nsv war wizrsv e |E

Display Type

Single

sssssssss

6.000 GHz

Freq/Dist Scale Sweep Measure Marker

Graph Type

Log Mag

Maximize
Active

FreqDist

Standard VNA Display

Figure 3-3. Measurement Menu in Field Mode Display and Standard VNA Display
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Select the Measurement Type

The following Quick Start instructions apply to VNA Field Mode. For detailed
Note measurement instructions, refer to the Vector Network Analyzer Measurement
Guide P/N 10580-00289, listed in Appendix A.

Press the Measure main menu key and then the Measurement Type submenu key. Select a
measurement graph and press Enter.

Set the Frequency
1. Press the Freq/Dist main menu key.

2. Press the Start Freq submenu key and use the keypad, rotary knob, or the arrow keys to
enter the start frequency.

3. Press the Stop Freq submenu key and use the keypad, rotary knob, or the arrow keys to
enter the stop frequency.

Set the Scale

1. Press the Scale main menu key.

2. For Smith Charts, select the appropriate zoom level. The graph expands or compresses
around the central reference impedance of the Smith Chart

3. For other graphs, set the Top and Bottom of the scale or press Autoscale.

Turn On Markers
1. Press the Marker main menu key.

2. Press the Marker submenu key to open the Select Marker list box and select a marker
by scrolling with the rotary knob or the arrow keys, then press Enter. Unused markers
are labeled OFF. The number on the Marker submenu key indicates the active marker.

3. Use the rotary knob, arrow keys, or touch and drag to move the Marker. The frequency
of the active Marker is shown in the upper-left corner of the display screen.

Peak and Valley Search Markers

When making measurements, the Peak Search and Valley Search features can be used to
quickly place a Marker on a maximum or minimum point of a trace.

1. With an active marker, press the Peak Search or the Valley Search submenu key to find
the maximum or minimum value on the trace that is associated with the current
marker.
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Set Up Delta Markers

If the intent is to conduct a delta measurement, then two markers are necessary: one to be the
reference marker and one to be the delta marker.

Delta Marker Setup:
1. Press the Marker main menu key.
2. Turn on Marker 1 (to be the Ref marker) and assign it to a trace.
a. Press Marker and select MK1 from the list box. Then press Enter.
b. The Marker Type submenu key is set by default to Ref.
Turn on Marker 2 and change the Marker Type from Ref to Delta.

4. Assign Marker 2 to Marker 1 by pressing the Avail Ref Mkr submenu key to open the
Select One list box. Scroll to choose MK1 and press Enter.

The Marker list box includes the current location, readout style, and delta status

Note it they exist). Otherwise, it indicates OFf.

Set a Single Limit Line
1. Press Shift and then Limit (6) to enter the Limit menu.
2. Set Limit State to On. Press the Limit key to set the limit line to either Upper or Lower.

3. Use the numeric keypad, the arrow keys, or the rotary knob to change the limit value
and then press Enter.

Limit lines are not available for Smith charts.

Note Refer to the Vector Network Analyzer Measurement Guide (listed in Appendix A)
for creating multi-segment limit lines.
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4. Press the Limit Alarm key to turn on or off the Limit Alarm.
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Figure 3-4. Single Limit Lines

Set Up Distance Domain

This option is fully described in the Vector Network Analyzer Measurement Guide.
Refer to Appendix A, “Measurement Guides”. Measurement Guides are available on the
documentation disc and as free downloads from the Anritsu Web site (refer to Table A-1).

Calibration Considerations

Various calibrations are available in the LMR Master. Press Shift-2 (Calibration) to open the
calibration menu. Press Start Cal and follow the instruction on the screen. 1-Port calibration is
the simplest and requires three connections during calibration. 2-Port calibration requires
four calibration connections and corrects for the transmit port match.

VNA calibration requires external precision OSL calibration components. 2-Port calibration
also requires a through connector (Figure 3-5 on page 3-7).

The Vector Network Analyzer Calibration menu is the same one that is used in the
Vector Voltmeter menu (Option 15). Refer to section “Calibration Menus” in
Chapter 6 of the Vector Network Analyzer Measurement Guide (refer to

Appendix A in this publication for a listing of all measurement guides) for more
information about the calibration menu. Note that some calibration parameters are
shared between the Vector Network Analyzer and Vector Voltmeter mode, and that
some parameters are different because they were optimized for the specific mode
application.

Note
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hetrecsm0] v o
Type: Insertion Format: dB

Optional Test Port Cable at VNA Port 2

Optional Test Port Cable at VNA Port 1

OSL (Open, Short, Load) Precision Calibration Components

Through Connection for 2 Port Calibration (Port 1 Connects to Port 2)
Figure 3-5. Calibration
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When performing a calibration, the correction coefficients are calculated for specific
measurements (depending on the type of calibration chosen) and for instrument settings
(frequency range, number of points, and power level). The term “calibration correction” refers
to the correction coefficients that are applied to measurements as a result of your calibration.

When calibration correction is On, the correction is applied to all applicable measurements.
For example, if a 1-port calibration is performed, then only traces that measure reflection
have a valid calibration. For those traces, the calibration information data in the Instrument
Settings Summary (item 1 in Figure 2-6 on page 2-7) shows “CAL: ON (OK)”. Other traces
that do not measure reflection display “CAL: --” to indicate that no valid calibration is
available for those traces. The calibration correction can also be turned off manually under
the Calibration menu by toggling the Cal Correction submenu key from On to Off. In that case,
the display shows “CAL: OFF” for all traces that have valid correction data available.

Note that “CAL: OFF” means that a calibration correction has been created, but it is not
currently being used. This is different from “CAL: --”, which means that no valid calibration
correction is available for the current setting.
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When you have Cal Correction on, you cannot increase the frequency range or the number of
points. You can, however, reduce the frequency range or decrease the number of points
without forcing the calibration to become invalid. When reducing the frequency range, the
LMR Master uses the appropriate points within the new frequency range that have correction
coefficients applied to them. In that case, you can observe that the number of points that are
being used for calibration correction are automatically reduced.

If you reduce only the number of points, then the frequency range is not changed. The

LMR Master finds a subset of the original points in the sweep that can be used. You can
therefore notice that the instrument may not use the exact number of points that you have
entered. It picks a specific number of points that allow the calibration correction to continue
to be valid. If you use the rotary knob, you will more easily find the available number of
points that can be set. For example, if you calibrated with 201 points, then you can observe
that you can reduce the number of points to 101, 68, 51, 41, and so forth.

If you change the source power setting, the calibration status is changed to “CAL: ON (?P)”,
which indicates that source power has changed since the instrument was calibrated (from
Low to High, or from High to Low). In this case, the calibration may still be valid, but a new
calibration is recommended.

Another status information display that you may see is “CAL: ON (?T)” which indicates that
the instrument temperature has deviated by more than a set amount since the time that the
calibration was conducted. The calibration is most likely still valid, but a new calibration is
recommended. If you see “CAL: ON (X)” on the display, then this indicates that the
instrument temperature has deviated (since the time the calibration was conducted) by an
amount that has more than likely rendered the calibration invalid. When this occurs, a new
calibration is highly recommended before further measurements are conducted.

Only one calibration is available at one time. Performing a new calibration overwrites any
existing calibration. You can, however, store a measurement setup (with CAL), which also
stores the calibration. You can therefore have multiple calibrations available (as long as the
calibration settings and conditions continue to apply).

Existing Cal Info

The Cal Info submenu key is found in the Calibration main menu and lists the current
calibration settings.

If you update the firmware for an LMR Master, you will have to recalibrate the
instrument. Before loading new firmware, make note of the calibrations set on this
instrument and make sure that the required supplies to re-establish those
calibrations are available.

Note
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3-5 Spectrum Analyzer

Set the instrument to Spectrum Analyzer mode as described in Section 3-2 “Measurement
Mode Selection” on page 3-1.

The following Quick Start instructions apply to Spectrum Analyzer Mode. For
Note detailed measurement instructions, refer to the Spectrum Analyzer Measurement
Guide listed in Appendix A.

Set Start and Stop Frequencies
1. Press the Freq main menu key then the Start Freq submenu key.

2. Enter the desired start frequency using the keypad, the arrow keys, or the rotary knob.
When entering a frequency using the keypad, the submenu key labels change to GHz,
MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same
affect as pressing the MHz submenu key.

3. Press the Stop Freq submenu key and enter the desired stop frequency.

Enter the Center Frequency
1. Press the Freq main menu key.
2. Press the Center Freq submenu key.

3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary
knob. When entering a frequency using the keypad, the submenu key labels change to
GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the
same affect as pressing the MHz submenu key.

The center frequency and span is shown at the bottom of the screen.

Select a Signal Standard
1. Press the Freq main menu key.
2. Press the Signal Standard submenu key. The Signal Standards dialog box opens.
3. Highlight a signal standard and press Enter to select.
4. Press the Channel submenu key to change the channel value in the Channel Editor.

The signal standard is shown in yellow at the top of the screen.

Set the Measurement Bandwidth
1. Press the BW main menu key to display the BW menu.

¢ Press the RBW and/or the VBW submenu key to manually change the values.

e Set RBW and VBW automatically by pressing the Auto RBW submenu key or the
Auto VBW submenu key.

2. Press the RBW/VBW submenu key to change the resolution bandwidth to video
bandwidth ratio.

3. Press the Span/RBW submenu key to change the span width to resolution bandwidth
ratio.
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Set the Amplitude

Press the Amplitude main menu key to display the Amplitude menu.
Set Amplitude Reference Level and Scale

1. Press the Reference Level submenu key and use the arrow keys, rotary knob, or the
keypad to change the reference level. Press Enter to set the reference level value.

2. Press the Scale submenu key and use the arrow keys, rotary knob, or the keypad to
enter the desired scale. Press Enter to set the scale value.

Set Amplitude Range and Scale

1. The Auto Atten submenu key sets an optimal reference level based on the measured
signal.

Press the Scale submenu key.

3. Enter the desired scale units by using the keypad, the arrow keys, or the rotary knob.
Press Enter to set. The y-axis scale is automatically renumbered.

Power Offset Set Up for Compensating External Loss

To obtain accurate results, compensate for any external attenuation by using power offset.
In power offset mode, the compensation factor is in dB. (External attenuation can be created
by using an external cable or an external high power attenuator.)

Press the RL Offset submenu key and use the keypad, the arrow keys, or the rotary knob to
enter the desired offset value. When using the rotary knob, the value changes in increments
of 0.1 dB. Using the Left/Right arrow keys changes the value in 10% increments of the value
shown on the Scale submenu key. When using the Up/Down arrow keys, the value changes in
the increment shown on the Scale submenu key. When using the keypad, enter the new value
then press Enter or the dB submenu key to set the value. The power offset is displayed in the
instrument settings summary column on the left side of the measurement display.

Set the Span

1. Press the Span main menu key or the Freq main menu key followed by the
Span submenu key.

2. To select full span, press the Full Span submenu key. Selecting full span overrides any
previously set Start and Stop frequencies.

3. For a single frequency measurement, press the Zero Span submenu key.

To quickly move the span value up or down, press the Span Up 1-2-5 or Span
Note Down 1-2-5 submenu keys These keys facilitate a zoom-in, zoom-out feature in a
1-2-5 sequence.
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Single Limit Line
Press the Limit menu key to display the Limit menu.

1. Press the Limit (Upper / Lower) submenu key to select the desired limit line,
Upper or Lower.

2. Activate the selected limit line by pressing the On Off submenu key so that On is
underlined.

3. Press the Limit Move submenu key to display the Limit Move menu. Press the first
Move Limit submenu key and use the arrows keys, rotary knob, or keypad to change the
dBm level of the limit line.

4. Press the Back submenu key to return to the Limit menu.

If necessary, press the Set Default Limit submenu key to redraw the limit line in view.

Create a Limit Envelope
1. Press Shift then Limit (6) to open the Limit menu.
2. Press Limit Envelope.
3. Press the Create Envelope key.
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Setting Up Markers
Press the Marker main menu key to display the Marker menu.
Selecting, Activating, and Placing a Marker

1. Press the Marker 12 34 5 6 submenu key and then select the desired marker by using
the touch screen marker buttons. The selected marker is underlined on the Marker
submenu key.

2. Press the On Off submenu key so that On is underlined. The selected marker is
displayed in red and ready to be moved.

3. Use the rotary knob to place the marker on the desired frequency.
4. Repeat Step 1 through Step 3 to activate and move additional markers.
Selecting, Activating, and Placing a Delta Marker:

1. Press the Marker 1 2 34 5 6 submenu key and select the desired delta marker.
The selected marker is underlined.

2. Press the Delta On Off submenu key so that On is underlined. The selected marker is
displayed in red and ready to be moved.

3. Use the rotary knob to place the delta marker on the desired frequency.

4. Repeat Step 1 through Step 3 to activate and move additional markers.
Viewing Marker Data in a Table Format

1. Press the More submenu key.

2. Press the Marker Table On Off submenu key so that On is underlined. All marker and
delta marker data are displayed in a table under the measurement graph.

iﬂnl‘itsu 03/29/2011 03:10:21 pm = : Marker 1/2
2l Marker

Ref Lvl

-40.0 dEm 123458

Input Atten
0.0 dB

Detection
8
i — 5
LAJ u M D | Peak Search
h

i ikl
fl-m.h .wﬂl\ "w"'.*’»’.*._l‘i‘ﬂu'n,"‘...lu MY L'L‘u.I\ Lﬂl\,ilﬁl-"u'l‘-,- |‘ﬁin\|\l‘l|‘«|| I‘.'I{‘,Jh'.,-'a' .‘JJR-..J lllirl' Lyt I \'.1|\|‘-_,III‘»J.M-.JM‘Ilrlf'.‘J VR

to

a1
l-' |,;| r».JHI J-,a\\'._ﬂf'\\||,,‘p'nml~llq\\j i
} i

Center
Marker

to
Ref Lyl
:i)‘_\l!eep = z ; Mare
Continuous Peak

Oplions —p

amplitude Marker

Figure 3-7. Marker Table

3-12 PN: 10580-00318 Rev. AC S412E UG



Quick Start Guide 3-5 Spectrum Analyzer

Select a Smart Measurement Type

In Spectrum Analyzer mode, press Shift then Measure (4) and select a smart one-button
measurement using the submenu keys. The smart one-button measurements are built-in for
field strength, occupied bandwidth, channel power, adjacent channel power ratio, and carrier
to interference ratio (C/I) tests. In addition, AM/FM demodulation is available to aid in the
identification of interfering signals. Refer to the Spectrum Analyzer Measurement Guide
listed in Appendix A, “Measurement Guides” for additional information.
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3-6 NBFM Analyzer

Set the instrument to NBFM Analyzer mode as described in Section 3-2 “Measurement Mode
Selection” on page 3-1.

The following Quick Start instructions apply to the NBFM mode. For detailed
Note measurement instructions, refer to the Land Mobile Measurement Guide
P/N 10580-00243, listed in Appendix A.

Set the Receiver (Rx) Frequency
1. Press the Freq main menu key.
2. Press the Rx Freq submenu key.

3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary
knob. When entering a frequency using the keypad, the submenu key labels change to
GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the
same affect as pressing the MHz submenu key. The center frequency and span are
shown at the bottom of the spectrum display. Press the Span submenu key to adjust the
measurement span.

Press Setup main key. Use the submenu keys to select the Tone Type.

Under the Amplitude main menu, the Auto Rx Range default will adjust the reference
level to display the received signal. To adjust the settings, press Adjust Rx Range then
set the Ref Level and Scale.

The maximum input power without damage is 2 Watts (+33 dBm) to the RF In
Caution 50 Ohm connector. To prevent damage, use a coupler or attenuator to reduce the
input power to below this level when measuring high output power devices.

Set the Signal Source Transmit (Tx) Frequency

The LMR Master contains a signal generator and test patterns for analog FM land mobile
radios. The maximum output power is 1.0 milliwatt.

1. Press the Freq main menu key.
2. Press the Tx Freq submenu key.

3. Enter the desired frequency using the keypad, the arrow keys, or the rotary knob.
When entering a frequency using the keypad, the submenu key labels change to GHz,
MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same
affect as pressing the MHz submenu key.

Bind the transmit frequency to receive frequency using the Rx/Tx Coupling and

Note Coupling offset submenus under the Frequency menu.

4. Press Setup main key and use the Tx pattern submenu key to set the transmit pattern.
Press Enter after selecting a pattern. Based on the pattern selected, set the
AM Percentage or the FM Deviation and Tone Deviation (under the More menu).
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5. Under the Amplitude main menu, set the signal generator output power using the
Tx Output Lvl submenu.

6. Press the Turn Sig-Gen ON main menu key to turn on the internal signal generator.
The menu button display Turn Sig-Gen OFF when the generator is running.

Rx and Tx Power Offset

To obtain accurate results, compensate for any external attenuation or gain by using the
Rx Power Offset or Tx Power offset submenus under the Amplitude main menu key. In power
offset mode, the compensation factor is in dB.

Press the Rx Power Offset or Tx Power Offset submenu key and use the keypad, the arrow
keys, or the rotary knob to enter the desired offset value. When using the rotary knob, the
value changes in increments of 0.1 dB. Using the Left/Right arrow keys changes the value in
10% increments of the value shown on the Scale submenu key. The power offsets for Tx and
Rx are displayed in the instrument settings summary column on the left side of the
measurement display.

Select the Measurement Types

NBFM Analyzer Measurement

1. Press the Measurement main menu key, then press the NBFM Analyzer submenu key.
Press Graph Type to set the displayed graph types (Figure 3-11).

2. Select the graph to change with the Active Graph submenu key or the touchscreen.
Change the graph with the Graph Type submenu key.
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NBFM Coverage Measurement
Press the Measurement main menu key, then press the NBFM Coverage submenu key

twice (Figure 3-13).
2. Refer to the Land Mobile Radio Measurement Guide listed in Appendix A for details on
creating a map and coverage mapping.
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Figure 3-10. NBFM Coverage Measurements

NBFM Quieting and NBFM SINAD Measurements
Refer to the Land Mobile Radio Measurement Guide listed in Appendix A for details on radio
sensitivity testing using the 12 dB SINAD and 20 dB Quieting methods.
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3-7 LMR Digital Demodulation Signal Analyzers

Set the instrument to P25/P25p2 Analyzer, NXDN Analyzer, dPMR Analyzer,
DMR Analyzer, PTC-ITCR Analyzer, PTC-ACSES Analyzer, or TETRA Analyzer mode as
described in Section 3-2 “Measurement Mode Selection” on page 3-1.

The following Quick Start instructions apply to the Land Mobile Radio modes. For
Note detailed measurement instructions, refer to the Land Mobile Measurement Guide
P/N 10580-00243, listed in Appendix A.

Set the Receiver (Rx) Frequency
1. Press the Freq main menu key.
2. Press the Rx Freq submenu key.

3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary
knob. When entering a frequency using the keypad, the submenu key labels change to
GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the
same affect as pressing the MHz submenu key. The center frequency and span is shown
at the bottom of the spectrum display. Press the Span submenu key to adjust the
measurement span.

4. Press Setup main key. Use the submenu keys to select the Mod Type (Mod Bandwidth in
NXDN) and Rx pattern (not applicable to either PTC-ITCR or PTC-ACSES mode).

5. Under the Amplitude main menu, the Auto Rx Range default will adjust the reference
level to display the received signal. To adjust the settings, press Adjust Rx Range then
set the Ref Level and Scale.

Set the Signal Source Transmit (Tx) Frequency

The LMR Master contains a signal generator and test patterns for LMR antenna and receive
system verification. The maximum output power is 0 dBm (1.0 mW).

Note Generation of dPMR signals are not currently supported by the LMR Master.

Press the Freq main menu key.
2. Press the Tx Freq submenu key.

Enter the desired frequency using the keypad, the arrow keys, or the rotary knob.
When entering a frequency using the keypad, the submenu key labels change to GHz,
MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same
affect as pressing the MHz submenu key.

If desired, the transmit frequency can be bound to the receive frequency using the

Note Rx/Tx Coupling and Coupling offset submenus under the Frequency menu.

4. Press Setup main key and use the Tx pattern submenu key to set the transmit pattern.
Press Enter after selecting a pattern. PTC modes Only: Set the Symbol Rate.
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5. Under the Amplitude main menu, set the signal generator output power using the
Tx Output Lvl submenu.

6. Press the Turn Sig-Gen ON main menu key to turn on the internal signal generator.
The menu button display Turn Sig-Gen OFF when the generator is running.

Rx and Tx Power Offset

To obtain accurate results, compensate for any external attenuation or gain by using the

Rx Power Offset or Tx Power offset submenus under the Amplitude main menu key. In power
offset mode, the compensation factor is in dB. (External attenuation can be created by using
an external cable or an external high power attenuator.)

Press the Rx Power Offset or Tx Power Offset submenu key and use the keypad, the arrow
keys, or the rotary knob to enter the desired offset value. When using the rotary knob, the
value changes in increments of 0.1 dB. Using the Left/Right arrow keys changes the value in
10 % increments of the value shown on the Scale submenu key. When using the Up/Down
arrow keys, the value changes in the increment shown on the Scale submenu key. When
using the keypad, enter the new value then press Enter or the dB submenu key to set the
value. The power offsets for Tx and Rx are displayed in the instrument settings summary
column on the left side of the measurement display.

Select the Measurement Types

Analyzer Measurements

1. Press the Measurement main menu key, then press the P25 Analyzer, P25p2 Analyzer,
NXDN Analyzer, dPMR Analyzer, DMR Analyzer, PTC-ITCR Analyzer, PTC-ACSES
Analyzer, or the TETRA Analyzer submenu key. Press Graph Type to set the displayed
graph types (Figure 3-11).
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2. Select the graph to change with the Active Graph submenu key or the touchscreen.

Change the graph with the Graph Type submenu key.
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Figure 3-11. Analyzer Measurements (Active Graph has the Red Outline)
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3-7 LMR Digital Demodulation Signal Analyzers

Quick Start Guide

Control Channel Measurement (not available in dPMR, PTC-ITCR and PTC-ACSES, or
TETRA modes)

1.
2.

Press the Setup main menu and set the Rx Pattern to Ctrl Channel or Voice.

Press the Measurement main menu key, then press the P25 Control, P25p2 Control,
NXDN Control or DMR Control submenu key twice.

To save control channel data for additional analysis, insert a formatted USB memory
device into the LMR Master and turn Log Data On.

Set the Hex Trigger, Sweep and Set Trigger Value (Figure 3-12). The Hex Trigger menu
and Hex Trigger Value menu are used to find a specific opcode in the Control Channel
data. To set the hex trigger value, press the Set Trigger Value menu. An on screen
keyboard will display and with the numbers 0 to 9 and the letters A to F. Enter the two
character hex value to search for. After entering the value, press Enter to set the trigger
value. Press Esc to cancel entry or changing the current hex value.

Setting Hex Trigger to On will set the Sweep function to Hold when the hex trigger value
is found in the first octet of a packet. The octet row with the found trigger value will be
displayed in the middle of the table. If Log Data is set to On, all of the data on the screen
is saved and Log Data is set to Off. When Sweep is set back to Run, the unit will
continue to collect data and stop on the next instance of the hex trigger value. To
continue to capture data to the USB memory device, set Log Data back to On before
setting Sweep to Run mode.

|/1nl‘itSL| 0343072011 08:05:59 am = - Contral Channel
Log Data
an Off.
ot e Date Tirme Qctets ———
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03/30/2011 |09.05:55 |30 00 03 |22 D0 (32 0 25 10 A2 63 AD|a3a] 7
03/30/2011 [09.0555 |30 00 03 (22 D0 |32 04 25 10 A2 63 AD |3 7
03/30/2011 | 09:05:55 | BD | @0 03 |22 D0 | 82 04 |25 | 10 | A2 | 87 | 84 [321] 7
Hex Trig 03/30/2011 | 09:05:55 | 30 | 00 03 |22 D0 |32 0~ |25 | 10 | A2 | 63 | AD[321] 7
OFF 03/30/2011 | 090555 |30 00 03 22 DO 32 0 25 10 A2 B3 A0 |3e1| 7 ELEER
Hex Trig Val 03/30/2011 | 09.05:55 |BD 00 03 22 DO 32 04 25 10 A2 87 94 |321) 7
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Figure 3-12. Control Channel Measurement
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This measurement is captured on an external USB memory device. The captured

Note data file can not be recalled and displayed on the instrument screen.
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3-7 LMR Digital Demodulation Signal Analyzers Quick Sta

rt Guide

Coverage Measurements

1.

Press the Measurement main menu key, then press the P25 Coverage,

P25p2 Coverage, NXDN Coverage, dPMR Coverage, DMR Coverage, PTC-ITCR
Coverage, PTC-ACSES Coverage, or TETRA Coverage submenu key twice
(Figure 3-13).

Refer to the Land Mobile Radio Measurement Guide listed in Appendix A for details on

creating a map and coverage mapping.

|/|nritsu 0a/22/2011 01:2928 pm @D M 370 6747 W 1210 39 24" | - Coverage Mapping
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-

: - ! Distance/Time
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&I z Setup —p
Symhbol Rate -84.9 dBm '
G000 Wery Good: »=-90.0 dBm .Pnnr <-110.0 dBm -

Auto Rx Range e
on Garat; e==HD ¢ 1100 dBm__-50.0 dEm
Frequency I Amplitude I Setup I heasurement I Start Data Collection

Figure 3-13. Coverage Measurements
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Quick Start Guide 3-7 LMR Digital Demodulation Signal Analyzers

Bit Capture Measurement (not available in dPMR, PTC-ITCR and PTC-ACSES, or TETRA

modes)
1. Press the Setup main menu and set the Rx Pattern to Voice.
2. Press the Measurement main menu key, then press the P25 Bit Capture,
P25p2 Bit Capture, NXDN Bit Capture or DMR Bit Capture submenu key.
3. To save bit capture data for additional analysis, insert a formatted USB memory device

into the LMR Master and turn Log Data On. (Figure 3-14).
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D0 OB Bl LOss T Fe 6

23 | a4 EC | DO cE 0

D& | 0& A0 | EE 2B Fo

o | F5 4D | &7 83 20
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5z | @& | £2 | 25 9z AE

cO | F5 40 | 5D 04 23
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Tx Pwr Offse
0.0 dB Ext Los

Squelch Lvi
—40.0 dBm

Frequency Amplitude Setup heasurement Turn Sig-Gen OK

Figure 3-14. Bit Capture Measurement

IQ Capture Measurement

Insert a formatted USB memory device in the USB port of the LMR Master.

Press the Measurement main menu key, then press the P25 IQ Capture, P25p2 1Q
Capture, NXDN IQ Capture, dPMR 1Q Capture, DMR IQ Capture, PTC-ITCR, PTC-ACSES,
IQ Capture, or TETRA IQ Capture submenu key.

After a few seconds the LMR Master will display the message “IQ Capture Complete”.

The IQ data is stored on the USB memory device under the /usr folder in a date
stamped folder. The file will be I0 CAPTUREyearmonthdaytime.p25 (or .p252, .nxdn,
.dpmr, .dmr2, .ptc, .acses, or .tetra).

Note

These measurements are captured on an external USB memory device. The
captured data file can not be recalled and displayed on the instrument screen.
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Quick Start Guide

3-8 Saving Measurements

The LMR Master can save files in the following formats based on measurement mode and
installed options:

filename

filename.
filename.
filename.
filename.

filename.

filename

filename.
filename.
filename.

filename.

filename

filename.
filename.
filename.

filename.

filename

filename.

filename

filename.
filename.
filename.
filename.

filename.

filename

.spa for SPA measurement

mna for VNA and VVM measurements

s2p S2P (SnP) for VNA S-parameter measurements
hipm for High Accuracy Power Meter measurements
pm for Power Meter measurements.

cwsg for CWSG measurements.

.afp for AM/FM/PM measurements

ia for Interference Analysis measurements
cs for Channel Scanner measurements
wmxd for WiMAX

wmxe for Mobile WiMAX

.1te for LTE measurements

tdlte for TDD LTE measurements

nbfm for NBFM measurements

p25 for P25 measurements

p252 for P25p2 measurements

.nxdn for NXDN measurements

dpmr for dPMR measurements

.dmr2 for DMR measurements

ptc for PTC-ITCR measurements

acses for PTC-ACSES measurements
tetra for TETRA measurements

jpg for JPEG images

stp for Setup files

.1im for Limit lines

Note

The LMR Master is not fully supported in Master Software Tools.
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Quick Start Guide 3-9 External Power On

Procedure for Saving Files:
1. Press Shift then File (7).
2. Press Save.

3. Press Change Save Location and set the current location to be the USB memory device
or internal memory, and then press Set Location.

4. Press Change Type (Setup/JPG/...) and select the desired file type from the Select File
Type list box and press Enter.

5. Enter the filename by using the keyboard and then press Enter.
Refer to Chapter 4, “File Management” for additional details about working with files.

39 External Power On
This feature allows the LMR Master to restart when external DC power is applied.

This source of external power is applied to the power connector as described in “External
Power” on page 2-11. This connector is shown as item 9 in Figure 2-8 on page 2-10. When this
feature is enabled from the Power—On menu, the LMR Master (when Off) automatically
restarts when external DC power is applied. Refer to “Power—On Menu” on page 5-15.

When this feature is enabled, the LMR Master in the off state will turn on when external DC
power is applied. The instrument turns off when external power is removed, even if a battery
is installed. This is useful for high-reliability remote operation, where the instrument may
need to be rebooted using a remotely-controlled power switch. In this mode however, the
Power button causes the instrument to restart.

If the instrument is turned on with the power switch, then external power is removed, the
instrument will continue to run until the battery is depleted. It will come on and the battery
will begin recharging when external power is applied. This state is useful when the
instrument is in a location where the power source may be interrupted.
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Chapter 4 — File Management

4-1

Introduction

This chapter describes the file management features of the LMR Master and describes the
File menu. The submenus under this menu allow you to save, recall, copy, and delete files in

internal

4-2

memory or to an external USB memory device.

File Types

Filename extensions that are used in the LMR Master:

° *
° *
° *
° *

.spa for SPA measurement
.mna for VNA and VVM measurements
.s2p S2P (SnP) for VNA S-parameter measurements

.hipm for High Accuracy Power Meter measurements

« *_pm for Power Meter measurements.

e *_ cwsg for CWSG measurements.

e *_ afp for AM/FM/PM measurements

e *_ia for Interference Analysis measurements
e *_cs for Channel Scanner measurements
e * wmxd for WiMAX

e * _wmxe for Mobile WiMAX

e *_1te for LTE measurements

e * _tdlte for TDD LTE measurements

e * _nbfm for NBFM measurements

e * .p25 for P25 measurements

e *.p252 for P25p2 measurements

e * _nxdn for NXDN measurements

e * _dpmr for dAPMR measurements

e * _dmr2 for DMR measurements

e * _ptc for PTC-ITCR measurements

e *_asces for PTC-ACSES measurements

e *_tetra for TETRA measurements

e *.jpg for JPEG images

 *.stp for Setup files

e *_1im for Limit lines

Note S2P is a standard ASCII text file format that is used for scattering parameters from

a 2-Port measurement. It is a subset of SnP (where n equals the number of ports).
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4-3 Managing Files File Management

4-3 Managing Files
Press the Shift key then the File (7) key on the numeric keypad to list the File menu.

When navigating through the File menu, pressing the Esc key returns to the

Note .
previous menu.

Save Files
Set the Save Location

Press Save then the Change Save Location submenu key and select the location to save files.
Files can be saved to the internal memory or to an external USB memory device. New folders
can be created at either location. Press Refresh Directories to update the location tree. Press
the Set Location key to set the save location.

Save Measurement As

The Save Measurement As key is used to quickly save measurements with a specific file
name. The LMR Master saves the measurement with the latest file name that was used to
save a measurement and with a number that is automatically incremented and appended to
the end of the file name. For instance, if the last measurement was saved with the name
System Return Loss, Save Measurement As saves the next measurement as System Return
Loss_1, System Return Loss_2, etc. The file name used can be changed using the Save dialog
box (Figure 4-1).

Save a Measurement
Press the Save Measurement key and enter the name for the measurement file.
Save a Setup

Press the Save submenu key, type a name for the setup file, confirm that the file type is Setup
using the Change Type key or the touchscreen, and then press Enter to save.

Create a Menu Shortcut for a Setup File

Press the Recall submenu key to display saved setup files. Locate the setup file to shortcut
and then using the touch screen press and hold on the file name for a few seconds. Select a
location in the shortcut grid to save the setup file.

Save a Measurement Screen as JPEG

Press the Save submenu key, type a name for the JPEG file, confirm that the file type is Jpeg,
and press Enter to save.

4-2 PN: 10580-00318 Rev. AC S412E UG



File Management 4-3 Managing Files

Save Dialog Box

The save dialog box (Figure 4-1) is used to store files on the internal memory or an external
memory device. The file type, file name, and save location are set starting with this display.
Refer to “Save Menu” on page 4-9 and “Save Location Menu” on page 4-10 for details.

Note The Save Dialog Box will vary based on current measurement mode.

[ Anritsu osrosizo10 10:02:33 am H T Save

Save

Location: Intarnal MemonyyvMAS

Filename: ||kl

Filetype

Measurement

GG e e
TE R
[ e

B e

Change

Space Save Location

Change Type
Cuiick Mame 1 Guick Mame 2 Guick Mame 3 Gluick Mame 4 Guick Name &

Setup/JPEGY.

‘ Freg/Dist I Scale I Sweep I Measure I fdarker

Figure 4-1. Save Dialog Box

Quick Name Keys

Quick Name keys (located below the keyboard in Figure 4-1) allow you to enter quick names
for frequently used parts of file measurement names. To edit the keys, press the Shift key,
then the File (7) key. Press Save then the Change Quick Name key, and select one of the
Quick Names for editing. Press Enter and enter the new name for the key. Press Enter again,
and the new name is displayed on the Quick Name key.

When entering filenames, use the quick name keys in any order in combination with the
keyboard to create measurement filenames.
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Recall Files

The recall menu enables you to view all of the Measurement and Setup files in the internal
memory and in an external USB memory device.

You can sort the recall menu by name, date, or type. You can also choose to view only
measurement files or setup files by pressing File Type on the Recall dialog box and selecting
the file type that you want to view.

Recall a Measurement

From the File menu, press the Recall Measurement submenu key, select the measurement
with the touchscreen, rotary knob, or the Up/Down arrow keys, and then press Enter.

Recall a Setup
Press the Recall submenu key. Confirm that the file type is Setup or All. Select the setup file

(. stp) with the touchscreen, rotary knob, or the Up/Down arrow keys, and then press Enter.
Recall Dialog Box

The Recall dialog box (Figure 4-2) opens previously saved measurements and setups. Refer
to the “Recall Menu” on page 4-12 for additional information.

[Anritsu osmerzu0s 035325 pr E ] Recall
Recall Sort By
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4
Filetype IALL j Sort Order
Scroll to File and Press Enter to Recall s Desc
File Type
=] & Internal hemory | ALL
& [ 05061404 _1 ——
(i [T 12k NEW_FOLDER
] Directories
r @ FileMame.dtf-rl 05/06/2009 10:54:06 a.m
P %FileName.rl 04/30/2009 01:03:00 p.m.
r % FileMame.stp RL 04/30/2009 01:03:10 p.m.
r % FileMame_s1 otf-rl 05/06/2009 10:56:20 a.m.
- % Setupd. stp RL 05/05/2009 03.17:20 p.m.
L % SetupG.stp 05/05/2009 03:21:20 p.m.
’usa 1

| Freg/Dist I Amplitude I Sweep/Setup I Measurements I Marker

Figure 4-2. Recall Dialog Box
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Copy Files

The steps below describe copying a file from internal memory to an external memory device.
Select the files to copy in the top window and the location for the files (to be copied) in the
bottom window (Figure 4-3). Refer to the “Copy Menu” on page 4-13 for additional

information.

1. Insert a USB memory device into either USB Type A port of the LMR Master.

2. From the File main menu, press the Copy submenu key. The Copy menu and Copy
dialog box are displayed.

3. Select the files that are to be copied. To select multiple files, highlight the first file, then
press the Select or De-Select key to keep the file selected. The selected file is outlined in
blue. Repeat with all the files that are to be copied. To display files in a folder, select the
folder and press the Enter key.

4. Press the Scroll key and highlight the USB memory device in the lower window using
the touch screen or the Up/Down arrow keys. The Scroll submenu key toggles between
source and destination, Src (top window) and Dst (bottom window).

5. Press the Copy key to copy the files to the memory device.
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Select Files or Directory to Copy A5 Desc
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@ﬂﬁﬂﬁ?ﬂﬂm 54519 inn NSMNRZONG NF4570 0 m L
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Directories

Ste Dst
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=] _:5; ]
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Figure 4-3. Copy Dialog Box
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4-3 Managing Files

File Management

Delete Files

Press the Delete submenu key. Highlight the file to be deleted with the touchscreen or the
Up/Down arrow keys. Press the Select or De-Select key. Selected files are outlined in blue.

Press the Delete key and then press Enter to delete the selected file.

Delete Dialog Box

Press the Delete submenu key to open the Delete dialog box (Figure 4-4). The menus allow
sorting by file type, name, and saved date. Refer to the “Delete Menu” on page 4-14 for
additional information.
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Figure 4-4.
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4-4 File Menu Overview
Open this menu by pressing the Shift key, then the File (7) key.

File
N
Save Measurement As
FileName.vna
Save
> Save
Measurement
/\_/
/_\_/
Save
—
Restore
LMR Analyzer Sale Default Quick
Modes Only On Save On... Name Butions |
Event N N
...Crossing Limit Change
Recall
—_— Recall on off Quick Name
Measurement N <
Sort By ...Sweep Complete Change
—_— Save Location
Recall Name Type Date On off Save Location
< /| Sort By
—< Sort Order <
Change Type Menu Name Type Date
V4
- Ascend Descend i
Copy @ == / SetuplJPEG/etc. | Varies by P
\ \ / Mode
—< File Type Save Then Stop
Ascend Descend
Delete - . Measurement On off <
< < Create
Vi Refresh
Clear All Folder
Directories <
/| Set
T~ - Location
o~ ¢
N
—\ Refresh
@ Copy Delete Back Directories
N N
Sort By Sort By «— /
Name Type Date Name Type Date
Sort Order Sort Order
Ascend Descend Ascend Descend
File Type File Type
ALL ALL
Refresh Select
or
Directories De-Select
Scroll
Delete
Src Dst
Select Refresh
or
De-Select Directories
Copy
Vi

Figure 4-5. File Menu and its Submenus
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File Management

4-5

Key Sequence: File

File Menu

File

N
Save Measurement As
FileName.vna
Save

Measurement

—<

Save

Save
On
Event

Recall

Measurement

Recall

——<

Copy

—<

Delete

Save Measurement As: Press this submenu key to save the current setup
with a user defined filename. The default filename is changed using the Save
menu. To change the default file name, type in a new file with the touch
screen keyboard and press Enter. After a few seconds, the screen returns to
File menu. Press the Save Measurement As key again and the new file
name is used.

Save Measurement: Press this submenu key to display the “Save Menu”
on page 4-9 and the touch screen keyboard. Measurements can be saved to
internal memory or to a USB memory device. The saved measurement can
be named by using the touch screen keyboard. By default, measurements
are saved to internal memory in a directory named /user. The save
destination is set with the “Save Location Menu” on page 4-10.

Save: Press this submenu key to display the “Save Menu” on page 4-9 and
the touch screen keyboard. Measurements can be saved to internal memory
or to a USB memory device. The saved setup, measurement, or JPEG file
can be named by using the touch screen keyboard. By default,
measurements are saved to internal memory in a directory named /user. The
save destination is set with the “Save Location Menu” on page 4-10.

Save on Event: Press this submenu key to display the “Save On Event
Menu” on page 4-11. This submenu key is displayed only in LMR Analyzer
modes.

Recall Measurement: Press this submenu key to display the “Recall
Menu” on page 4-12. This menu is for recalling measurements from internal
memory or from a USB memory device.

Recall: Press this submenu key to display the “Recall Menu” on page 4-12.
This menu is for recalling measurement or setup data from internal memory
or from a USB memory device.

Copy: Press this submenu key to display the “Copy Menu” on page 4-13.
The Copy menu is for copying files or folders from internal memory or a USB
memory device.

Delete: Press this submenu key to display the “Delete Menu” on page 4-14
and a selection box that shows the setup and measurement names and the
type, date, and time that the information was saved. Use the rotary knob or
the Up/Down arrow keys to highlight the file that is to be deleted and press
the Delete submenu key, then press Enter. Press the Esc key to cancel the
operation. Note that deleted files cannot be recovered.

Figure 4-6.

File Menu
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File Management

4-5 File Menu

Save Menu

The top keys in the Save menu display the available file-type save options based on the
current measurement mode.

Key Sequence: File > Save

Save

/\_/
/\_/

—

Restore
Default Quick
Name Buttons

Change
Quick Name
Change
Save Location
Change Type

Setup/JPEG/...

Restore Default Quick Name Buttons: Press the submenu key to restore
the default names (Quick Name 1, Quick Name 2, etc.).

Change Quick Name: Press this submenu key to change the Quick Names
that are displayed at the bottom of the touch screen keyboard (Figure 4-1).
Select the Quick Name to edit and press Enter. Type the new Quick Name
and press Enter again. The new Quick Name is displayed on the
corresponding Quick Name button below the keyboard.

Change Save Location: Press this submenu key to open the “Save Location
Menu”.

Change Type Setup/JPEGI... Press this submenu key to select among the
various file types available for setup and measurement data. This submenu
key also opens the File Type menu with a submenu key to select Full screen

2 |or Graph Only images for JPEG file types.

Figure 4-7. Save Menu
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Save Location Menu

This menu and dialog box are used to create folders and to select the location where the
LMR Master saves the current file. Select folders or drives with the Up/Down keys, the rotary
knob, or the touch screen.

Only folders (not files) are visible in the Save Location dialog box. To view files, use

Note the “Recall Menu” on page 4-12.

Key Sequence: File > Save > Change Save Location

Sort By
< Name Date type: Press this submenu key to sort the folders by Name,
Sort By Type, or Date.

Save Location

Na_me Type Date sort Order
Asc Desc: Press this submenu key to display the folder names in
Sort Order ascending or descending order.

Ascend Descend [ | Create Folder: Press this submenu key to create a new folder in the
highlighted location or folder. Name the new folder in the create directory

Create dialog box.

Folder Set Location: Press this submenu key to set the current location for saving

ot files and then return to the “Save Menu” on page 4-9.
€

Refresh Directories: Press this submenu key to update the display.
Location

Refresh

Directories

Figure 4-8. Save Location Menu

| ANritsu oaso7e2008 044016 pro [55] |

Select Save Location

&Intemal hemory I

=] ' |
BEBE
T/ MEW_FOLDER

Figure 4-9. Select Save Location Dialog Box
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Save On Event Menu

In all Spectrum Analyzer, Interference Analyzer, and LMR Analyzer modes, this menu is
used to auto save measurements to internal memory after a set events occur.

Key Sequence: File > Save On Event

...Crossing Limit

< | On Off: Toggling this submenu key to On sets the LMR Master to save
-..Crossing Limit the measurement to internal memory when the measurement has crossed a
defined limit line that has been created with the Limit menu.

Save On...

on off
...Sweep Complete
iy Calnllis On Off: Toggling this submenu key to On sets the LMR Master to save

the measurement to internal memory after the current sweep is complete. If

o) off

= Save Then Stop is toggled Off, then a measurement is saved after every
Save Then Stop sweep.

on off Save Then Stop

—— On Off: Toggling this key to On sets the LMR Master to stop the sweep
after a measurement is saved. With this key Off and Sweep Complete On, a
Clear Al measurement is saved after every sweep.

/] | Clear All: Press this key to turn Off all three save-on-event keys:
- Crossing Limit

/\_ﬂ Sweep Complete

O\
Save Then Stop

Back

% Back: Press this key to return to the “File Menu” on page 4-8.
/

Figure 4-10. Save On Event Menu (Spectrum and Interference Analyzer Modes)

Squelch Crossing
Save On.. On Off: Toggling this submenu key to On sets the LMR Master to save
Squelch Crossing Y | the measurement to internal memory when the measurement has crossed a
defined squelch level that has been set via the Setup menu.
On Off
/| | Back: Press this key to return to the “File Menu” on page 4-8.
%
N\
Back
- /

Figure 4-11. Save On Event Menu (LMR Analyzer Modes)
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File Management

Recall Menu

This menu and its dialog box are used to select the location from which the LMR Master
recalls a file. Select folders or drives with the Up/Down arrow keys, the rotary knob, or the

touch screen.

Key Sequence: File > Recall

Recall

Sort By
Name Type Date
Sort Order
Ascend Descend
File Type
ALL
Refresh

Directories

Use these menu keys to change the way files are listed in the Recall dialog
box. Navigate to the desired file, then press Enter to recall.

When recalling a saved setup, all current instrument settings are replaced by
the stored setup information. When recalling a saved measurement and
multiple traces are displayed, parameter settings shown on the instrument
screen may reflect those of the recalled trace or the active trace, depending
on the measurement mode or other factors.

Sort By
Name Date Type: Press this submenu key to sort files and folders by the
file name, by the type of file, or by the date that the file or folder was saved.

Sort Order
Asc Desc: Displays the folder or file in ascending or descending order
based on the selection in the Sort By key.

File Type: Press this submenu key to select the type of file to be viewed.
The file type can be changed with the Up/Down arrow keys, the rotary knob,
or the touch screen. Press Enter to make the selection. Refer to

Section 4-2 “File Types” for file type descriptions.

Refresh Directories: Press this key to update the display.

Figure 4-12. Recall Menu
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Copy Menu

This menu and dialog box are used to copy folders and files. Select folders or files with the
Up/Down arrow keys, the rotary knob, or the touch screen. Figure 4-3 on page 4-5 shows the
Copy dialog box with two JPEG images and one folder (including the folder contents) selected
and ready to be copied to the USB memory device. Highlight a folder and press Enter to view
the contents.

Key Sequence: File > Copy

Sort By
< Name Type Date: Press this submenu key to sort file and folder lists
Sort By by name, by type of file, or by the date that a file was saved.

Copy

Name Type Date Sort Order
Asc Desc: Press this submenu key to display the folders or files in
St Crdla ascending or descending order based on the selection in the Sort By key.

Ascend  Descend | | File Type: Press this submenu key to select the type of files to view for
< copying. The file type can be changed with the Up/Down arrow keys, the

File Type rotary knob, or the touch screen. Press Enter to make the selection. Refer
AL to Section 4-2 “File Types” for file type descriptions.
oo Refresh Directories: Press this submenu key to update the display.
efres
Scroll
Directories Src Dst: Press this submenu key to use the scroll function in the Source
Serol Folder (Src or top panel) or in the Destination Folder (Dst or bottom panel).
Refer to Figure 4-3.
Src Dst Select or De-Select: Press this submenu key to select or deselect the files
o or folders to be copied. When selected, a file or folder is outlined in blue.
ar Refer to Figure 4-3.
De-Select

Copy: Press this submenu key to copy the files or folders that are selected
in the top window to the destination that is selected in the bottom window. A
Copy dialog box indicates when the copying is complete. If a file with the same
name exists in the destination folder, then a warning box is displayed to
allow file overwrite or cancel.

/

Figure 4-13. Copy Menu
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File Management

Delete Menu

This menu and dialog box are used to delete folders and files. Select folders or files with the
Up/Down arrow keys, the rotary knob, or the touch screen.

Key Sequence: File > Delete

Delete

Sort By
Na_me Type Date
Sort Order
Ascend Descend
File Type
ALL
Select

or
De-Select

<

Delete

Refresh

Directories

/

Sort By
Name Date Type: Press this submenu key to sort files and folders
by name, by the type of file, or by the date that the file or folder was saved.

Sort Order
Asc Desc: Press this submenu key to display the folders or files in
ascending or descending order based on the selection in the Sort By key.

File Type: Press this submenu key to select the type of file to be deleted.
The file type can be changed with the Up/Down arrow keys, the rotary
knob, or the touch screen. Press Enter to make the selection. Refer to
Section 4-2 “File Types” for file type descriptions.

Select or De-Select: Press this submenu key to select or deselect the files
or folders to be deleted. When selected, a file or folder is outlined in blue.

Delete: Press this submenu key to open the Delete dialog box. Press
Enter to delete the selected item, or press Esc to Cancel.

Refresh Directories: Press this submenu key to update the display.

Figure 4-14. Delete Menu
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Chapter 5 — System Operations

5-1

Introduction

This chapter describes the LMR Master system operations.

“System Menu Group Overview” on page 5-2
“System Menu” on page 5-4

“Preset Menu” on page 5-19

“Self Test” on page 5-19

“Updating the LMR Master Firmware” on page 5-20

The other menus (Sweep, Measure, Trace, and Limit) are described in the Measurement
Guides that are listed in Appendix A.

S412E UG PN: 10580-00318 Rev. AC



5-2 System Menu Group Overview System Operations

5-2 System Menu Group Overview

To access the functions under the System menu, press the Shift key, then the System (8) key.
Figure 5-1 and Figure 5-2 show the menu subgroups that are accessible from the System
menu. Menu maps typically display all possible submenu keys, although some keys are

displayed on the instruments only under special circumstances (refer to the menu
descriptions on the following pages).

Note that the paths indicated by numbered circles are shown in Figure 5-2.

System Menu Group Map 1

System GPS System Options — Display Settings
GPS Date
Status & Brightness
On Off Time N
Self Ethernet
GPS Info —»@ Display Blank
Test Config
Application GPS Voltage @
Self Language Default Colors
Test 33V 5V
—<
@)
GPS % Display | Black on White
—> —>
Reset Name Night Vision
Calibrate O
Touch Back Volume High Contrast
Screen
< /
Application (@]
@ Reset @ Color on White
Options
P —
System
More @ Back
Options
prens — —
Figure 5-1. System Menu Map — Part 1

5-2
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5-2 System Menu Group Overview

System Menu Group Map 2

©

®

®

®

Ethernet Reset System Options 2/2 Application Options
Type Factory Share CF & Impedance
Pwr Offset
Manual DHCP Defaults All Modes Not Shared 50 Ohm 75 Ohm Other|
Field Master Set
Remote Access Bias Tee
1P G-Way Sub Reset Password N
Update
First Octet Power-On Auto Ref Level
Firmware
irmwar N
Second Octet % %
N N
Input Power
Third Octet Back Warning Back
On Off
S / — &
/\/
Fouth Octet T —
—\
Back

Figure 5-2.

System Menu Map — Part 2

To access the functions under the System menu, press the Shift key, then the System (8) key.

Note

The display settings will vary based on the current measurement mode.

S412E UG
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5-3 System Menu

System Operations

5-3

System Menu

Key Sequence: Shift, System (8)

Svstom Status: Press this submenu key to display the current system status,
! « | including the operating system and firmware versions, temperatures and
other details such as current battery information. Press Esc or Enter to
s return to normal operation.
Self Test: Press this submenu key to initiate a series of diagnostic tests that
Self check the components of the instrument. A display lists the individual tests
Tost with a pass or fail indication. Press Esc or Enter to return to normal
operation.
Appg‘;laf“"” Application Self Test: Press this submenu key to initiate a series of
Test diagnostic tests related to the performance of the instrument for specific
,—< applications. A display lists the individual tests with a pass or fail indication.
Press Esc or Enter to return to normal operation.
GPS
GPS: Opens the “GPS Menu” on page 9-3. This submenu key is displayed
R — only when the GPS (Option 31) is installed.
Calibrate Calibrate Touch Screen: Press this submenu key to start the touch screen
Teeuel calibration. Run the calibration procedure when the instrument is not
Screen responding to your screen taps as expected.
Application Application Options: Press this submenu key to open a menu to select
Ootions application options. This varies depending upon the measurement
° — (application) mode. Refer to “Application Options Menu” on page 5-5.
System System Options: Press this submenu key to open the “System Options
St Menu” on page 5-12.
P =)
Figure 5-3. System Menu
Calibrate Touch Screen Shortcut
Note

Press Shift then 0 to open the Calibrate Touch Screen display. Press Enter to start

the calibration or Esc to cancel.
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5-4 Application Options Menu

5-4

Application Options Menu

Key Sequence: Shift, System (8) > Application Options

The display of this menu varies based on the current measurement mode. In addition to the
following information, refer to the appropriate Measurement Guide listed in Appendix A.

VNA Mode
Options Units . . . .
- m ft: Press this submenu key to toggle the units setting to metric (meters,
Uil or m) or to U.S. (feet, or ft). Press Enter to accept the changes, or press the
" - Esc key to return to normal operation without changing the setting.
——| | Trace Label
On Off: Press this submenu key to toggle the trace labels On or Off.
Auto: Press this submenu key to set the Measurement Gain Range
Mode to Auto. In this mode, the instrument adjusts the gain
Trace Label . .
automatically to provide the best overall system performance
on off (dynamic range and high level noise).

Meas Gain Range
Auto

C—

Meas Menu

Field N

—<

Bias Tee Setup

<

Back

>

o /

Fixed: Press this submenu key to set the Measurement Gain Range
Mode to Fixed. In this mode, the gain of the instrument is always set to
the low gain setting. For most applications, Auto mode is
recommended. For certain types of filter measurements (mostly in the
range less than 500 MHz), the instrument may toggle between low
gain and high gain modes as the signal level rises from the noise to
the pass band of the filter, resulting in extra ripple. Setting the Gain
Range to fixed might address that problem.

Meas Menu Field VNA: Press this submenu key to toggle between Field (a
simplified subset of the standard VNA menu structure) and VNA
(standard menu structure.

Bias Tee Set up:
Int Voltage P2: Set the internal voltage in the range of 12 to 32 vdc.
Int Current Limit P2: Set the internal current limit from 0 to 450 mA.

Back: Press this submenu key to return to the “System Menu” on page 5-4.

Figure 5-4. Application Options Menu (VNA Mode)
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SPA Mode

Key Sequence: Shift, System (8) > Application Options

Options

Impedance

50 Ohm 75 Ohm Other

Bias Tee

Bias Tee

Bias Tee
off On
Bias Tee Voltage

15.0V
—

/\_/
/\_/

Current

Low High

Back

- /

Impedance

50 Ohm 75 Ohm Other: Press this submenu key to toggle the
impedance setting to 50 ohm, 75 ohm, or Other impedance value.
Selecting 75 ohm selects the 7.5 dB loss of the Anritsu 12N50-75B
adapter. For other adapters, select Other and enter the appropriate loss.

Bias Tee (Option 10 required): Opens the Bias Tee submenu. When
turned on, the Bias Tee voltage and current are shown in the upper left
corner of the display.

Bias Tee: Toggles On and Off the variable power supply.

Bias Tee Voltage: Use this submenu to set the power supply
voltage.

Current: Toggle the current between Low and High.

Back: Press this submenu key to return to the Application Options
Menu.

Back: Press this submenu key to return to the “System Menu”
on page 5-4.

Figure 5-5. Application Options Menu (SPA Mode)
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5-4 Application Options Menu

DMR Mode

Key Sequence: Shift, System (8) > Application Options

Options

Load DMR

Patterns

C—

/\_/
/\_/

0\

Back

- /

Load DMR Patterns: Press this submenu key to load additional DMR signal
patterns into the instrument. Refer to “Updating Signal Generator Patterns”
on page 5-11 before continuing.

Back: Press this submenu key to return to the “System Menu” on page 5-4.

Figure 5-6. Application Options Menu (DMR Mode)

P25 Mode

Key Sequence: Shift, System (8) > Application Options

Options

Load P25

Patterns

—

/\_/
/\_/

O\

Back

S /

Load P25 Patterns: Press this submenu key to load additional P25 signal
patterns into the instrument. Refer to “Updating Signal Generator Patterns”
on page 5-11 before continuing.

Back: Press this submenu key to return to the “System Menu” on page 5-4.

Figure 5-7. Application Options Menu (P25 Mode)
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P25p2 Mode
Key Sequence: Shift, System (8) > Application Options

Load P25p2 Patterns: Press this submenu key to load additional P25p2
Options signal patterns into the instrument. Refer to “Updating Signal Generator
Load P25p2 N | Patterns” on page 5-11 before continuing.

Patterns

Back: Press this submenu key to return to the “System Menu” on page 5-4.

/\_/
/\_/

Back
- /

Figure 5-8. Application Options Menu (P25p2 Mode)

NXDN Mode
Key Sequence: Shift, System (8) > Application Options

Load NXDN Patterns: Press this submenu key to load additional NXDN
Options signal patterns into the instrument. Refer to “Updating Signal Generator
Loadnxon ) | Patterns” on page 5-11 before continuing.

Patterns

| | Back: Press this submenu key to return to the “System Menu” on page 5-4.

/\_/
/\_/

Back
< /

Figure 5-9. Application Options Menu (NXDN Mode)
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PTC-ITCR Mode
Key Sequence: Shift, System (8) > Application Options

Load PTC Patterns: Press this submenu key to load additional PTC-ITCR
Options signal patterns into the instrument. Refer to “Updating Signal Generator
loaaptc ) | Patterns” on page 5-11 before continuing.

Patterns

Back: Press this submenu key to return to the “System Menu” on page 5-4.

/\_/
/\_/

O\

Back
- /

Figure 5-10. Application Options Menu (PTC-ITCR Mode)

PTC-ACSES Mode
Key Sequence: Shift, System (8) > Application Options

Load PTC Patterns: Press this submenu key to load additional
CpE PTC-ACSES signal patterns into the instrument. Refer to “Updating Signal
Load PTC-ACSES Generator Patterns” on page 5-11 before continuing.

Patterns

Back: Press this submenu key to return to the “System Menu” on page 5-4.

/\/
/\/

Back

Figure 5-11. Application Options Menu (PTC-ACSES Mode)
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TETRA Mode
Key Sequence: Shift, System (8) > Application Options

Load TETRA Patterns: Press this submenu key to load additional TETRA
Options signal patterns into the instrument. Refer to “Updating Signal Generator
Load TETRA ) | Patterns” on page 5-11 before continuing.

Patterns

Back: Press this submenu key to return to the “System Menu” on page 5-4.

/\_/
/\_/

Back
- /

Figure 5-12. Application Options Menu (TETRA Mode)
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Updating Signal Generator Patterns

e This procedure requires firmware (Package Version) V1.14 or greater.

¢ Updating the patterns could take up to an hour to complete.

Note * For some applications, downloading the patterns makes the unit busy for

as long as 15 minutes, but the process does not have to be closely
monitored.

Prepare the USB Memory Device

1. The USB memory device must be formatted in a single partition as either FAT or
FAT32 file system.

2. The USB memory device should have at least 1 GB of free space.

Copy the tx folder containing all of the patterns to the top-level directory of the USB
device.

Update the LMR Master Patterns

This process needs to be repeated for each LMR analysis mode where patterns
Note need to be updated (i.e., P25, P25p2, NXDN, DMR, TETRA, PTC-ITCR and
PTC-ACSES, etc.).

1. Power on the LMR Master and insert the USB memory device into one of the USB ports
on the LMR Master.

2. Enter the desired analysis mode for the patterns being loaded. For example NXDN,
PTC-ITCR, PTC-ACSES, P25, P25p2, TETRA, or DMR mode.

3. Execute the following sequence:

a. Access the System Menu by pressing the Shift key, then press the 8 key on the
keypad.

b. In the System menu, select Application Options > Load Patterns, then press Enter
when ready to start loading patterns.

Load Patterns

Press Enter to Start Loading Patterns

Figure 5-13. Load Patterns Dialog

c. Wait for the unit to end the loading process (this can take several minutes), press
Enter as directed, and the patterns will be loaded.

d. Press the Esc key when done.
4. Repeat Step 2 and Step 3 for each analysis mode for which an update is desired.
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System Operations

5-5

System Options Menu

System Options Menu
Key Sequence: Shift > System (8) > System Options

System Options

Date
&
Time

Ethernet

Config

<

Language

—<

Display
—*<
Name

<

Volume

<

Reset
—%<

More

—> /

Date & Time: Press this submenu key to display a dialog box for setting the
current date and time. Use the submenu keys or the Left/Right arrow keys to
select the field to be modified. Use the keypad, the Up/Down arrow keys, or
the rotary knob to select the date and time. Press Enter to accept the
changes, or press the Esc key to return to normal operation without making
changes.

Ethernet Config: (Optional) Press this key to display the Ethernet submenu
and to open the Ethernet Editor dialog box, where you can set the instrument
IP address. For details, refer to Chapter 6, “Ethernet Connectivity”.

Language: Press this submenu key to open a list box and select a built-in
language for the instrument display. Press Enter to apply the change, or
press Esc to cancel.

The languages that are currently available are: English, French, German,
Spanish, Japanese, Chinese, Korean, Italian, Russian, and Portuguese. You
can edit non-English language captions using Master Software Tools (MST).
If a mode does not have language translations available, then English is the
default language.

Caution: A firmware update or any instrument reset will overwrite
modifications you may have made in any of the language files.

Display: The Display submenu key opens the “Display Settings Menu”
on page 5-16, allowing brightness control and the selection of different
display attributes.

Name: Press this submenu key to open the Unit Name dialog, where you
can enter a name for the instrument, using the touch screen keyboard. Press
Enter to save the name.

The assigned instrument name appears in measurement files, setup files,
limit line files, and MST reports. It is displayed on the browser page banner
when the instrument is connected to a remote PC or mobile device.

Volume: Press this submenu key to view or adjust the speaker volume. The
current volume setting is displayed in the Volume input box. Use the numeric
keypad, the Up/Down arrow keys, or the rotary knob to change the value,
and press Enter to apply the change.

Reset: Press this submenu key to open the “Reset Menu” on page 5-18.

More: Press this submenu key to open the “System Options 2/2 Menu”
on page 5-13.

Figure 5-14. System Options Menu
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System Options 2/2 Menu
Key Sequence: Shift > System (8) > System Options > More

System Options 2/2

Share CF &
Pwr Offset
All Modes Not Shared

Set
Remote Access
Password

Power—On

—

Input Power
Warning
On Off

/\/
/\/

Back

Share CF & Pwr Offset

All Modes Not Shared: Press this submenu key to toggle the setting
between All Modes and Not Shared. Select All Modes to have the current
center frequency setting and power offset setting carried over when changing
measurement modes. This function is not applicable to measurements that
do not have a center frequency or power offset setting or to measurements in
which the current center frequency or power offset setting is outside the
range of the new measurement.

Set Remote Access Password: Press this submenu key to open the
Password entry dialog (see Figure 5-16). Use the touch screen keyboard to
enter the new password. Passwords may contain digits, uppercase and
lowercase letters, and the symbols -  + . (hyphen, underscore, plus,
period). Press Enter to save or Esc to cancel.

Setting the remote password and rebooting the instrument will lock it from
Telnet and FTP connections. This means that connecting to the instrument
via Master Software Tools (v2.21.1 or later), Wireless Remote Tools (WRT),
or the Web Remote Control browser interface will require the set password.
To unlock the instrument, remove the password by setting it to blank. The
password is also removed following a Master Reset, Factory Defaults reset,
or a firmware update.

Power-On: Press this submenu key to open the “Power—On Menu”
on page 5-15.

Input Power Warning
On Off: Press this submenu key to toggle a brief display of the input power
caution message at startup (see Figure 5-17).

Back: Press this submenu key to return to the “System Options Menu”
on page 5-12.

Figure 5-15. System Options Menu 2/2)

Warning

Do not set a remote access password when using SCPl commands to
communicate with the instrument.

S412E UG
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System Operations
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Figure 5-16. Remote Access Password Dialog

CAUTION!

To prevent damage to the instrument, NEVER connect
a transmitter directly to the input ports.

Input power limits per port:

RF In port: 50 Ohms, +33 dBm MAX, +50 VDC MAX
VNA port 1: 50 Ohms, +23 dBm MAX, +50 VDC MAX
VNA port 2: 50 Ohms, +23 dBm MAX, +50 VDC MAX

Press ESC to continue.

Figure 5-17.

Input Power Caution Text Box

5-14
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Power—-On Menu

Key Sequence: Shift > System (8) > System Options > More > Power-On

Power-On

Power Switch

WhenDC O

Applied

Back

—

N

/\_/
/\_/

O\

/

Power Switch: Press this submenu key to set the LMR Master for normal
use of the On/Off button on the instrument front panel.

When DC Applied: Press this submenu key to set the LMR Master to
automatically restart when DC power is applied to the External Power
connector (see Figure 2-8 on page 2-10). Refer to “External Power On”
on page 3-25.

In this mode, the Power button does not turn off the instrument, merely
recycles it.

Back: Press this submenu key to return to the “System Options 2/2 Menu”
on page 5-13.

Figure 5-18. Power-On Menu
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System Operations

Display Settings Menu

Key Sequence: Shift, System (8) > System Options > Display

Display Settings

N
Brightness
— :
Display Blank

—<

Default Colors

—=<

@)
Black on White

—

Night Vision

—<

(@)
High Contrast

<
O
Color on White

<

Back

- /

Brightness: Opens the “Brightness Settings Menu” on page 5-17.

Display Blank: Opens the message box illustrated in Figure 5-20. Press
Enter to turn off the display, or press Esc to abort. To turn the display back on,
press any key (except the Power button) three times in rapid succession. A
power cycle also turns the display back on.

Default Colors: Sets the display colors to the factory defaults. Used for
normal viewing.

Black on White: Sets the display colors to black on a white background for
printing and viewing in broad daylight conditions. See Figure 2-7 on page 2-9
for illustrations of the display color schemes selectable in this submenu.

Night Vision: Sets the display to a red-tinted color on a black background.
The front panel keypad is backlighted in red. This setting is optimized for
nighttime viewing.

High Contrast: Increases the black-and-white contrast of the default display.
This setting is used in challenging viewing conditions.

Color on White: Sets the display background to white, the grid to gray, and
leaves sweep data in color. This setting is used for printing and viewing in
broad daylight conditions.

Back: Press this submenu key to return to the “System Options Menu”
on page 5-12.

Figure 5-19. Display Settings Menu

Display Blank

To turn off the display, press <Enters,
or press <Escx to abort.

Three rapid keypresses,
or turning povwer off and on,
will turn on the display.

Figure 5-20. Display Blank Message Box
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Brightness Settings Menu

Key Sequence: Shift, System (8) > System Options > Display > Brightness

Brightness Settings

Brightness

Auto Dim

On Off

Auto Dim
Delay (min)
15

Auto Dim

Brightness
10.00 %

/\/
/\/

Back

The brightness of the display can be adjusted to optimize viewing under a
wide variety of lighting conditions.

Brightness: Press this key to open the Brightness Editor window, where you
can adjust the display brightness level from 0 to 100, with 100 being the
brightest. See Figure 5-22. Use the rotary knob to adjust the value in
increments of 5, or press the Up/Down arrow keys to change the value in
increments of 25. Press the Left or the Right arrow key to jump to 0 or 100,
respectively. Press Enter to accept the change; press Esc to retain the
previous setting. All display elements on the instrument screen are affected by
the Brightness setting.

Auto Dim On/Off: Press this key to toggle the display auto-dimming feature
on and off. Enabling auto-dim can extend battery life.

Auto Dim Delay: Press this key to adjust the amount of idle time, from 1 to
15 minutes, before the instrument display goes dim. Use the arrow keys or the
rotary knob to adjust the value in increments of 1 minute. You can also use the
numeric keypad, then press Enter. Out-of-range values are ignored and
decimal entries are rounded down to next lower minute.

Auto Dim Brightness: Press this key to select the brightness percentage
level of the display when it is dimmed. Use the arrow keys or the rotary knob
to adjust the value in increments of 5%, from 0% to 25%. You can also use the
numeric keypad, then press % or the Enter key. Out-of-range values are
ignored.

Back: Press this key to return to the “Display Settings Menu” on page 5-16.

Figure 5-21. Brightness Settings Menu

Erightness Editor

oo

Figure 5-22. Brightness Editor Input Box
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5-6 Reset Menu

System Operations

5-6 Reset Menu
Key Sequence: Shift, System (8) > System Options > Reset

Reset
Factory
Defaults
Master
Reset
Update
Firmware
—
T~
0\
Back
o /

Factory Defaults: Press this key to restore the instrument to the default
settings for all measurement modes and system settings, including
connectivity, language, and the display and audio settings. The instrument
will power cycle when the operation is complete. Press the Enter key to
initiate the reset, or press Esc to abort.

Note: This same reset sequence can be initiated when turning the
LMR Master on by pressing and holding the Esc key until the Anritsu
splash screen is displayed.

Master Reset: Press this submenu key to restore the instrument to factory
defaults as described above and to delete all user files from the instrument
internal memory. The instrument will power cycle when the operation is
complete. Press Enter to initiate the reset, or press Esc to abort.

Note: This same reset sequence can be initiated when turning the
LMR Master on by pressing and holding the System (8) key until the
Anritsu splash screen is displayed.

Update Firmware: Press this submenu key to update the instrument
operating system from an external USB memory device. Press Update
Firmware to start the update procedure, or press the Menu key to cancel and
display the Menu key screen of application icons. Refer to “Updating the
LMR Master Firmware” on page 5-20 for additional information on firmware
update.

Back: Press this submenu key to return to the “System Options Menu”
on page 5-12.

Figure 5-23. Reset Menu

Using Master Reset (System+O0n), erases all of the user-saved setups and
Caution  measurement traces and returns the LMR Master to a full Factory Default
condition.

PN: 10580-00318 Rev. AC S412E UG




System Operations

5-7 Preset Menu

5-7 Preset Menu
Key Sequence: Shift, Preset (1)

Preset

Preset

Save
Setup
Recall

Setup

Preset: This key resets all parameter settings for the current measurement
mode to their factory default values, and switches the display to the default
view for that mode. Measurement settings specific to other modes or
applications, are not affected.

Save Setup: Press this submenu key to open the Save dialog box

(Figure 4-1 on page 4-3) to name and save the current operating settings,
allowing them to be recalled later to return the instrument to the state it was
in at the time the setup was saved.

The saved setup can be named using the touch screen keyboard. Use the
Caps key to select an upper case letter. Use the Left/Right directional
arrows to move the cursor position. Press Enter to save the setup.

Note: Set the File type as Setup. Refer to “Save Menu” on page 4-9
for details.

Recall Setup: Press this submenu key to select and recall a previously
stored instrument setup using the “Recall Menu” on page 4-12. Use the
rotary knob, the Up/Down arrow keys, or the touchscreen to highlight the
saved setup, and press Enter. All current instrument settings are replaced
by the stored setup information.

Figure 5-24. Preset Menu

5-8 Self Test

At power on, the LMR Master runs through a series of quick checks to ensure that the system
is functioning properly. The System Self Test runs a series of tests that are related to the
instrument itself. The Application Self Test runs a series of tests that are related to the
current operating mode of the instrument.

If the LMR Master is within the specified operating range with a charged battery and the
self-test fails, contact your Anritsu Service Center at http://www.anritsu.com/contact-us.

To start a self-test when the system is already powered up:
1. Press the Shift key and then the System (8) key.
2. Press the Self Test submenu key. The Self Test results are displayed.

3. Press Esc to continue.

S412E UG
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5-9 Updating the LMR Master Firmware System Operations

5-9

Updating the LMR Master Firmware

To update your Anritsu instrument firmware, use a high quality USB memory stick with at
least 250 MB of free space and FAT32 file system format.

1. Insert the memory stick into your PC or laptop.
2. From a browser, go to the following Anritsu Products page:
http://www.anritsu.com/en-US/test-measurement/products/mt8220t.
3. If the Web page lists more than one product, find your instrument model number and
click the link.
On the product page, press the Downloads button.
Under the Drivers/Firmware/Software tab, you can optionally follow the Firmware
Revision/Release History link to download a document detailing current and past
firmware changes.
Click on the link Firmware Update for the BTS Master MT8220T.
Click the Download button, then choose Save or Save As. Do not run the executable file
directly from the Web page.
8. Go to the Save location designated in Step 7 and double-click the installer file, or USB
Loader.
9. In the Firmware Update dialog, click to view, then accept the software license
agreement.
10. Select the Removable Disk drive where the USB stick is inserted.
11. Click Prepare USB Memory Stick to extract and copy the firmware update code.
12. After the firmware update code has finished copying, click through the final steps in
the Firmware Update dialog to close the installer program.
13. Eject the memory stick from the computer.
The file structure created on the USB memory stick by the installer program is
Note ) .
necessary for a successful firmware update and must not be altered in any way.
14. Turn off the LMR Master and insert the USB memory stick into the instrument.
15. Make sure the LMR Master is plugged into an AC power source and not running on
battery alone, then turn on the instrument.
16. The instrument should detect new firmware on the USB stick and ask if you wish to
upgrade. Press Yes.
17. The Automatic Firmware Update dialog should open at this time. Skip to Step 19.
If the same firmware code as contained on the USB stick is already loaded on the
instrument, a message indicating that firmware update is skipped will display
Note briefly on the instrument screen.
If the firmware update on the memory stick does not match your instrument model,
an error message will display briefly, indicating that it is not compatible.
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System Operations 5-9 Updating the LMR Master Firmware

18. If there is no error but the instrument does not enter upgrade mode automatically:
a. Press Shift > System (8) > System Options > Reset > Update Firmware.
b. Press Load Firmware at the bottom left of the instrument screen.
c. Press Update Application Firmware.
d. The Firmware Update dialog opens.
19. Use the Up/Down arrow keys or the rotary knob to select one of the Save modes.
e Save none: No attempt is made to save any user data.

¢ Save user data: User data is saved to the selected external media device.

Some user data may be lost if not enough memory space is available on the

Warning selected device.

* Save & restore user data: User data is saved to the selected external media
device. The instrument also attempts to restore the files to the instrument after
the update.

Some user data may be lost if not enough memory space is available on the

Warning selected device.

20. Press Enter.
21. Press Enter again to proceed with the firmware upgrade.

To cancel the operation, press Esc. In this case, you need to press Shift > Mode (9) and
select an application from the Mode Selector list in order to exit upgrade mode and
resume normal instrument operation.

You cannot stop the upgrade once it has started. To avoid potential permanent
Warning damage, do not turn off the instrument or remove the USB stick during the
firmware update.

22. After the update is complete, the instrument should reboot automatically.

23. When the upgrade is finished, power off the instrument, remove the USB stick and
power the instrument back on.

If the instrument turns off but does not restart, remove the USB stick and power the

Note instrument back on.
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Chapter 6 — Ethernet Connectivity

6-1 Introduction

This chapter describes how to connect to a network or directly to a PC using Ethernet
Connectivity. It also describes the RJ-45 connector, DHCP, and connection tests for the
S412E LMR Master.

6-2 Ethernet Connection

Network Connection

DHCP is the default Ethernet type. If the Anritsu handheld has been set to Manual,
Note change to DHCP from the System main menu (Shift+8) > System Options >
Ethernet.

Use the following procedure if you can connect to a network that offers DHCP.

1. Connect the handheld instrument and the computer running MST to the Ethernet
network.

2. Turn on the Anritsu handheld and confirm the network connection from the
System main menu (Shift+8) > Status submenu key. The IP address on the handheld is
displayed in the STATUS window.

3. In Master Software Tools, press the Network tab, then the Query Network for Instruments
button. Double-click the handheld instrument to complete the connection. The
instrument model and IP address along with a green connection icon will be displayed
at the top of the MST window.

Ethernet Direct Connection
Use the following procedure if you cannot connect to a network running DHCP.

1. Connect the handheld instrument and the computer running MST with an Ethernet
crossover cable or a standard Ethernet cable with a crossover adapter.

2. Turn on the Anritsu handheld and set the Ethernet connection to Manual.
System main menu > System Options > Ethernet.

3. Use the Field and Octet submenu keys to setup the following:

IP: 10.0.0.2
Gateway: 10.0.0.2
Subnet: 255.255.255.0

Press Enter to save the changes.

Note The following steps may disable network and/or Internet access.
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6-3 Ethernet Configuration Ethernet Connectivity

4. Configure the computer for direct Ethernet connection:

a. On the computer running MST, double-click on the local area connection
associated with Ethernet crossover cable connection (Start menu > Settings >
Network Connections > Local Area Connection x).

b. Click on the Properties button, then double-click on Internet Protocol (TCP/IP).

Select Use the following IP address (or Alternate Configuration) and enter the
following information:

1P: 10.0.0.1
Gateway: 10.0.0.1
Subnet: 255.255.255.0

d. Close all the open windows and restart the computer and the Anritsu
instrument.

5. Open Master Software Tools, press the Network tab then the Query Network for
Instruments button. Double-click on the instrument to complete the connection. The
instrument model and IP address (10.0.0.2) along with a green connection icon will be
displayed at the top of the MST window.

6-3 Ethernet Configuration

LAN Connection

The RdJ-45 connector is used to connect the LMR Master to a local area network. Integrated
into this connector are two LEDs. The amber LED shows the status of the Ethernet Link:
Link Up (On) or Link Down (Off). The green LED flashes to show that LAN traffic is present.
The instrument IP address is set by pressing the Shift key, then the System (8) key followed
by the System Options soft key and the Ethernet Config soft key. The instrument Ethernet
address can be set automatically using DHCP, or manually by entering the desired IP
address, gateway address, and subnet mask. Refer to “DHCP” on page 6-6 for more
information.

An active Ethernet cable may need to be connected to the instrument before it is
turned on in order to enable the Ethernet port for DHCP or static IP address.

Depending upon local conditions, the port may remain enabled when changing
Note from DHCP to static IP address, when changing from static IP address to DHCP,
or when temporarily disconnecting the Ethernet cable.

If the port becomes disabled, ensure that an active Ethernet cable is attached to
the instrument before cycling the power OFF and back ON.
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To display the IP address with the instrument on, press the Shift key, then the System (8)
key, then the System Options soft key and the Ethernet Config soft key. The IP address will be
displayed as shown in Figure 6-1. The image on the display panel of your LMR Master may
differ from the image shown here.

|/|nritsu 12015/2010 01:20:35 prn 3 : Ethernet

Type
Ref Lvl
10.0 dEm Manual DHCP

Field

1€ Setthe IP Address dynamically using DHCP.
192.166.1.10 le &=ty @i

" Getthe IP address Manually using the following Setings.

IP |192 g |1aa 5 |1 = |1u g
VEW Gateway |192 = |153 = |1 = |1 =

f
E el Second Octet
1 MHz Subnet 755 & 255 B pre—r 7 - p. "v.u\"n}‘nﬂ'\""‘
Sweep Ti I j I j I j I :’ wrll,h_ﬂu‘.n'! e
g i

First Octet

rAC ADDRESS 00:00:91:f0:53:5 Third Octet

Lo e

Fourth Octet

Sweep (F
Can

B.000 GHz

Amplitude fdarker

Figure 6-1. |IP Address Assigned Using DHCP
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6-3 Ethernet Configuration

Ethernet Connectivity

Ethernet Config

Press this submenu key to display the Ethernet submenu and to open the Ethernet Editor

dialog box in order to set the IP address of the instrument.

| Anritsu 1zaszoo 012138 pn

Ref Lvl
10.0 d

PRI (856t the P Address Manually using the following Settings

Peak
=S = N KT

3

Gateway

|192 g I‘\Eﬁ = E

5

Subnat ElE N ER:NERERE

rAC ADDRESS 00:00:91:f0:53:f5

LWL T

Sweep (F
Continui

Freq Ref
Int 3

amplitude

3

Ethernet
Type
Manual  DHCP
Field

G-Way Sub
First Cctet
Second Octet
llk‘fr

Third Octet

Fourth Octet

Marker

Figure 6-2. Setting IP Address Manually
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Ethernet Connectivity

6-3 Ethernet Configuration

Ethernet Menu

Key Sequence: Shift, System (8) > System Options > Ethernet Config

Ethernet

Type
Manual DHCP

Field

P G-Way Sub

First Octet

<

Second Octet

——<

Third Octet

—<

Fouth Octet

/

Type

Manual DHCP: Press this submenu key to select whether the address will

Y |be entered manually, or will be supplied automatically by a network DHCP

server. If Manual is selected, then use the submenu keys or the Left/Right
arrow keys to select the field that is to be modified. Use the keypad, the
Up/Down arrow keys, or the rotary knob to enter the input. Press Enter to
accept the changes, or press the Esc key to return to normal operation
without changing anything.

Field
IP G-Way Sub: Press this submenu key to select the desired Internet
Protocol Property to be edited.

First Octet: Moves the cursor to the left most column of the selected IP
properties field.

Second Octet: Moves the cursor to the second column from the left of the
selected IP properties field.

Third Octet: Moves the cursor to the third column from the left of the
selected IP properties field.

Fourth Octet: Moves the cursor to the forth column from the left of the
selected IP properties field.

Figure 6-3.

Ethernet Menu
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6-4 DHCP Ethernet Connectivity

6-4 DHCP

Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates the
process of setting IP addresses for devices that use TCP/IP, and is the most common method
of configuring a device for network use. Most networks include a DHCP server to manage IP
addresses. When a DHCP server is available on the network, DHCP is the preferred IP
address assignment mode.

To determine if a network is set up for DHCP,

1. Connect the LMR Master to the network and select DHCP protocol in the
Ethernet Config menu.

2. Turn the LMR Master off, and then on. If the network is set up for DHCP, the assigned
IP address should be displayed briefly after the power up sequence.

When using DHCP, no setup is required to lease and use a dynamic IP address. In a dynamic
IP operation, the IP address in use may change from use to use. The DHCP server hands out
IP addresses on a first come, first served basis. As soon as the device is disconnected from the
network, the IP address that it was using becomes available to lease to the next unit that
requests an IP address. Normally, some amount of lag time is present on the DHCP server
end, so if the device is connected again reasonably soon, then it may end up with the same
address.

The instrument may need to be connected to the network before it is turned on in
order for DHCP to function. Key elements of the DHCP lease are performed during
the instrument startup operations or when switching from manual to DHCP, and
may not reliably synchronize during normal operation.

Note

6-5 Static IP Address

When a DHCP server is not available, a static IP address can be used. A static IP address is a
fixed address. After being set, it remains the same from session to session.

When using a static IP address on an established network, always request the static IP
address from the network administrator, so that it does not conflict with other equipment on
the network. Randomly choosing a static IP address on an established network may result in
duplicate IP addresses or other conflicts.

These parameters must be set prior to using a static IP address:
IP Address: This is the static IP address on the network.

Default Gateway: Often when a static IP address is assigned, a default gateway is also
identified. If the default gateway is unknown, then type in the static IP
address so that the static IP address and default gateway are the same
number.

Subnet Mask : This parameter is usually extracted from the static IP address based on
the class of the address and determines the destination of any broadcast
messages that might be sent from the instrument. It can be customized
if necessary. The subnet mask may also be provided with the static IP
address.
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Ethernet Connectivity 6-6 ipconfig Tool

Example 1

In this example, a static IP address has been chosen because no network DHCP service is
available. The instrument is connected to the network port on the PC with a crossover
Ethernet cable (not included). This is also referred to as Direct Connect:

IP Address: 10.0.0.2
Default Gateway: 10.0.0.1
Subnet Mask: 255.255.0.0

Example 2

In this example, the static IP address has been assigned with an associated gateway and
subnet mask:

IP Address: 153.56.100.42
Default Gateway: 153.56.100.1
Subnet Mask: 255.255.252.0

6-6 ipconfig Tool

A few tools that are built into the Microsoft Windows operating system can assist in making
some determinations about the network to which the PC is connected. Typing ipconfig at a
command prompt produces a display of information about the in-use parameters of the PC
and its network connection. Following is an example of the typical results expected:

The ipconfig display does not report whether the information is from a DHCP

Note server or from a static IP setup.

Y:\>ipconfig
Windows 2000 IP Configuration

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix. : us.anritsu.com
IP Address. . . . . . . .« .+ .+ . . 172.26.202.172
Subnet Mask . . . . . . . . . . . : 255.255.252.0
Default Gateway . . . . . . . . . : 172.26.200.1
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6-7 ping Tool

Another tool that can find out if a selected IP address is already on the network is ping. Ping
is a harmless way to determine if an address is found on the network, and (if it is found) to
receive a reply. Basically, the ping function sends out a request to a specific address to
determine if a computing device is connected to the network at that address. If a valid
connection is found, then a copy of the signal (that was sent) is returned. If a connection is not
found, then the response is “request timed out”, which means that no reply was received from
that TP address.

Y:\>ping 172.26.202.172

Pinging 172.26.202.172 with 32 bytes of data:

Reply from 172.26.202.172: bytes=32 time<lOms TTL=128
Reply from 172.26.202.172: bytes=32 time<lOms TTL=128
Reply from 172.26.202.172: bytes=32 time<lOms TTL=128
Reply from 172.26.202.172: bytes=32 time<lOms TTL=128
Ping statistics for 172.26.202.172:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milliseconds:

Minimum = 0 ms, Maximum = 0 ms, Average = 0 ms

6-8 PN: 10580-00318 Rev. AC S412E UG



Chapter 7 — Anritsu PC Software
Tools

7-1 Introduction

This chapter provides a brief overview of the available PC software tools from Anritsu. For
detailed information about specific software, refer to the Anritsu web site or the program’s
built-in Help. Software is included with the instrument and is also available from the Anritsu
web site: http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx.

7-2 Anritsu Tool Box

The Anritsu Tool Box is a central location to open an Anritsu measurement, visit the
Anritsu web site, or launch Anritsu applications. To open the Anritsu Tool Box, either click
the shortcut icon on the desktop or click Start and navigate through the Programs folder to the
Anritsu folder and select Anritsu Tool Box.

After the tool box is open, move the mouse pointer over any of the application icons to view a
short description of the application. The following pages describe the software programs that
can be launched from the Anritsu Tool Box

A, Anritsu Tool Box O x

Utilities

Applications

Open File Line Sweep Tools

MST

Anritsu Web I
a0\
CTTy

e

easyMap Tools «

Copyright @ Anritsu Company 2015 - Anritsu Tool Box - V2.6 Build: 0

Figure 7-1.  Anritsu Tool Box
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7-3 Line Sweep Tools Anritsu PC Software Tools

The Anritsu PC Software tools do not support all of Anritsu’s handheld instruments
or all of their measurements. Compatibility information is provided in the program’s
Help.

Note Line Sweep Tools (LST) can be used for downloading and post-processing of
certain VNA measurements and cable & antenna analysis sweeps.

Master Software Tools (MST) is primarily used for spectrum analysis
measurements.

7-3 Line Sweep Tools

Line Sweep Tools is a program designed to increase productivity for people who work with
dozens of Cable traces, Antenna traces, and Passive Intermodulation (PIM) traces every day.
Line Sweep Tools can:

e Collect sweeps from Anritsu PIM and Line Sweep gear.

» Help verify that those sweeps are done properly and that the Cable, Antenna and PIM
sweeps meet specifications.

e Help create reports of the findings quickly and to a professional standard.

T Line Sweep Tools

File  Edit  ‘Wiew Capture  Tools  Settings  Windows — Help

P e = |G @ M) ) =] e e[
A A N A A EEEEET TR

Return Loss
LineSweep RL LOAD 8§50 8837 GBW

Stakus |

Figure 7-2. Line Sweep Tools
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Anritsu PC Software Tools 7-4 Master Software Tools

7-4 Master Software Tools

Anritsu Master Software Tools is a PC program for transferring and editing saved
measurements, markers, and limit lines to a PC. Anritsu Company recommends MST for
Spectrum Analyzer instruments or instruments that perform spectrum analysis
measurements.

Anritsu Master Software Tools
Eile View Connection Sync Tools Window Help
a3 & T UsE - wi Bl

Local Device Open Metwork Trace Catalog - Spectium Analyzer

rram Files\Anritsutt aster Software Tok + @ @ =2 W EH- W - 0
=15 Master Saftwan &

g j:g'geg ﬁ; Mouse: Position = %Autascale S, Undo Zoom %Dver\ays [v EditGraph  [EF Markers =
59 Dathet208
83 erlis ¥ SPA Measurement Editor - preview.spa

< >

MName Size  Type b

Zdspa 297KB  SPA
DaML_2400..  302KB  SPA @
FileName. spa 304KB  SPA
ResidualSpur.. 30.7KE  SP4

Captured.ia 29MEB (L%
preview.ia 29 ME [ o
< >

Preview | | File Summary

File Summary: preview.spa
File Type:  SPA ~

Trace & data:

Trace Mode = Mormal

Preamp = OFF

Min Sweep Time = 0.001 5
Reference Level Offset = 0 dB

Input Attenuation = 30,0 dB

REW = 100.0 Hz

VB = 30.0Hz

Detection = Peak

Center Frequency = 800.000 000 MHz
Start Frequency = 799.975 000 MHz
Stop Frequency = 800,025 000 MHz
Frequency Span = 50,000 000 kHz
Reference Level = 3.800 dBm
Scale =100 dB/div

Device Summary:

Serial Mumber = 1015031

Base Wer =421

AppVer =557

Model = M52713E

Options = 9,10,19, 25, 27, 28, 29, 30,3
Date = 8/31/2011 1:51:44 PM

Device Name =

< >

Mot Connected [

Figure 7-3. Master Software Tools
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7-5 easyTest Tools Anritsu PC Software Tools

7-5 easyTest Tools
Use easyTest Tools to create work instruction files that consist of a command sequence and
instructions to help less-experienced personnel operate an instrument in the field.

e A drag-and-drop tool facilitates the creation of a test sequence from a library of
commands.

* Instructions can be a mix of textual prompts and graphic images.
e Sample procedure files (.ett) are included with easyTest Tools.

¢ Command sequences are delivered electronically and loaded on the instrument, where
they are recalled with a press of a button.

e Recall Setup places the instrument in the proper mode for the measurement by
retrieving saved parameters such as measurement type, frequency and amplitude
settings, markers and limit lines.

The current measurement setup or the screen display can be saved manually or
automatically.

7-6 easyMap Tools

Use easyMap Tools to create geo-referenced maps and convert floor plans for use by Anritsu
mapping spectrum analyzers. easyMap Tools can also create single-panel maps (.map files)
for legacy instruments or pan and zoom maps (.azm files) for current instruments. Mapping of
both interference and coverage is available while indoors or outdoors.

“ casyMap Tools
Auddenss honobud, haviai w | Go Covernpe 12 3 Deid 16 3 Estimated Size MB) 40,168 Save Mag
Coverage Map Detail Map
e, Woanaba - & T - ’:L: "-'I i 6 BaiBoocn o 3 g E (s
% Ml Valey P L
@ ' £ @ . v
Pea F L @
i £
] o )
Feckam AFB £ % e 2,
. Zh e ®, = e
o B L __‘e~"> 3 %v
B g
e ©
wan Park & §5 &

Gaoghe - ap Tle Atas, Imigety 90013 TeraMatrics 9013 oo~ M 190913 TR Atns. gy S Trabutcs

Figure 7-4. Captured Geo-referenced Map Ready for the Analyzer
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Chapter 8 — Bias Tee (Option 10)

8-1 Overview

Option 10 provides a bias tee that is installed inside the instrument. The bias arm is
connected to a 12 VDC to 32 VDC power source that can be turned on as needed to place the
voltage on the center conductor of the VNA Port 2 (in VNA mode; see Figure 8-2) or the center
conductor of RF In (in SPA mode; see Figure 8-4). This supply of bias is useful when
conducting two-port transmission measurements and can also be used to provide power to
block down-converters in satellite receivers or to power some tower-mounted amplifiers
(TMAs).

Bias Tee in VNA Mode

The bias can be turned on only when the Start Frequency is 2 MHz or greater. When bias is
turned on, the bias voltage and current are displayed in the Instrument Settings Summary
area of the screen. The 12 VDC to 32 VDC power supply is designed to continuously deliver a
maximum of 6 watts.

When in VNA mode, the bias tee menu can be accessed as follows:
¢ From the Sweep menu when in standard VNA mode:
Key Sequence: Sweep > Configure Ports > Bias Tee Setup

e From the System Options menu when VNA Field menus are selected:
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8-1 Overview

Bias Tee (Option 10)

Key Sequence: Shift, System (8) > Application Options > Bias Tee Setup

Bias Tee

Bias Tee

Off
C—

/\_/
/\_/

Int Voltage P2
16.1V
Int Current Limit P2

450 mA
S—

Back

S /

Bias Tee: Toggles On and Off the variable power supply.

Int Voltage P2: Use this submenu to set the power supply voltage.

Int Current Limit P2: Use this submenu to set the power supply current.
Back: Press this submenu key to return to the Configure Ports menu.

Figure 8-1. Bias Tee Menu
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Bias Tee (Option 10)

Overview

Figure 8-2 shows how the LMR Master provides an internal voltage between 12 volts and
32 volts that is applied to the center conductor of Port 2. That voltage would be available at

the port along with the RF signals.

(Bias Tee)

VNA Port 2
VNA Port 1

/inritsu _ S412E LMRMaster

VNA Port 2 VNA Port 1
O © 4
Internal Bias
+12t0 +32V IS O] ®
450 mA Max N @
g‘it:s""lge T )
@ ®

Transmission C,:? @mm w@v
Sampler @ @ ©)

Figure 8-2. Bias Tee Setup in VNA Mode

Additional information for Option 10 is provided in the Vector Network Analyzer

Measurement Guide (refer to Appendix A).
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8-1 Overview Bias Tee (Option 10)

Bias Tee in SPA Mode

When bias is turned on, the bias voltage and current are displayed in the Instrument Settings
Summary area of the window. The 12 VDC to 32 VDC power supply is designed to
continuously deliver a maximum of 6 watts.

The bias tee menu can be accessed from the Application Options menu in SPA mode:

System > Application Options > Bias Tee

Bias Tee: Toggles On and Off the variable power supply.

Bias Tee

Bias Teo Bias Tee Voltage: Use this submenu to set the power supply voltage.

Current: Toggle the bias tee current between Low and High.
Off On
— Back: Press this submenu key to return to the Application Options menu.
Bias Tee Voltage

16.1V

Figure 8-3. Bias Tee Menu
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Bias Tee (Option 10)

8-1

Overview

/inritsu  S412E

LMRMaster

Signal Generator Out

%

RF IN

Internal Bias

TITI

+12to +32 V
450 mA Max

Internal T
Bias Tee

Transmission
Sampler

lllll

...........

Figure 8-4.

Bias Tee Setup in SPA Mode
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Chapter 9 — GPS (Option 31)

9-1 Introduction

The LMR Master is available with a built-in GPS receiver feature (Option 31) that can
provide latitude, longitude, altitude, and UTC timing information. This option also enhances
the frequency reference oscillator accuracy in the Spectrum Analyzer mode. Within three
minutes of satellite acquisition, the reference oscillator will have an accuracy of better than
50 ppb (parts per billion).

In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites,
or the antenna must be placed outside without any obstructions. An Anritsu GPS antenna is
required.

The LMR Master Technical Data Sheet provides a list of options and the

Note measurements that require the GPS (Option 31).

9-2 Activating the GPS Feature

To activate the GPS feature:
1. Install the Anritsu GPS antenna onto the GPS Antenna connector on the LMR Master.
2. Press the Shift key, then the System (8) key.
3. Press the GPS submenu key.
4

Press the GPS On/Off submenu key to toggle the GPS feature on or off. When GPS is
first turned on, a RED GPS icon appears at the top of the display.

Figure 9-1. GPS Icon, Red
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9-2 Activating the GPS Feature GPS (Option 31)

5.

When the GPS receiver has tracked at least three satellites, the GPS icon changes to
GREEN. Latitude and Longitude information is displayed in the white bar on top of the
display. Acquiring satellites might take as long as three minutes.

Figure 9-2. GPS Icon, Green

6.

Press the GPS Info submenu key to view information about:
Tracked Satellites

Latitude and Longitude

Altitude

UuTC

Fix Available

Almanac Complete

Antenna and Receiver Status

GPS Antenna Voltage and Current

Refer to Section 9-4 “GPS Menu” on page 9-3 for details about the GPS Info dialog box.
Press the Reset submenu key to reset the GPS.

The GREEN GPS icon with a RED CROSS through it, as shown below, appears when
GPS satellite tracking is lost (after actively tracking 3 or more satellites). The GPS
longitude and latitude are saved in the instrument memory until the LMR Master is
powered off or until GPS is turned off by using the GPS On/Off key.

Figure 9-3. GPS Icon, Tracking Lost
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GPS (Option 31)

9-3 Saving and Recalling Traces with GPS Information

9-3

Saving and Recalling Traces with GPS Information

Saving Traces with GPS Information

The GPS coordinates of a location can be saved along with a measurement trace. Refer to
“Save Menu” on page 4-9 for more information. The current GPS coordinates are saved with
the measurement traces whenever GPS is on and actively tracking satellites.

Recalling GPS Information

If the GPS coordinates were saved with a measurement, when the measurement is recalled,
those coordinates are recalled as well. Refer to “Recall Menu” on page 4-12 for more
information about recalling a saved trace.

9-4

GPS Menu

Key Sequence: Shift, System (8) > GPS

GPS: Press this submenu key to turn GPS on or off.

GPS
oPS N | GPS Info: Press this submenu key to display the current GPS information.
Refer to “GPS Info” on page 9-4.
On o GPS Voltage: Press this submenu key to set the source voltage to be either
< 3.3 V or 5V depending on the GPS receiver being used. GPS antenna
GPS Info voltage is set to 3.3 V by default to prevent accidental damage to
lower-voltage GPS antennas.
GPS Voltage 5V is the recommended setting for Anritsu GPS antennas.
Reset: Press this submenu key to set the number of tracked satellites to 0
3.3V 5V . .
— A | and to erase any almanac data, along with saved coordinates. The process
of searching for and reacquiring satellites begins again.
/\/
| Back: Press this submenu key to return to the “System Menu” on page 5-4.
0\
Reset
——<
Back
N /
Figure 9-4. GPS Menu
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9-4 GPS Menu GPS (Option 31)

GPS Info

Tracked Satellites

Shows the number of tracked satellites (three are required to retrieve latitude and
longitude, four are required to resolve altitude). Generally, the larger number of
satellites tracked, the more accurate the information.

Latitude and Longitude

Shows location in degrees, minutes, and seconds.
Altitude

Shows altitude information in meters.

UTC

Coordinated universal time.

Fix Available

The cold start search sets are established to ensure that at least three satellites are
acquired within the first couple of minutes. When three satellites are found, the
receiver computes an initial fix (typically in less than two minutes). Fix Not Available
means that the initial position has not been established.

Almanac Complete

The system Almanac contains information about the satellites in the constellation,
ionospheric data, and special system messages. In a cold start, the GPS receiver does
not have any navigation data so the receiver does not have a current almanac. A
complete system almanac is not required to achieve a first position fix. The availability
of the almanac, however, can significantly reduce the time to first fix.

Antenna Status
OK: Antenna is connected properly and antenna is working properly

Short/Open: A short or open exists between the antenna and the connection. If this
message 1s displayed, then remove and replace the GPS antenna. If the message
persists, then try another Anritsu GPS antenna. If the message persists, contact your
nearest Anritsu Service Center.

Receiver Status
Current status of the receiver.
GPS Antenna Voltage and Current

Shows the voltage and current for the GPS antenna.

94
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Chapter 10 — Web Remote Control

10-1 Introduction

Web Remote Control capabilities are embedded in the LMR Master, providing full instrument
control through any HTML-5 compatible browser. The ability to remotely monitor and control
the instrument from the ground or desk enhances operator safety and efficiency when
conditions make it unsafe or impractical to be close to the instrument. Login passwords can
be used to restrict access to authorized users only.

An Ethernet connection is required.

A remote connection terminates when the user logs out or closes the browser, or when the
session time duration requested at login expires. To prevent multi-user conflicts, only one
connection is permitted at a time. A second user who tries to log in will see a message
indicating the instrument is currently reserved by another client, with the time remaining in
their session.

While only one user can have control of the instrument, multiple users can view the same
instrument using a desktop sharing application.

10-2 Setup

You can connect one or more instruments to any computer with HTML-5 compatible browser.
Anritsu strongly recommends using Google Chrome, as other browsers do not fully support
HTML-5. The controlling device may be a laptop or a desktop computer or a mobile device,
including a wide range of tablets and smart phones running Android or i0OS operating system.
Note, however, that you cannot download files to an i0OS device, because it lacks a
user-accessible file system.

Physical connection is established from the instrument’s Ethernet port directly to the
computer, to a LAN, or a portable Wi-Fi router such as the ZyXEL MWR102 Portable Router.

LAN Connection
1. Connect the Ethernet port of the LMR Master to your LAN.
2. Press Shift followed by System (8).

3. Press the Status submenu key to display the Status window and take note of the
instrument IP address.

Press Esc to close the Status window.

4. If no IP address has been assigned, refer to Appendix 6, “Ethernet Connectivity” for
information on setting an IP address for the instrument. If connecting to another
network, Anritsu Company recommends that you request a static IP address from your
network administrator to avoid duplicate addresses.

Alternatively, you can set the instrument for dynamic IP addressing using DHCP.
Refer to “Ethernet Menu” on page 6-5. In a long distance network, however, it may be
difficult or impossible to determine what the current dynamic address is, after the
instrument is in the field.
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10-2 Setup Web Remote Control

Set instrument parameters as appropriate, such as measurement mode, frequency
range, amplitude. You may skip this step and set up the instrument remotely at a later
time, after Ethernet connection has been established.

Launch the Google Chrome browser on your PC, laptop, or mobile device. Due to
compatibility issues with HTML-5, do not connect using another browser than Chrome.

Enter the instrument IP address in the browser address bar to open the Web Remote
Control Login page illustrated in Figure 10-1 on page 10-3.

Connection to a Wi-Fi Portable Router

Instead of connecting the instrument directly to a LAN, you can connect it to a Wi-Fi router.
This section documents connection to the ZyXEL MWR102 Portable Router as an example.

1.

Take note of the router’s SSID and pre-programmed password, which are found on a
sticker affixed to the router.

Using the Ethernet cable included with the router, connect one end to the black LAN
port and the other end to the test instrument’s Ethernet port.

Insert the Mini-B (small) end of the provided USB cable into the router and the Type-A
(larger) end of the cable into one of the USB ports of your test instrument.

Optionally, secure the router to the instrument body using a strip of Velcro or other
hook-and-loop fastener. You may also place the router in the instrument carrying case,
if it fits.

Use your computer’s Wi-Fi Network Connection utility to find the router. With the
ZyXEL MWR102 Portable Router, the SSID name will be ZyXEL followed by an
alphanumeric string unique to your particular router.

Connect to this SSID. When prompted, enter the router password noted in Step 1.
Set the IP address manually on the instrument. Refer to “Ethernet Menu” on page 6-5.

Launch the Google Chrome browser on your PC, laptop, or mobile device. Due to
compatibility issues with HTML-5, do not connect using another browser than Chrome.

Enter the instrument IP address in the browser address bar to open the Web Remote
Control Login page illustrated in Figure 10-1 on page 10-3.

10-2
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Web Remote Control 10-3 Web Remote Control Interface

10-3 Web Remote Control Interface

The Web Remote Control Login page opens following browser connection to the instrument.
See Figure 10-1. The page may show or hide certain elements depending on device
management options set by the Administrator, as described in “Device Options”

on page 10-12.

— [ =
[ Anritsu x - _:
€« C'  [117226.202.254 %=
| /inritsu S412E IP Address: 172.26.202.254

Password: ||

Login as Administrator

Time Requested (up to 10 hours): 1 ¥|hours |0 ¥ minutes

Login

Enter your password and press Login to continue.

Figure 10-1. Login Page

User Login
To start a remote session with a test instrument:

1. Enter the instrument IP address in the Google Chrome address bar. The instrument
must be connected via Ethernet as described in “Setup” on page 10-1.

2. Use the pull-down menus on the Login page to set the time, in hours and minutes,
before the remote session times out. The default session time is 1 hour, with a 10-hour
maximum.

Only one user at a time can connect to the instrument. To avoid locking out other users
unnecessarily, do not reserve a longer session than you need.

3. To enable functions available only to the network administrator, select the Login as
Administrator checkbox.

4. Enter the instrument password, then click Login.

The default administrator password is “Admin” with a capital A. For other users, leave
the field blank.

If another user already has control of the instrument when you try to log in, a message will
display indicating the instrument is currently reserved by another client, whose IP address is
listed with the time remaining in their session.

Following login, the Web Remote Control Home (see Figure 10-2) page is displayed.
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10-3 Web Remote Control Interface

Web Remote Control

Home Page

The Web Remote Control Home page lists the same information as what is displayed on the
instrument screen when you press Shift, System (8) at the front panel, followed by the Status

menu key.

At the top of the page, a green banner shows the instrument model number and IP address. If
the instrument has been assigned a name, this name is displayed in the center of the banner.

The menu bar below the banner consists of tabs for commands and links: Home, Remote
Control, Capture Screen, Capture Trace, File List, Device Management, and Logout.

~

Vi S412E IP Address: 172.26.202.206 |

S revote control Capture Screen Capture Trace File List Device Management Logout f

] System Information E
Package T2.24.9304 Temperature 450C/1130F

5 0s T4.26.9304 Battery Charge 0% ||
Base T5.68.9304 Battery Current OmA

IPL Version V3.60 Battery Voltage 117V |

SPL Version V3.60 Serial Number 1223116 i

Installed Components
Spectrum Analyzer T6.93.9304 6 6 GHz SPA
Power Meter T6.93.9304 10 Bias Tee
Channel Scanner T6.93.9304 15 Voltmeter
Interference Analyzer T6.93.9304 16 6 GHz MWVNA
CW Signal Generator T6.93.9304 19 High Accuracy Power Meter
AM-FM-PM Analyzer T6.93.9304 25 Interference Analyzer
High Accuracy Power Meter T3.69.9304 ol Channel Scanner
Fixed WiMAX Signal Analyzer T3.44.9304 2iil GPS
Mobile WiMAX Signal Analyzer T3.44.9304 37 WIiMAX 802.16e (OTA)
Vector Network Analyzer T7.32.9304 46 WiMAX 802.16d (RF)
Vector Voltmeter T7.32.9304 47 WiMAX 802.16d (DEMOD)
LTE Signal Analyzer T3.48.9304 66 WiMAX 802.16e (RF)
P25 Analyzer T3.10.9304 67 WiMAX §02.16e (DEMOD)
NXDN Analyzer T3.10.9304 431 Coverage Mapping
DMR 2 Analyzer unversioned 509 AMFM/PM Analyzer (DEMOD)
PTC Analyzer T3.10.9304 52 P25 Tx Analyzer and Signal Generation
NBFM Analyzer T3.10.9304 509 P25 Coverage bt
H100% -
Figure 10-2. Web Remote Control Home Page
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Web Remote Control 10-3 Web Remote Control Interface

Remote Control

The Remote Control page displays a bitmap image of the instrument screen. The buttons on
the right of the display reflect the layout of the buttons on the instrument and are used to
access the same monitoring and control functions. See Figure 10-3.

VT S412E Address: 172.26.202.206

Home Remote Control Capture Screen Capture Trace File List Device Management Logout

Session Time Remaining
0 hours, 52 minutes

ANrikSU o5/05/2016 10:18:07 am

Ref Lvi
10.0 dBm

Input Atten
30.0 dB

I E
m

g

g

I

Application
Self

Test
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A M,
i "'f'\‘k“""'\’ﬂ'l & LEARARY

Sweep Time k
155 7 '».‘.\‘\l“'w” "’N'h\\‘\'l“"a\‘.‘.'\‘ gl

File Sys || Mode

il
o i H.W ﬁm-u'” '|>“v-\-n""u‘w"‘i"'

Meas Trace Limit

Calibrate
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§

Application

Options

o w
— ﬁ_‘ - ~ ;
(v a
| gwm

) ()

(

System . N
¥ Communication Activity

N Options

z Configure TimeOut

3 Sec

H100% -

Figure 10-3. Remote Control Page

*  When clicking a key or measurement icon on the Remote Control page, a
small green dot appears at the point of the cursor to indicate that the key,

Not button, or icon was pressed.
otes
* Asingle Web-enabled device can monitor and control multiple instruments.

However, multiple Web-enabled devices with different IP addresses cannot
connect to the same instrument simultaneously.

Session Time Remaining

This is the amount of time remaining before your remote session automatically terminates.
The session time is reserved at login. It can be changed on the Device Management page.
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10-3 Web Remote Control Interface Web Remote Control

Normal Mode

Normal Mode is the default mode, where the bitmap image of the instrument screen is
continually refreshed in the browser window. Click the single arrow button near the bottom
right of the page to return to Normal Mode from either Fast or Pause Mode. Clicking any tab
on the menu bar also returns to Normal Mode.

Fast Mode

Click the double arrow button to enter Fast Mode, where the update rate can be significantly
faster than Normal mode, especially over low bit-rate connections. Only the measurement
data (yellow trace) is continually updated. The main menu keys and submenu keys may look
different than in Normal Mode, but their functions are the same. Error messages are not
shown in Fast Mode.

Fast Mode is not available with some Spectrum Analyzer measurement types, in which case
the Fast Mode button is disabled. The button is not displayed when the measurement mode is
something other than Spectrum Analyzer.

While in Fast mode, if a measurement type is selected that Fast mode does not support, the
instrument will return to Normal mode.

Pause Mode

Clicking the Pause button turns the Communication Activity dot in the lower right-hand
corner to yellow. If the interface was in Normal Mode, this stops the instrument display from
refreshing in the browser window. If the interface was in Fast Mode, the trace measurement
stops updating. Click the single arrow or the double arrow button to resume remote
communications with the instrument in Normal or Fast Mode, respectively. The
Communication Activity dot then returns to green.

Communication Activity

The moving dot labeled Communication Activity, when green, indicates that ongoing
communication is occurring between the instrument and PC. When you click Home, Capture
Screen, Capture Trace, File List, Device Management, or Logout on the menu bar, the
Communication Activity dot briefly turns yellow before the selected page opens in the
browser.

Configure Timeout

If the Ethernet connection is poor and you expect frequent lags in response time, you can
increase the timeout up to 20 seconds, before the instrument sends an “Instrument Busy”
message. The default timeout is 3 seconds.
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Capture Screen

Captures a JPEG image of the current instrument display and saves it directly to internal
memory. A file name is automatically created using the current date and time stamp. The
captured display is loaded to the browser page, under the menu bar. See Figure 10-4. In
Windows, you can right-click on the screen image and select Copy. With 10S, press and hold
on the picture. This makes it easy to create documentation using screen captures.

Home Remote Control Capture Screen Capture Trace File List Device Management Logout

Iﬂnl‘itSLl 04/12/2016 11:56:31 am H = Freq 172

Ref Lvl M1 -54.471 dBm @751.000 MHz

-45.0 dBm
Center Freq 751.000 MHz Start Freq
741.000 MHz

Stop Freq

761.000 MHz

T
lup N Jﬁ'f,.“Jl mlpr.\‘l.' ﬁﬁ\r\w\
‘ Signal

A Normal

T
Traces I‘I v"""hlllhh" ! ||H |

y ‘ \‘ Standard
) J
‘-‘“'\Ih "ﬂ\-‘lil NII[‘}H r Channel

Freq Ref
GPS Hi Accy
741.000 MHz

Amplitude Marker

Figure 10-4. Capture Screen Page

Capture Trace

Opens an input dialog to enter a name for the trace to be saved. See Figure 10-5. After
clicking Save, a confirmation dialog opens to indicate the trace was successfully saved to the
instrument.

Home Remete Control Capture Screen Capture Trace File List Device Management Logout
Save Measurement
Filename |Trace 03 X

Figure 10-5. Capture Trace Page

Depending on the browser and operating system used, different prompts may appear. Some
operating systems like 10S may not support file saving from a browser.
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File List

Displays the list of folders (type “dir”) and files contained in the instrument's internal
memory. See Figure 10-6. To view the contents of a folder, click on the folder name.

Y/ i S412E IP Address: 172.26.202.206

Home Remote Control Capture Screen Capture Trace File List Device Management

D/L Select File Type Modified

| Anritsu_Snapshot dir MON 18/04/2016 04:36 PM

| IntMemTest.stp stp FRI 15/04/2016 08:58 AM

#100% -

Figure 10-6. File List Page

To download a file, click the file name. Alternatively, you can select the checkbox on the left of
the file name, then click Download. You may also select the checkboxes of multiple files and/or
folders and download them together, as a zipped folder. In this case, a pop-up dialog box
shows the estimated download time. Press OK to continue.

Note Some operating systems, like iOS, do not support file downloads.

Depending on the browser and operating system, the download function may allow you to
open the file or save it, or both. In Google Chrome, for example, the downloaded file or files
are automatically saved to the designated folder on your computer, such as the Downloads
folder. In the banner at the bottom of the browser window, click a downloaded item to open it.

If the selected item is a single file, the file will open in the default application for the file type.
For example, a JPEG file will open in the computer's default image viewer, while a
measurement file will open in Master Software Tools (MST), provided the application is
installed.

Device Management (not as Administrator)

Click the Device Management tab on the menu bar to set or clear the instrument password, to
assign a device name to the instrument, or to change the session time. See Figure 10-7.

If you logged in as Administrator, the Device Management page has additional sections for
viewing the remote access log and for setting device options. Refer to “Device Management
(Administrator)” on page 10-11.
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Password

If no password is set, which is the factory default, remote access to the instrument is
unrestricted and any user who knows the instrument IP address can connect to it, provided
the device isn’t currently reserved by another client. When a password is set, it is required
upon login. To clear the current password, click the Reset button. This password is different
from the administrator password described under “Device Management (Administrator)”.

/i T S412E IP Address: 172.26.202.206

Home Remote Control Capture Screen Capture Trace File List Device Management Logout
I Change Password I
New Password ‘ ‘ Default: None
Confirm Password ‘ ‘

The instrument Master Reset function will restore the defaults,
Master Reset is found under Shift, 8, Svstem Options, Reset, Master Reset.

Clicking the Reset button above will clear the current password.

Change Instrument Name

New Name | | Default: None

Save

This is a name that can be used to identify this instrument.

The instrument name can be viewed and set from the system menu.
The Name option is found under Shift, 8, Svstem Options, Name.

Change Session Time

Time Requested (up to 10 hours) hours minutes

Change the amount of time the instrument is reserved.

®100% -

Figure 10-7. Device Management Page

Instrument Name

The instrument name, if defined, is displayed in the green banner at the top of the page. It is
useful in identifying the instrument when you have more than one instrument connected. The
name can be assigned remotely from this Device Management page, or it can be set from the
instrument's System Options menu. Note that this instrument name is not a "hostname" as
used in an Ethernet router.
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Session Time

Use the pull-down menus to select the time, in hours and minutes, until the remote session
times out. Click Update to reset the session timer at the specified duration. At the end of the
selected time period, a message notifying the user that the session has expired displays.

172.26.202.254 says:

Session has expired, returning to the login page

Figure 10-8. Session Expired
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10-3 Web Remote Control Interface

Device Management (Administrator)

Logging in as Administrator gives you access to additional functions associated with the
instrument’s remote connection log and the display of information on the Login page.

Home Remote Control Capture Screen Capture Trace File List Logout
Change Password I
New Password Default: Admin
Confirm Password
Save Reset
The instrument Firmware Update will restore the default password.
Clicking the Reset button above will reset the password to default.
Access Log
2016 Apr01. 01:35PM  Admin Fail 172.26.202.96
2016 Apr 01, 01:37PM  Admin Success 172.26.202.246
2016 Apr 01. 01:39PM  Admin Success 172.26.202.96
2016 Apr01. 01:41PM  User Success 172.26.202.96
2016 Apr01. 01:44 PM  User Success 172.26.202.96
2016 Apr01. 01:45PM  Admin Success 172.26.202.96
| Download Log | | ClearLlog |

Device Options

expected, but not warranted
performance. They do not
guarantee the performance of
any individual product.

Save

Disclaimer Text

¥ Show device banner on Login page

Default: None

Change Instrument Name

New Name

Save

This is a name that can be used to identify this instrument.

The Name option is found under Shift, 8, Svstem Options, Name.

The nstrument name can be viewed and set from the system menu.

Default: None

Change Session Time

0 v |minutes

Update

Time Requested (up to 10 hours): 0 v hours

Change the amount of time the mstrument is reserved

Figure 10-9. Device Management Page (Administrator)
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Administrator Password

A password is always required to log in as Administrator. The password is case-sensitive,
with “Admin” as the factory default. To change the password, type your new entry twice and
click Save. See Figure 10-9 on page 10-11.

To restore the default password, click the Reset button. The administrator password is also
reset to default each time you update the instrument firmware.

Access Log

The Access Log is viewable only when you are logged in as Administrator. It contains the date
and time, success or failure status, and user information for up to 50 most recent login
attempts. To save a copy of the log to the default download location on your control device,
click Download Log. The saved file is a comma-delimited CSV file that can be opened with an
application like Microsoft Excel. Click the Clear Log button to empty the Access Log.

Some operating systems, such as iOS, do not support a user-accessible file
Note system. Consequently, the download function is not possible if your control device
is an Apple iPhone, for example.

Device Options

When logged in as Administrator, you have the option to turn on or off the optional text
message and the green banner on the Login page.

For security reasons, for example, you may not want the instrument IP address to display
during login. To hide the banner, deselect the Show device banner on Login page checkbox.
See Figure 10-9 on page 10-11. After changing the Show/Hide setting, click OK in the Banner
Visibility message box. You may need to scroll the browser page to bring the message box into
view.

The factory default is to show the banner. Note that this device option only affects the Login
page. Figure 10-10 illustrates the Login page with no banner.

« € | [} 172.26.202.254/Login o

Specifications describe the warranted performance of the
instrument. Typical specifications. noted in parenthesis ().
describe performance that will be met by a minimum of 80 %
of all products. They do not include guard bands and are not
warranted. Nominal specifications are generally representative
of the expected performance. They are not tested and not

I warranted.

Password:
‘ ¥ Login as Administrator
Time Requested (up to 10 hours): 1 v |hours|0 v minutes
Login

Enter your password and press Login to continue. |

Figure 10-10.Login Page with Optional Text and No Banner
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Web Remote Control 10-3 Web Remote Control Interface

To add a disclaimer or any other message to the Login page, enter the appropriate text in the
text box under the Device Options section of the Device Management page, then click Save.
See Figure 10-9 on page 10-11. Click OK in the update status message box (Figure 10-11).
You may need to scroll the browser page to bring this message box into view.

New disclaimer text successfully updated

OK

Figure 10-11.Disclaimer Text Update Status

Figure 10-10 on page 10-12 shows an example of optional text on the Login page. To remove
the message, delete it from the Disclaimer Text box on the Device Management page and click
Save, then OK.

Instrument Name

The instrument name function is the same whether you are logged in as Administrator or as a
regular user. Refer to “Instrument Name” on page 10-9.

Session Time

The session time is set in the same manner, whether you are logged in as Administrator or as
a regular user. Refer to “Session Time” on page 10-10.

Logout

Exits Web Remote Control and displays the Login page. To start a new session, enter the
password if required, select the session time, and click Login.

If you close the Web Remote Control browser window without logging out, there
Note may be a slight delay before the instrument is released. During this time,
connection attempts by other users will fail.
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Appendix A — Measurement Guides

A-1 Introduction

This appendix provides a list of supplemental documentation for LMR Master features and
options. Measurement guides are available as PDF files on the documentation disc and the

Anritsu website (http://www.anritsu.com).

Table A-1. Measurement Guides for Analyzers and Analyzer Options (1 of 2)

LMR Master Feature (Available Option)

Document and Part Number

LMR Master Instrument

Important Product Information,
Compliance, and Safety Notices
(10100-00065)

Performance Specifications

LMR Master Technical Data Sheet
(11410-00486)

NBFM Analyzer

P25/P25p2 Analyzer (Option 521)
P25/P25p2 Coverage (Option 522)
NXDN Analyzer (Option 531)
NXDN Coverage (Option 532)
dPMR Analyzer (Option 573)
dPMR Coverage (Option 572)
DMR Analyzer (Option 591)

DMR Coverage (Option 592)
PTC-ITCR Analyzer (Option 721)
PTC-ITCR Coverage (Option 722)
PTC-ACSES Analyzer (Option 731)
PTC-ACSES Coverage (Option 733)
TETRA Analyzer (Option 581)
TETRA Coverage (Option 582)

Land Mobile Radio
Measurement Guide (10580-00243)

Spectrum Analyzer

PIM Hunting

Interference Analyzer (Option 25)
Channel Scanner (Option 27)
Coverage Mapping (Option 431)
AM/FM/PM Analyzer (Option 509)
EMF Measurements (Option 444)

Spectrum Analyzer
Measurement Guide (10580-00349)

Vector Network Analyzer
VNA Bias-Tee (Option 10)
Vector Voltmeter (Option 15)
Distance Domain

Vector Network Analyzer
Measurement Guide (10580-00289)

High-Accuracy Power Meter (Option 19)

Power Meter
Measurement Guide (10580-00240)
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A-1 Introduction

Measurement Guides

Table A-1. Measurement Guides for Analyzers and Analyzer Options (2 of 2)

LMR Master Feature (Available Option)

Document and Part Number

LTE RF Measurements (Option 541)

LTE Modulation Quality (Option 542)

LTE OTA Measurements (Option 546)

LTE 256QAM Modulation Measurements (Option 886)
TDD LTE RF Measurements (Option 551)

TDD LTE Modulation Quality (Option 552)

TDD LTE OTA Measurements (Option 556)
GSM/GPRS/EDGE Measurements (Option 880)

EMF Measurements (Option 444)

3GPP Signal Analyzer
Measurement Guide (10580-00234)

Fixed WiIMAX RF Measurements (Option 46)

Fixed WiMAX Demodulation (Option 47)

Mobile WiIMAX RF Measurements (Option 66)

Mobile WiMAX Demodulation (Option 67)

Mobile WiIMAX Over-the-Air Measurements (Option 37)

WIMAX Signal Analyzer
Measurement Guide (10580-00236)

SCPI Programming Manual

LMR Master Programming Manual
(10580-00319)

A complete suite of PC Tools for Anritsu Handheld RF Instruments is available for download
at anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box.
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Appendix B — Error Messages

This appendix provides information and error messages that could be displayed on the
LMR Master. If any error condition persists, contact your local Anritsu Service Center.

B-1 Reset Options

You can reset your LMR Master to Factory Defaults or use a Master Reset to return to the
FULL Factory Default condition from the instrument menu or from the Off condition.

Reset Via Instrument Menus
To reset the instrument from the menu:

1. On the LMR Master menu system, press the Shift key, then the System (8) key to open
the System menu.

2. Press the System Options submenu key to open the System Options menu.

Press the Reset submenu key to open the Reset menu (refer to “Reset Menu”
on page 5-18).

4. From the Reset menu, press either the Factory Defaults submenu key or the
Master Reset submenu key.

Using Master Reset erases all of the user-saved setups and measurement traces

Caution and returns the LMR Master to a full Factory Default condition.

Reset from OFF Condition

You can also reset the LMR Master by turning it Off and then restarting under one of the
following conditions:

Factory Defaults Reset:
To preserve user files and reset to factory defaults:
1. Hold the Esc button while pressing and releasing the On/Off button.
2. Continue holding the Esc button until the Anritsu splash screen appears.

3. Release the Esc button. The LMR Master starts up with many Factory Default settings
(refer to “Factory Defaults” on page 5-18). Throughout this appendix, this sequence is
abbreviated as Factory Defaults (Esc+0n).
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B-2 Self Test

Error Messages

Master Reset:

Caution

Using Master Reset, erases all of the user-saved setups and measurement traces
and returns the LMR Master to a full Factory Default condition.

To force a master resetting of the instrument:

1. Hold the 8 key in the number keypad (also referred to as the System (8) key) while
pressing and releasing the On/Off button.

Continue holding the 8 key until the Anritsu splash screen appears.

Release the key. The LMR Master starts up in FULL Factory Default condition (refer to
“Master Reset” on page 5-18). Throughout this appendix, this sequence is abbreviated
as Master Reset (System+0n).

B-2 Self Test

To run self test, press Shift and System (8) and then Self Test. Refer to the results window in
Figure B-1, which summarizes the status of several key functions in the instrument that are
common to all applications (note that your instrument display may differ from this image).
If any subtest shows FAILED, then check that the battery level is adequate for operation,

or check that the temperature is within acceptable limits. Reset to factory defaults with

either “Factory Defaults Reset:” (Esc+0n), or “Master Reset:” (System+0On).

USE: PASSED

Disk-on-Chip: PASEED
EEPROM: PASSED
Temperature: Ok
DsF: PASSED
RTC: PASSED
Display: PASSED
Battery: PASSED
Power: PASSED

vEys= 11784 v

15418 Y PASSED
YDEP: PASSED

4.0%=4026 W

58 W=5763 Y

128 v=12461 V

24 W= 22964 V

-5.8"%=-5795 V¥

-15.0 W= -15.224 ¥

RTC backup= 3023 V
CPUFPGA version: 214

Decade PLD Version: 2.04

katherboard 1D 765

Figure B-1.

Self Test Results Window
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Error Messages B-3 Application Self Test

B-3 Application Self Test

VNA Mode Self Test (Vector Network Analyzer mode only)

To run the application self test, press Shift and System (8) and then Application Self Test from
within the desired mode. When you are in Vector Network Analyzer mode, you will see the
results window that is shown in Figure B-2 (note that your instrument display may differ
from this image). It summarizes the status of several key functions that are specific to this
application.

APPLICATION SELF TEST

Oweral Status: PASSED -

2. Frequency Sweep=FASSED
3. EEPROM = PASSED

YNa FPGA: v3.00

Figure B-2. Application Self Test

If the Overall Status shows Failed, then one or more elements of the Application Self Test
have failed. This self test consists of two subtests:

Frequency Sweep: Lists any frequency range over which errors in the sweep are occurring
EEPROM: Indicates whether reading or writing (or both) to the EEPROM has failed

If any of the subtests shows FAILED, then check that the battery level is adequate for
operation or that temperature is within acceptable limits. Reset to factory defaults with
either “Factory Defaults Reset:” (Esc+0n), or “Master Reset:” (System+0On).

Spectrum Analyzer Mode Self Test

AFPPLICATION SELF TEST
Owverall Status: PASSED
A0C Self Test: PASSED

hixer Temperature: 43C
DSP FPGA Wersion: 1.13
SPA FPGA Wersion: 1.14

Figure B-3. SPA Application Self Test
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Error Messages

CW Signal Generator Mode Self Test

APPLICATICMN

Owerall Status: PASSED

Sys PLL: PASSED

G PLL: PASEED

LD PLL: PASSED

YR FLL: PASSED
SigGen FPGA Ver: 1.01
Sinad: PASSED

Sinad Lvl: 8.4 dB

Sinad Freg: §32.3 Hz
Sinad PP: 1483174 mV

Level Cal ver: 1

Figure B-4. CW Signal Generator Application Self Test

NBFM, P25/P25p2, NXDN, dPMR, DMR, PTC-ITCR, PTC-ACSES, and TETRA

Analyzer Self Test

AFFPLICATION SELF TEST

Cverall Status: PASSED
HW Present: PASSED
DOC Test PASSED
EEFROK Test: PASSED
FIFO Test: PASSED
Lock Test PASSED

Sys PLL: PASSED

IG PLL: PASSED

LO FLL: PASSED

WR FLL: PASSED

SigGen FPGA Ver: 1.09
SigGen FPGA USE Programmable?: Yes
SigGen Flash Size: 2 GBits
SigGen Board |1D: G0200-4
SINAD: PASSED

SINAD Lyvl: 6.5 dB

SINAD Freg: 332.3 Hz
SINAD PP: 605.493 mY
DSFP FPGA Wer: 1.50
YWoltage Levels: PASSED

Figure B-5. All Others Application Self Test
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B-4 Operation Error Messages

Measurement mode specific error messages are listed in the Measurement

Note Guides. Refer to Appendix A.

Fan Failure

The system has determined that the fan should be running due to the internal temperature of
the unit, but cannot detect that the fan is actually running.

It is important to keep the fan inlet and exhaust ports clear of obstructions. The cooling fan
will vary the speed in relation to the internal temperature of the instrument (refer to
Figure B-6). The fan will turn on at low speed when the internal temperature of the
instrument reaches 44°C, and will increase the fan speed to maximum at 54°C. As the
internal temperature of the instrument decreases, the fan will reduce speed until the
temperature reaches 39°C, at which point the fan will turn off.

& &
&
¥
. Q
Temperature Rising === &
emperature Rising === \/&Q v‘§
FAN OFF | LOW | HeH ¥
SPEED | | ' |
-100 39,41, 43, 45 4T 40 5T 53, 85 90 +100
e [
FAN OFF | LOW | HIGH |
SPEED | | |

Temperature Falling guu==

Figure B-6. Fan Speed vs. Temperature

High Temp Warning

The internal temperature has reached an excessive level, 85°C. Verify that the ventilation
openings are unobstructed and that the fan is running. Internal temperatures may be
manually verified by using the SELF TEST function. Turn off the unit and allow the
temperature to cool down. If the fault is not resolved and the internal temperature reaches
90°C, then a countdown of 10 seconds will begin. The countdown gives the user a chance to
save the current setup before the instrument turns itself off (before internal temperatures
can cause any damage). If the error persists after removing any obstructions and allowing the
unit to cool, then reset to the factory defaults with “Factory Defaults Reset:” (Esc+0n), or
“Master Reset:” (System+On).
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Operation not Permitted in Recall Mode

Attempted to perform an operation on a recalled trace. Many operations are valid only on a
live or active trace.

Power Supply
Power Supply failed. Charge the battery.

Error Saving File. General Error Saving File

An error was detected while saving a file. Try again.
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Appendix C — Tower Mounted
Amplifiers

C-1 Introduction

A Tower Mounted Amplifier (TMA) can be used to amplify the received signal. There are
different types of TMA depending on the system requirements. Three commonly used types
are:

e TMA-D: A duplex tower mounted amplifier that combines transmit and receive ports
from the radio system and connects to a single antenna. This configuration is specific to
systems that use a single antenna configuration.

e TMA-S: A receive-only tower mounted amplifier is installed between the receiving
antenna and the radio to boost weak signals. This configuration is common on systems
that implement separate antennas for transmitting and receiving.

e TMA-DD: A dual-duplex tower mounted amplifier used for radios systems with a single
transmission line connection for transmit and receive. These systems are commonly
called transceivers.

TMA-D

TMA-S TMA-DD

= T 5

ANT RX

(Bias Tee) i \ /

RFOUT RFIN ANT RX ANT RX/TX
{Bias Tee) (Bias Tee)
ARFOUT RFIN AF OUT RFIN

Figure C-1. Tower Mounted Amplifiers
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Appendix D — Glossary of Terms

D-1

Introduction

The following terms are related to this product and its technology.

D-2

Adaptive Array

3GPP:

Adapter :

Antenna :

ADC :

Glossary of Terms
3 dBrule:

The 3 dB rule provides a means to estimate relative power values. A 3
dB gain indicates that power increases to twice the power (a multiple of
2). A 3 dB loss indicates that power decreases to half the power (a
multiple of 1/2). A system with 40 watts of input power and a 6 dB
insertion loss will have only 10fwatts of output power (a multiple of 1/2
for each 3 dB loss, or 1/4 of 40 watts).

The 3rd Generation Partnership Project (3GPP) is a collaboration
agreement that was established in December, 1998. It is a co-operation
between ETSI (Europe), ARIB/TTC (Japan), CCSA (China), ATIS
(North America), and TTA (South Korea). The scope of 3GPP was to
make a globally applicable third generation (3G) mobile phone system
specification within the scope of the ITU’s IMT-2000 project. 3GPP
specifications are based on the evolved GSM specifications, now
generally known as the UMTS system.

A fitting that supplies a passage between two sets of equipment when
they cannot be directly interconnected.

Adaptive array antenna is a type of advanced ’smart’ antenna
technology that continually monitors a received signal and dynamically
adapts signal patterns to optimize wireless system performance. The
arrays use signal processing algorithms to adapt to user movement, to
changes in the radio-frequency environment, and to multi-path and
co-channel interference.

Analog-to-Digital Converter (ADC, A/D or A to D) is an electronic device
that converts continuous signals to discrete digital numbers. The
reverse operation is performed by a digital-to-analog converter (DAC).
ADC can uniquely represent all analog input values within a specified

total input range by a limited number of digital output codes. Refer also
to DAC.

S412E UG
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D-2 Glossary of Terms Glossary of Terms

Adjacent Channel :

Adjacent channel
interference :

AM :

AMC :

Analog System :

Analog
Transmission :

Antenna :

Antenna
beamwidth :

Adjacent Channel is a channel or frequency that is directly above or
below a specific channel or frequency. First-adjacent is immediately
next to another channel, and second-adjacent is two channels away, and
so forth. Information on adjacent channels is used in keeping stations
from interfering with one another.

Adjacent channel interference refers to signal impairment to one
frequency due to the presence of another signal on a nearby frequency.

Amplitude Modulation (AM) uses amplitude variation in proportion to
the amplitude of the modulating signal, and is usually taken as DSB-LC
(Double-Sideband Large Carrier) for commercial broadcast
transmissions and DSB-SC (Double-Sideband Suppressed Carrier) for
multiplexed systems.

Adaptive Modulation and Coding (AMC) is an alternative link
adaptation method in 3G mobile wireless communication. AMC
provides the flexibility to match the modulation-coding scheme to the
average channel conditions for each user. With AMC, the power of the
transmitted signal is held constant over a frame interval, and the
modulation and coding format is changed to match the current received
signal quality or channel conditions.

An Analog system uses an analog transmission method to send voice,
video and data-using analog signals, such as electricity or sound waves,
that are continuously variable rather than discreet units as in digital
transmissions. Mobile analog systems include AMPS, NMT, and
ETACS.

Analog Transmission refers to signals propagated through the medium
as continuously varying electromagnetic waves.

Antenna is a device which radiates and/or receives radio signals,
including RF, microwave, and RADAR.

Antenna beamwidth, also known as the half-power beamwidth, is the
angle of an antenna pattern or beam over which the relative power is at
or above 50% of the peak power.

D-2
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D-2 Glossary of Terms

Antenna Directivity :

Antenna Efficiency :

Antenna Gain :

Antenna, Isotropic :

Antenna, Parabolic :

Attenuation :

Attenuator :

Average power :

Band Pass Filter :

Antenna directivity, also known as antenna gain, is the relative gain of
the main beam of an antenna pattern to a reference antenna, usually an
isotropic or standard dipole. Antenna Directivity is the percentage of
radiated signal transmitted or received in a given direction related to
beamwidth.

Antenna Efficiency is the percentage of theoretical gain actually
realized from an antenna.

Antenna gain, also known as antenna directivity, is the relative gain of
the main beam of an antenna pattern to a reference antenna, usually an
isotropic or standard dipole. Antenna Gain is the effectiveness of a
directional antenna expressed as the ratio of input power of the
directional antenna to input power of an isotropic radiator to provide
the same field strength in the desired direction. Sometimes related to a
dipole antenna.

An isotropic antenna is a theoretical point source radiating a spherical
power envelope.

A parabolic antenna is an antenna utilizing a reflector that is shaped as
a paraboloid in order to both concentrate the radiated signal into a
beam and to provide considerable gain. Beamwidth varies inversely and
gain varies directly with the size of the antenna and with frequency.

Attenuation refers to decreasing in signal magnitude between two
points. These points may be along a radio path, transmission line or
other devices.

Attenuator is a device specifically designed to decrease the magnitude
of a signal transmitted through it.

Average power is the peak power averaged over time and is usually
applied to pulsed systems where the carrier power is switched on and
off.

A Band Pass Filter is a radio wave filter with a specific range of
frequencies in which it is designed to pass. It rejects frequencies outside
the pass-band range. A resistor-inductor-capacitor circuit is an example
of a Band Pass Filter.

S412E UG

PN: 10580-00318 Rev. AC D-3



D-2 Glossary of Terms Glossary of Terms

Bandwidth :

BER:

BERT :

Bias Tee :

Broadband :

C/:

Bandwidth usually identifies the capacity of a circuit or amount of data
that can be sent through a given circuit. It may be user-specified in a
PVC. It is an indication of the amount of data that is passing over a
medium. Also, bandwidth is the portion of the frequency spectrum
required to transmit desired information. Each radio channel has a
center frequency and additional frequencies above and below this
carrier frequency which is used to carry the transmitted information.
The range of frequencies from the lowest to the highest used is called
the bandwidth.

Bit Error Rate or Bit Error Ratio (link quality specification/testing)
(BER) is a measure of transmission quality. The ratio of error bits to the
total number of bits transmitted. A bit error rate of 10-6 refers to an
average of one error per million bits. It is generally shown as a negative
exponent, (for example, 10-7 which means 1 out of 107 bits are in error
or 1 out of 10,000,000 bits are in error). Bit Error Rate is the fraction of
a sequence of message bits that are in error.

Bit Error Rate Test/Tester (BERT) is a test that gauges the quality of
the T1 or digital line. By sending a known pattern to another device
across the span, the far end device can compare incoming pattern to its
own, thereby indicating bit errors on the line.

A three-port network used to supply an isolated DC signal.

Broadband refers to telecommunication that provides multiple channels
of data over a single communications medium, typically using some
form of frequency or wave division multiplexing. It is a service or
system requiring transmission channels capable of supporting rates
greater than the Integrated Services Digital Network (ISDN) primary
rate.

Carrier-to-Interference ratio (C/I) is the ratio of power in an RF carrier
to the interference power in the channel.

D-4
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D-2 Glossary of Terms

Calibration :

Carrier Frequency :

Cell Site :

Coaxial Cable :

Coupler :

CW:

When making measurements, the instrument must be calibrated in
order to remove residual errors due to measurement setup conditions.
Anritsu recommends performing the calibration under the same
conditions as the measurement: temperature, frequency, number of
points, source power, and IFBW. Calibrations standards with known
reflection coefficients are used to calculate the correction factors. The
calibration must be conducted using the appropriate standards at the
open end of any test port cables and adapters that are connected to the
instrument. This ensures that the match, phase length, and loss of
these cables and adapters are all accounted for. For optimal
performance, high quality phase-stable cables and precision adapters
must be used.

Carrier Frequency refers to the nominal frequency of a carrier wave, the
frequency of the unmodulated electrical wave at the output of an
amplitude modulated, the center frequency of a frequency modulation
signal, frequency modulated, or phase modulated transmitter of the
output of a transmitter when the modulation is zero.

Cell Site, also called Base Station, is the local cellular tower and radio
antenna (including the radios, controller, switch interconnect, etc.) that
handles communication with subscribers in a particular area or cell. A
cellular network is made up of many cell sites, all connected back to the
switch via landline or microwave.

Coaxial Cable (Coax) is a type of electrical communications medium
used in the LAN environment. This cable consists of an outer conductor
concentric to an inner conductor, separated from each other by
insulating material, and covered by some protective outer material.
This medium offers large bandwidth, supporting high data rates with
high immunity to electrical interference and a low incidence of errors.
Coax is subject to distance limitations and is relatively expensive and
difficult to install.

A coupler is a passive device used to split or combine a transmission
line.

Continuous Wave (CW)

S412E UG
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DANL :

dB:

dBc:

dBm :

Demodulate :

Displayed Average Noise Level (DANL): Displayed average noise level
is sometimes confused with the term Sensitivity. While related, these
terms have different meanings. Sensitivity is a measure of the
minimum signal level that yields a defined signal-to-noise ratio (SNR)
or bit error rate (BER). It is a common metric of radio receiver
performance. Spectrum analyzer specifications are always given in
terms of the DANL. One of the primary uses of a spectrum analyzer is to
search out and measure low-level signals. The limitation in these
measurements is the noise generated within the spectrum analyzer
itself. This noise, generated by the random electron motion in various
circuit elements, is amplified by multiple gain stages in the analyzer
and appears on the display as a noise signal. On a spectrum analyzer,
this noise is commonly referred to as the Displayed Average Noise
Level, or DANL 1. While there are techniques to measure signals
slightly below the DANL, this noise power ultimately limits our ability
to make measurements of low-level signals.

Decibel or deciBel (dB) is a logarithmic ratio of the difference between
two values (a logarithm ratio is equal to 10 times). dB is a unit for
measuring relative power ratios in terms of gain or loss. The units of dB
are expressed in terms of the logarithm to base 10 of a ratio and
typically are expressed in watts. For example, a -3 dB loss indicates a
50% loss in power; a +3 dB reading is a doubling of power; 10 dB
indicates an increase (or a loss) by a factor of 10; 20 dB indicates an
increase (or a loss) of a factor of 100; 30 dB indicates an increase (or a
loss) by a factor of 1000. Common values of dB expressed in ratios: 0 dB
=1:1,10dB =10:1, 20 dB = 100:1, 30 dB = 1000:1, -30 dB = 0.001:1 [or
(1/1000):1].

Decibels referenced to the carrier (dBc) is a technique for expressing a
power measurement in logarithmic form using the carrier power as a
reference. The units are used to describe how far down signals and noise
are relative to a known signal. Typical use of this term is to describe
spurious signals and noise compared to a desired transmit signal.

dBm is an absolute measurement of power relative to 1 milliwatt. In
other words, dBm is a decibel value referenced to a milliwatt (dBm).
This is a technique for expressing a power measurement in logarithmic
form using 1 mW as a reference. dBm is a decibel ratio (log 10) of Watts
(W) to one milliwatt (1mW). dBm, therefore, represents absolute power.
Examples are: 0 dBm = 1.0 milliwatt, 10 dBm = 10 milliwatt, 30 dBm =
1000 milliwatt = 1 watt.

To extract information from a transmitted (modulated) signal.
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Demodulator :

Deviation :

DHCP:

Directional Coupler :

Discriminator :

Distributed antenna
system :

DMR:

DSP:

Duplex :

EMF :

FFT:

A device that extracts information from a transmitted (modulated)
signal.

The difference between signal parameters (generally in frequency
modulated signals, the difference between the maximum modulated
frequency and the base carrier frequency).

Dynamic Host Configuration Protocol (DHCP)

A Directional Coupler is a device to split an incident transmission into
two separate paths, and to absorb reflections from the sampled
(coupled) line.

A Discriminator is a demodulation circuit that is used to recover the
modulation from frequency modulated signals. A Discriminator
responds to frequency variations.

Distributed antenna system is a type of antenna system that is
distributed or remotely located away from the transmitter. Such an
antenna or series of antennas can be connected via coaxial cable, leaky
feeder, or optical fiber link.

Digital Mobile Radio (DMR)

Digital Signal Processing (DSP)

Duplex refers to two way communication.

Electromagnetic Field

Fast Fourier Transform (FFT) is an efficient algorithm to compute the
Discrete Fourier transform (DFT) and its inverse. FFTs are of great
importance to a wide variety of applications, from digital signal
processing to solving partial differential equations to algorithms for
quickly multiplying large integers.

S412E UG
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Flash Memory :

FM:

FM Modulation
Index :

FM Threshold :

GPS :

Graticule :

Impedance :

Flash memory is a non-volatile solid state storage device that is
packaged as a chip. It can be electrically erased and reprogrammed. It is
primarily used in memory cards, USB flash drives, MP3 players, and
solid-state drives for general storage and transfer of data between
computers and other digital products. It is a specific type of EEPROM
(electrically erasable programmable read-only memory) that is erased
and programmed in large blocks.

Frequency Modulation (FM) is a form of angle modulation in which the
instantaneous frequency of a sine-wave carrier is caused to depart from
the carrier frequency by an amount proportional to the instantaneous
value of the modulating wave. In FM, signals of different frequencies
represent different data values.

In FM modulated systems, the FM Modulation Index is the ratio of the
peak frequency deviation to the maximum modulating frequency. The
higher the index, the greater the received quality. M Modulation Index
= (peak frequency deviation / maximum modulation frequency)

FM Threshold is the point at which the input signal power is just strong
enough to enable the receiver demodulator circuitry to successfully
detect and recover a good quality television picture from the incoming
video carrier.

The Global Positioning System (GPS) is a space-based global navigation
satellite system (GNSS) that provides reliable location and time
information in all weather and at all times when and where an
unobstructed line of sight is available to four or more GPS satellites.
The system is maintained by the United States government and is
freely accessible by anyone with a GPS receiver. The Global Positioning
System is making it possible for people using ground receivers to
determine their geographic location within 10 meters to 100 meters.
The satellites use simple mathematical calculations to broadcast
information that is translated as longitude, latitude, and altitude by
Earth-based receivers.

A reticle or grid.

Impedance is a measure of RF component electrical resistance,
measured in ohms. In most cable and antenna systems, the standard
impedance is 50 ohms.

D-8
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Insertion Loss :

IP Address :

IPv6 :

Insertion Loss (or Cable Loss) is a measure of the total amount of signal
energy absorbed (lost) by the cable assembly. It is measured in dB. S21
(an S-Parameter) is another name for this measurement.

An Internet Protocol address (IP address) is usually a numerical label
that is assigned to each device (computer or printer for example) that is
participating in a computer network that uses the Internet Protocol for
communication. An IP address serves two main functions: location
addressing and host (or network) interface identification. The Internet
Protocol originally defined an IP address as a 32-bit number. This was
known as Internet Protocol Version 4 (IPv4), which is still in use.
Growth of the Internet requires a new addressing system. An Internet
Protocol Version 6 (IPv6) that uses 128 bits for the address was
developed in 1995, and it is standardized as RFC 2460. IPv6 began
being deployed worldwide in the year 2000. IP adresses are binary
numbers, but they are usually stored in text files and displayed in
human-readable notations, such as decimal nnn.nnn.nnn.nnn or
172.16.255.1 (for IPv4), and hexadecimal
nnnn.nnnn.nNNN.ANNN.ANNAN.NNNN.NNNN.ANAN OF
2C01:AB18:0:1234:FF03:567C:8:1 (for IPv6). In IPv4, each decimal
group (nnn) represents values from 000 to 255, or binary values of 8
bits. In IPv6, each hexadecimal group (nnnn) represents values from
0000 to FFFF, or binary values of 16 bits (0000 0000 0000 0000 to 1111
11111111 1111).

Internet Protocol Version 6 (IPv6) is a numerical label that is used to
identify a network interface of a computer or other network node
participating in an IPV6-enabled computer network. IPv6 uses 128 bits
for the address (as compared to an IPv4 address, which is defined as a
32-bit number). Pv6 was developed in 1995, and it is standardized as
RFC 2460. V6 began being deployed worldwide in the year 2000. I
addresses are binary numbers, but they are usually stored in text files
and displayed in human-readable notations, such as hexadecimal
NNNn.NNNN.NNNN.ANNN.ANNN.NNNN. NNNN.ANNAN OF
2C01:AB18:0:1234:FF03:567C:8:1 (where FFFF [Hex] = 65535 [Dec)).
Ea hexadecimal group (nnnn) represents values from 0000 tofFFFF, or
binary values of 16 bits (0000 0000 0000 0000 to 1111 1111 1111 1111).

In-phase and Quadrature (IQ) or (I/Q) 1Q is a method of representing
digital modulation. Ll baseband signals can be represented by an I
(In-Phase) portion and a Q (Quadrature-Phase) portion. Vectors
describe the I and Q states (or equivalently the amplitude and phase) of
a signal, so that all possible information about that signal can be
derived from them. Ittext files contain pairs of I/Q values for signals
that they represent. IQ modulators are 90tdegrees out of phase with
each other. IQ modulation combines two channels of information into
one signal and then separates them later.

S412E UG
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LMR:

LST:

LTE :

LVD :

NBFM :

NF :

NXDN :

OBW :

Land Mobile Radio

Line Sweep tools (LLST) is PC-based post-processing software that
efficiently manipulates line sweep and PIM traces for reporting
purposes.

Long Term Evolution (LTE), sometimes also referred to as 3G LTE or
Super-3G, is the 3GPP radio technology evolution architecture. Its full
name is UTRA-UTRAN Long Term Evolution (LTE) and 3GPP System
Architecture Evolution (SAE). TE refers to a mobile technology upgrade
path for 3G networks that will provide faster data speeds and new
services through new radio access technology optimized for IP-based
traffic. E is part of the GSM evolutionary path beyond 3G, following
EDGE, UMTS/W-CDMA, and HSPA (HSDPA and HSUPA combined). L
uses Orthogonal Frequency Division Multiple Access (OFDMA) on the
downlink to achieve high peak data rates in high spectrum bandwidth.
LT systems will coexist with 3G systems as well as 2G systems. Multi
mode devices will likely function across LTE/3G or even LTE/3G/2G,
depending on market circumstances.

Low Voltage Directive (LVD)

Narrow Band Frequency Modulation

Noise Figure (NF) is a measure of degradation of the signal-to-noise
ratio (SNR) that is caused by components in a radio frequency (RF)
device. The noise factor (F) of a system is defined as the signal-to-noise
ratio of the input power of the system divided by the signal-to-noise
ratio of the output power of that system. F (the noise figure) is defined
as the decibel value of the noise factor. NF = 10log (F) where log uses
the base 10, or common log. This formula is valid only then the input
termination is at standard noise temperature.

A narrowband frequency-domain multiple access communication
protocol.

Occupied Bandwidth (OBW) is a measure of the bandwidth containing
99% of the total integrated power of the transmitted spectrum, centered
on the assigned channel frequency. Interference to other channels or to
other systems can occur if OBW 1is too large.
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OSL:

OSLT:

OTA:

P25 :

PTC:

Return Loss :

OSL or Open Short Load calibration method for coaxial line types.
Calibrations standards with known reflection coefficients are used to
calculate the correction factors. Refer to Calibration. Compare this with
SSL or Offset Short 1, Offset Short 2, Load calibration method for
waveguide line types.

OSLT or Open Short Load Thru calibration method for coaxial line
types. Calibrations standards with known reflection coefficients are
used to calculate the correction factors. Refer to Calibration. Compare
this with SSLT or Offset Short 1, Offset Short 2, Load, Thru calibration
method for waveguide line types.

Over The Air (OTA): OTA refers generally to any transfer of information
or signal that takes place in a wireless environment, rather than using
a wired connection. OTA is usually used in connection with a standard
defining the provisioning of mobile devices and applications, such as
downloading or uploading content or software, and commonly used in
conjunction with the Short Messaging Service (SMS). SMS OTA
Messages contain information that is used to configure the settings of a
WAP browser in a mobile phone (refer to SMS and WAP).

An set of open interface communication standards.

Positive Train Control (PTC) is a system that provides railway safety
for trains and workers. The American Railway Engineering and
Maintenance-of-Way Association (AREMA) organization describes PTC
as having the following primary characteristics: [1] train separation for
collision avoidance, [2] enforcement of line speeds, [3] temporary speed
restrictions, and safety of wayside rail workers. In PTC, movement
authority and train location (via GPS) are available by utilizing wireless
technologies.

Return Loss is a measurement (in dB) of reflected energy caused by
impedance mismatch. Return loss is the loss of power in the signal
returned/reflected by a discontinuity in a transmission line or optical
fiber. May also be referred to as S11. Although S11 values are expressed
as negative numbers, Return Loss values are expressed as positive
numbers because by definition the iLossi expression implies a negative
sign. The higher the value, the better the impedance match (think of a
large negative number being less than a smaller negative number). 40
dB is nearly ideal. Only 0.01 % of the total transmitted power is
reflected if the Return Loss measurement value is 40 dB. A measured
value of 0 dB would be a complete reflection, or stated another way, 100
% of the transmitted power is reflected back. Return Loss is typically a
pass/fail measurement.

S412E UG
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RF :

SCPI :

SINAD :

SOLT :

SSL:

SSLT:

TETRA:

TFT:

Radio Frequency (RF) is the frequency of radio sine waves. RF generally
refers to wireless communications within a frequency range of 3 kHz to
300 GHz. Formally, according to the Article 2 of the Radio Law, radio
frequency is below 3,000 GHz. Radio frequencies can be used for
communications between a mobile telephone and an antenna mast.

Standard Commands for Programmable Instruments (SCPI)

Signal-to-Noise And Distortion (ratio) (SINAD)

Short Open Load Thru calibration method for coaxial line types with
simple and redundant standards. It is not band-limited. It requires
well-defined standards. It has lower accuracy at higher frequencies.
Calibrations standards with known reflection coefficients are used to
calculate the correction factors. Refer to Calibration. Compare this with
SSLT or Offset Short 1, Offset Short 2, Load, Thru calibration method
for waveguide line types.

SSL or Short Short Load or Offset Short 1, Offset Short 2, Load
calibration method for waveguide line types uses Shorts with different
offset lengths. It is a calibration (common in waveguide) with simple
and redundant standards, but it is band-limited. It requires
well-defined standards. It has lower accuracy at higher frequencies.
Offset Short 1 is 1/8 wavelength, and Offset Short 2 is 3/8 wavelength.
Calibrations standards with known reflection coefficients are used to
calculate the correction factors. Refer to Calibration. Compare this with
OSL or Open Short Load calibration method for coaxial line types.

SSLT or Short Short Line Thru or Offset Short 1, Offset Short 2, Load,
Thru calibration method for waveguide line types uses Shorts with
different offset lengths. It is a calibration (common in waveguide) with
simple and redundant standards, but it is band-limited. It requires
well-defined standards. It has lower accuracy at higher frequencies.
Offset Short 1 is 1/8 wavelength, and Offset Short 2 is 3/8 wavelength.
Calibrations standards with known reflection coefficients are used to
calculate the correction factors. Refer to Calibration. Compare this with
OSLT or Open Short Load Thru calibration method for coaxial line

types.

Terrestrial Trunked Radio (TETRA) (new name)

Thin-Film Transistor/Thin-Film Technology (TFT)

PN: 10580-00318 Rev. AC S412E UG



Glossary of Terms D-2 Glossary of Terms

TMA: A Tower Mounted Amplifier (TMA) amplifies signals from an antenna
to reduce the signal to noise ratio of a base transceiver station (BTS).
This helps to improve the overall sensitivity of the BTS. A TMA is a
low-noise amplifier (LNA) that is usually mounted as close as practical
to the antenna in Base Transceiver Stations or in mobile masts. When
using a TMA, the antenna is able to receive weaker signals.

TTL: Transistor-Transistor Logic (TTL)

VSWR : Voltage Standing Wave Ratio (VSWR). VSWR is another method to
measure reflected energy caused by impedance mismatch. It is
expressed as a ratio of X:1. VSWR measures the voltage peaks and
valleys. A ratio of 1:1 would be a perfect match. A typical cable and
antenna system would be around 1.43:1 (VSWR) or 15 dB Return Loss.

Watt: Watt (W) is a unit of measure for power.

WiMax : Worldwide Interoperability for Microwave Access (WiMax), is a popular
name of the 802.16 wireless metropolitan-area network standard,
including both 802.16-2004 for fixed WiMAX and 802.16-2005 for mobile
WiMAX. WiMax has a range of up to 31 miles. Data rates for WiMax
can reach up to 75 Mbps (Fixed) or 15 Mbps (Mobile). A number of
wireless signaling options exist ranging anywhere from the 2 GHz
range up to 66 GHz. WiMax is primarily aimed at making broadband
network access widely available without the expense of stringing wires
(as in cable-access broadband) or the distance limitations of Digital
Subscriber Line. WiMax technology can deliver high-speed Internet
access to rural areas and other locations. WiMax also offers an
alternative to satellite Internet services.

S412E UG PN: 10580-00318 Rev. AC D-13
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A C
accesslog ...... ... . L 10-12 calibration
adapters approved ............... 2-14 2 port, considerations . .......... 3-6
additional documents .............. A-1 image, 2-port ................. 3-6
address touch screenkeys .............. 5-4
Ethernet IP address ............ 6-2 capture
administrator SCIEEIN .. v v vttt eiiiiieeennnn 10-7
login ....... ... ... . .. . . ... .. 10-3 trace ............ ... 10-7
password .................... 10-3 CATTYING CASE . v v v v veeeeee e eennnn 2-17
AM/FM/PM measurement format ... 3-24 caution
annual verification ................ 1-7 automotive power adapter . ...1-6, 2-1
Anritsu cleaning instrument .. .......... 1-3
contacting .................... 1-1 ESD damage .................. 1-4
application fan port blocking ............. 2-17
selftest ..................... 5-19 testcables .................... 1-7
self test submenu key .......... 5-4 cautions
application options language and custom settings ... 5-12
MENU &« \vve et e ee e 5-7, 5-8 center frequency sharing .......... 5-13
DMRmode ................ 5-7 change directory .................. 4-9
P25p2mode ............... 5-8 changefiletype ................... 4-9
PTC-ACSES mode .......... 5-9 channel scanner measurement format 3-24
PTC-ITCRmode . ........... 5-9 chargers, approved ............... 2-14
TETRAmode ............. 5-10 charging battery .................. 1-6
VNAmode ................ 5-5 coloronwhite ................... 5-16
submenukey ................. 5-4 community activity . .............. 10-6
autodim ....................... 5-17 connection
automotive power adapter, caution ... 1-6 LAN ... 10-1
B router .............0 i, 10-2
connections, identifying ........... 2-10
banner . connector
show/hide . ................. 10-12 damage, wear, cleanliness . . . . . .. 1.4
battery . connectorcare .................... 1-4
CapaCILY .. ..o 2-1 contacting Anritsu ................ 1-1
chargers, approved ............ 2-14 COPY MENU . .ot e e e e e ie e 4-13
dual charger .................. 1-6 create folder .................... 4-10
long-term storage .............. 1-6 custom language
replacement .................. 1-5 settings lost with reset . ........ 5-12
) symbols ... 2-13 CWSG measurement format ....... 3-24
bias tee
option 10, setup ............... 8-1 D
SPAmode .................... 8-4 dataentry ...................... 2-15
VNAmode .................... 8-1 default
black & while display setting ........ 2-8 display colors ................ 5-16
black onwhite . .................. 5-16 gateway, for IP address ......... 6-6
block diagram, TMA ............... C-1 delta marker setup ................ 3-5
brightness .................. 5-16, 5-17
settingsmenu ................ 5-17
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DHCP
detailed information ............ 6-6
LAN connection ............... 6-2
when toconnect ............... 6-6
disclaimertext ................. 10-13
display
autodim .................... 5-17
brightness ................... 5-17
color schemes ................ 5-16
OVEIVIEW v vvvie et 2-7
settings .................. 2-8, 5-16
submenukey ................. 5-12
turnoff .......... ... .. ... ... 5-16
distance domain .................. 3-6

dPMR saved measurement format .. 3-24
dual-duplex tower mounted amplifier . C-1
duplex tower mounted amplifier ..... C-1
Dynamic Host Configuration Protocol

see DHCP

E

easyTest Tools .................... 7-4
electrostatic discharge ............. 1-4
electrostatic potential for damage .... 1-4
enteringdata .................... 2-15
envelope

create .. ... ... i 3-11

Hmit ........................ 3-11
erasing memory . ................. 1-8
ESD damage, cautions ............. 1-4
Ethernet

configuration . ................. 6-4

IPaddress .................... 6-2

MENU vttt e iee e eiee e 6-5
external

power connector .............. 2-11

power control ................ 5-15

reference in connector ......... 2-12

trigger in connector ........... 2-12

F

factory defaults

custom language settings lost ... 5-12

submenukey ................. 5-18
fastmode ....................... 10-6
file

management .................. 4-2

MENU vttt et iee et eiee e 4-8

setup file, recalling . ........... 4-12

types, by extension ............. 4-1

firmware
updating ................ 5-18, 5-20
floppyicon ...................... 2-14
formats
measurement ................ 3-24
frequency
calibration considerations ....... 3-7
TANEZE . oottt e 1-2
full 2-port calibration
calibration considerations ....... 3-6
G
gateway
default, for IP address .......... 6-6
partof IPaddress .............. 6-2
general instrument specs
ESD damage .................. 1-4
GPS
altitude ...................... 9-4
antenna
proper operation . . .......... 9-4
voltage and current ......... 9-4
antenna connector ............ 2-12
coordinates recalled ............ 9-3
fix .. 9-4
information saved with traces . ... 9-3
latitude and longitude .......... 9-4
MENU .ottt et ie e ie e ie e ieenns 9-3
option 31, main topic ........... 9-1
receiver status ................ 9-4
satellite ...................... 9-1
satellites required ............. 9-4
submenukey .................. 5-4
H
headsetjack .................... 2-11
High  Accuracy Power Meter saved
measurement format ............. 3-24
highcontrast .................... 5-16
display setting ................ 2-8
|
icons
adding and deleting ............ 2-4
front panel image .............. 2-3
front panel shortcuts ........... 2-4
impedance submenukey ........... 5-6
inspect connectors .. ............... 1-4
instrumentcare .................. 1-3
instrumentname ................ 10-9

instrument settings summary, image . 2-7
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Interference Analysis measurement format
3-24

internal memory .................. 1-2
invert black & while display setting .. 2-8
IPaddress ................... 6-2, 10-1
default gateway ............... 6-6
dynamic ..................... 6-6
pingtool ..................... 6-8
static ........ ... 6-6
subnet mask
static IP address ........... 6-6
ipconfigtool ...................... 6-7
J
JPEG measurement format ........ 3-24
L
LAN and DHCP information ........ 6-1
LAN connection ......... 2-11, 6-2, 10-1
language
custom settings lost with reset .. 5-12
submenukey ................ 5-12
limit
SPA ... 3-11
limit measurement format ......... 3-24
line of sight, GPS ................. 9-1
links
contacting Anritsu ............. 1-1
product page ................. 5-20
S412E product page . ........... 1-1
LMR Master, see S412E
login ........... ... ........ 10-3, 10-12
logout .......... .. ............. 10-13
LTE measurement format ......... 3-24
M
mainmenukey ................... 2-6
maintenance ..................... 1-3
marker
delta,setup ................... 3-5
peak and valley search . ......... 3-4
USING .ottt et i i 3-4
mask, subnet, for IP address ........ 6-6

master reset
custom language settings lost ... 5-12

master reset submenu key ......... 5-18
Master Software Tools

driver for Windows XP ......... 2-11
measurement formats ............ 3-24
measurement guides .............. A-1

memory
EraSINg . v vviiit 1-8
security . ... 1-8
storage, internal ............... 1-2
USB ... 1-2
menu
application options .......... 5-7, 5-8
DMRmode ................ 5-7
P25p2mode ............... 5-8
PTC-ACSES mode .......... 5-9
PTC-ITCRmode ............ 5-9
TETRAmode ............. 5-10
VNAmode ................ 5-5
COPY v et ettt e 4-13
delete ....................... 4-14
display settings .............. 5-16
Ethernet ..................... 6-5
file ... 4-8
GPS ... ... 9-3
mode selector ................ 2-16
Power-On ................... 5-15
preset .......... ... .. ... 5-19
recall ........ ... ... ... ... ... 4-12
reset ... ... 5-18
SAVE it 4-9
savelocation ................. 4-10
saveonevent ................ 4-11
system . ....... ... . 5-4
systemgroup ................. 5-2
system options ............... 5-12
system options 2/2 . ........... 5-13
mobile WIMAX measurement format 3-24
mode selector menu .............. 2-16
N
name, see instrument name
NBFM measurement format ....... 3-24
nightvision ..................... 5-16
display setting ................ 2-8
normalmode .................... 10-6
NXDN
application options ............. 5-8
measurement format .......... 3-24
(o)
on via external power ............. 3-25
option
10,BiasTee .................. 8-1
31,GPS ... .. 9-1
overview of instrument features ..... 2-1
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P
P25
application options ............. 5-7
measurement format .......... 3-24
P25p2
application options ............. 5-8
measurement format .......... 3-24
password
remote ............ 10-3, 10-9, 10-12
patterns, signal generator ......... 5-11
pausemode ..................... 10-6
peak search via marker ............ 3-4
pingtool ....... ... ... ... . .. ... ... 6-8
power adapter, automotive, caution .. 1-6
power control via external power . ... 3-25
Power Meter measurement format .. 3-24
power offset sharing .............. 5-13
power supply
failure ....................... B-6
SOUTCES  + v vt v e ee et eieee e 2-1
power-on menu .................. 5-15
preset
MENU v voe et ee e eee e e 5-19
submenukey ................. 5-19
preventive maintenance ............ 1-3
product page (URL) ........... 1-1, 5-20
PTC
ACSES
application options . ......... 5-9
ITCR
application options .. ........ 5-9
measurement format ....... 3-24, 4-1
Q
quick name, saving files ............ 4-3
R
recallmenu ................. 4-11, 4-12
recall setup submenu key .......... 5-19
receive only tower mounted amplifier . C-1
reference oscillator, accuracy ........ 9-1
refresh directories ................ 4-10

remote
accesslog................... 10-12
control display ............... 10-5
device management ...... 10-8, 10-11
deviceoptions ............... 10-12
instrument name ............. 10-9
interface .................... 10-3
password .......... 10-3, 10-9, 10-12
session time ....... 10-3, 10-5, 10-10
Web control .................. 10-1
replacing the battery .............. 1-5
reset
masterreset ................. 5-18
to factory defaults . ............ 5-18
resetmenu...................... 5-18
resetting memory ................. 1-8
RF Inconnector . ................. 2-12
S
S2P measurement format . ......... 3-24
S412E .. ... 1-1
additional options . ............. 1-2
CATE v v vttt e 1-3
description ................... 1-1
frequency ranges .............. 1-2
maintenance .................. 1-3
OVETVIEW .. vvvviiiiie e ennnnns 2-1
satellite
acquisition ................... 9-1
tracked for accuracy ............ 9-4
SAVE MENU ..ttt ee e ee e enne e 4-9
save setup submenu key . .......... 5-19
saving measurements . ............ 3-24
search, markervalue .............. 3-4
security of memory ................ 1-8
select files and folders ............ 4-13
self test
atstartup ......... ... ... ..., 5-19
submenukey .................. 5-4
session time
session expired message ...... 10-10
setting atlogin ............... 10-3
time until sessionends ........ 10-5
set remote access password key .. ... 5-13
set up delta marker ............... 3-5
setting
amplitude, SPA .............. 3-10
bandwidth, SPA ............... 3-9
distance domain, VNA .......... 3-6
freq
demodulation ............. 3-17
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NFBM ................... 3-14 dual-duplex type ........... C-1
SPA ... ... 3-9 duplextype D) ............ C-1
VNA ... 3-4 receive-only type (S) ........ C-1
limit line S-type ... C-1
SPA ... 3-11 torque, applying to connector . . ... ... 1-4
VNA ... 3-5 touch screen
markers keyboard .................... 2-15
SPA ... 3-12 keys ..o 2-6
VNA ... 3-4 tower mounted amplifier, see TMA
power offset, SPA . ... 3-10, 3-15, 3-18 trace label submenukey ........... 5-5
scale, VNA . .................. 3-4
signal standard, SPA ........... 3-9 ) u
span, SPA ... ... 3-10 update firmware submenu key ..... 5-18
Setup measurement format ........ 3-24 updating signal generator patterns .. 5-11
share center freq and power offset key 5-13 USB
signal generator patterns .......... 5-11 CoNNectors ................... 2-11
SINgle SWEEP .o vovereenn . 9.14 interface .................... 2-11
SnP (S2P) measurement format .... 3-24 MEMOLY ...\ vve v 1-2
softcase .............. ... . ..., 2-17 use of phase stable Cable ........... 1.7
SPA user files
description remove With master reset. ...... 5-18
measurement format . ... ...... 3.94 retain with factory reset ....... 5-18
Spectrum Analyzer, see SPA uTC . i )
stand, tilt bail ................... 2-18 available with option 31 ........ 9-1
staticIPaddress .................. 6-6 coordinated universal time ...... 9-4
status submenukey ............... 5-4 submenu ... 9-2
subnet ............. ... ... ... 6-6 \Y/
LAN connection ............... 6-2 valley search via marker ........... 3-4
system _ verification, annual instrument . . . . . . 1-7
display settings .............. 5-16 VNA
MENU . 5-4 measurement format .......... 3-24
MEeNU group . . .« vvvvvvevvneenen 5-2 Port 1 and 2 connectors ........ 2-12
self;test P 55)12 S-parameter measurement format 3-24
system options menu .......... - i
system options 2/2 menu .. ...\ =13 VVM measurement format ........ 3-24
system options W
submenukey ................. 5-4 warning
T external power connection . .. ... 2-11
%gq?RIfE measurement format ... . . 3-24 Web;igﬁct PAE .t 5-20
S412E product page ............ 1-1
application options . ........... 5-10 Web remotg controlp. g ............ 10-1
measurement format .......... 3-24 website
}:I]‘.%\E[Zall ......................... 2-18 contacting Anritsu . ... 1-1
Wi-Firouter .................... 10-2
toweg];n;)unted amplifier o1 WiMAX measurement format ... ... 3-24
type ... -
D-type ... .. C-1
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